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Chapter 1. Troubleshooting resources
Learn about sources of information that can help you resolve a problem in IBM® Cognos® Analytics.

The following checklist might guide you to the problem resolution, or help you collect the diagnostic data
that you can share with IBM support.

Table 1. Checklist actions

Actions Description

Check if a product fix is available to resolve your
problem.

Apply all known fix packs, or service levels, or
program temporary fixes (PTF).

Ensure that the configuration is supported. Review the information in the Supported Software
Environments page.

Reproduce the problem using the product
samples.

When a problem can be reproduced with product
samples, it might be easier for you to log a defect,
and for IBM support to resolve the problem faster.

Ensure that the installation was successfully
finished.

The installation location must contain the
appropriate file structure and file permissions. For
example, if the product requires write access to
log files, ensure that the directory has the correct
permission.

Review all relevant documentation and
technotes.

Try to determine whether your problem is known,
has a workaround, or is already resolved and
documented.

Review recent changes in your computing
environment.

Sometimes installing new software, updating
existing software, or applying OS patches might
cause compatibility issues.

If the items in the checklist did not guide you to a resolution, you can share the collected diagnostic data
with an IBM customer support representative who will assist you in resolving the problem.

IBM Support Portal
The IBM Support portal is a unified, centralized view of all technical support tools and information for all
IBM systems, software, and services.

The IBM Support portal lets you access all the IBM support resources from one place. You can tailor the
pages to focus on the information and resources that you need for problem prevention and faster problem
resolution.

Documentation
IBM Documentation includes documentation for each supported release of IBM Cognos Analytics.

Cognos Analytics documentation (www.ibm.com/docs/en/cognos-analytics) includes English and
translated versions. Click the different tiles to access the documentation for different Cognos Analytics
releases.

https://www.ibm.com/support/pages/node/6440667
https://www.ibm.com/support/pages/node/6440667
http://www.ibm.com/support/entry/portal/
https://www.ibm.com/docs/en/cognos-analytics


Cognos Analytics community
IBM Cognos Analytics community offers a place to share ideas and solutions with your peers.

Active Cognos forums are available at IBM Business Analytics Community (https://community.ibm.com/
community/user/businessanalytics/home).

Software support and RSS feeds
IBM Software Support RSS feeds are a quick, easy, and lightweight format for monitoring new content
added to websites.

After you download an RSS reader or browser plug-in, you can subscribe to IBM product feeds at IBM
Support site. When you subscribe to product notifications, you are provided with RSS/Atom feed links.

Error Messages
The first indication of a problem is often an error message. Error messages contain information that can
be helpful in determining the cause of a problem.

You can click the Details link to see the full error message. The administrator can use this information, as
well as other information about what product you are using and what you did before the error message
displayed, to resolve an issue.

If you click OK in response to the error message, IBM Cognos Analytics undoes the last action and returns
to the previous state.

Log files
Log files can help you troubleshoot problems by recording the activities that take place when you work
with a product.

Operations performed in IBM Cognos Analytics are recorded in various log files for tracking purposes.
For example, if you experienced problems installing IBM Cognos Analytics, consult the transfer log file to
learn what activities the installation wizard performed while transferring files.

Before you begin viewing log files, ensure that they contain the information that you need.

Use IBM Cognos Administration to set the level of detail to log for each category.

Use IBM Cognos Configuration to specify the size, number, and location of log files, and to configure the
properties of the log server.

When troubleshooting, the following files can assist you:

Transfer log file

This file records the components you installed, disk space information, the selections you made in the
transfer dialogs, and any errors the installation wizard encountered while transferring components. It also
records the activities that the installation wizard performed while transferring files.

The transfer log file is located in the install_location\uninstall\logs directory. The file name
includes the product name and time stamp. The following is an example of the file name format:

IBM_Cognos_Analytics_Install_04_21_2016_11_00_59.log

Installation Configuration log file

This log file records any configuration activities during the installation. For example, it reports the
available port for the dispatcher.
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The transfer summary-error log file is located in the install_location\logs directory. It is named
install_configuration.log

The Startup Configuration File

This file records your configuration choices each time you save your property settings. The file name is
cogstartup.xml.

If you are unable to save your configuration, or are having problems you can revert to a previously
saved configuration file. The backup configuration files are located in the install_location/
configuration directory. The following is an example of the file name format for backup configuration
files:

cogstartup_200811231540.xml

The Startup Configuration Lock File

This file is created each time you open IBM Cognos Configuration. It prevents you from opening more than
one IBM Cognos Configuration window.

If you experience problems opening IBM Cognos Configuration, you can check the install_location/
configuration directory for the cogstartup.lock file. If the file exists and IBM Cognos Configuration
is not open, it means that IBM Cognos Configuration did not shut down properly the last time you used it.
You can delete the lock file and then open IBM Cognos Configuration.

The Locale Configuration File

This file records the configuration choices you make in IBM Cognos Configuration for product and content
locales, locale mapping, and currency support.

If you experience problems with language support in the user interface or in reports, use these
files to track your changes. The backup configuration files are located in the install_location/
configuration directory. The following is an example of the file name format:

coglocale_200811231540.xml

The Runtime Log File

The default IBM Cognos log file, named cogaudit.log file, or other log files that you configure to receive
log messages from the log server, record information after you start the IBM Cognos Analytics service.
They are located in the install_location\logs directory. If you configured another destination for
log messages, check the appropriate file or database.

Some log messages indicate problems. Most messages provide information only, but others can help you
to diagnose problems in your runtime environment.

The Gateway Log File

The gateways record errors in the gateway log file, which is located in the
install_location\uninstall\logs directory.

You can use the gateway log file to troubleshoot problems that prevent the gateway from processing
requests or from using encryption. Symptoms of these problems are as follows:

• User IDs and passwords do not work
• Single signon does not work
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• The dispatcher is running but users receives an error message advising that the IBM Cognos Analytics
server is not available

The gateway log file uses the following naming format, where gateway_interface is cgi, mod2 (Apache 2.0
module), or isapi.

gwgateway_interface.log (for example, gwcgi.log)

The Uninstallation Log File

This file records the activities that the Uninstall wizard performed while uninstalling files. The log file
is named cognos_uninst_log.htm and is located in the Temp directory. You can use the log file to
troubleshoot problems related to uninstalling IBM Cognos Analytics components.

The Silent Mode Log File

This file records the activities that IBM Cognos Configuration performed while running in silent mode. This
log file is named cogconfig_response.csv and is located in the install_location\logs directory.

Core dump files
If you receive an error message about the report server not responding, IBM Cognos Analytics wrote a
core dump (.dmp) file to the file system.

Core dump files indicate a serious problem with the program, such as an unhandled exception or an IBM
Cognos Analytics process that terminated abnormally. Core dump files create a complete memory dump
of the current state of the program when the problem occurs. The core file usually indicates a bug that
requires a software fix

If you see the report server not responding message, immediately check the \bin directory of the
IBM Cognos Analytics server installation for any core dump files. On Windows, these files are named
processID.dmp, such as BIBusTKServerMain_seh_3524_3208.dmp. On UNIX, the files are named core.
On Linux®, the files are named core.processID. These binary files must be viewed with a debugging
program such as dbx, GNU debugger, or the WinDbg debugger for Windows.

If your server administrator cannot solve the problem, contact IBM support and provide them with a test
case, if possible, and the core files.

Core files can be 300 MB or more, and a new one of the same size is created each time that the
problem occurs. In Windows, the files should be checked and cleaned regularly, during regular server
maintenance. In UNIX and Linux, system settings can control how and when the core file is written to the
file system when a process abnormally terminates.

In Windows, you can use a configuration file to turn off the creation of .dmp files. In a production
environment, you can then enable core dumps when you encounter problems. Because not all problems
are easy to reproduce, core file creation should be enabled in your testing and development environment
so that you can use them.

With some IBM Cognos Analytics hotsite builds, core dump files are automatically created. During an
upgrade, configuration settings are not overwritten.

Turn off core file creation
You can turn off core file creation.

Procedure
1. On the server where IBM Cognos Analytics is installed, open the cclWinSEHConfig.xml file from the
install_location\configuration directory.
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2. In the configuration element, change the value of the environment variable setting to 0 (zero) so that it
reads

<env_var name="CCL_HWE_ABORT" value="0"/>

3. Save the file.

Metric Dump File
You can use the metric dump file to obtain detailed information about the state of the system at a
particular time, and to track system trends over a given period of time for historical purposes.

The default name of this file is metricdump.xml and it is located in the
install_location\uninstall\logs directory.

The metric dump file records a snapshot of the current system metrics. The file does not appear in
the install_location\uninstall\logs directory until metric dumping is enabled in IBM Cognos
Administration. For more information, see “Enable Metric Dumping in IBM Cognos Administration” on
page 5. By default, metric dumping is disabled.

The process of metric dumping is configured using the metricdumpconfiguration.xml file in
the install_location\configuration directory. For more information, see “Change the
metricdumpconfiguration.xml file” on page 6. This file is used to specify the resources to be
tracked in the metric dump file, and to control the size and location of the metric dump file. After
metric dumping is enabled in IBM Cognos Administration, you can keep it inactive by renaming the
metricdumpconfiguration.xml file. To reactivate metric dumping for a particular event, rename the
configuration file back to its original name.

Note: You can rename the metricdump.xml file and change its location using the
metricdumpconfiguration.xml file.

Enable Metric Dumping in IBM Cognos Administration
The procedure to enable metric dumping in IBM Cognos Administration is as follows.

Procedure
1. On the Configuration tab in IBM Cognos Administration, click Dispatchers and Services.

2. From the toolbar in the upper-right corner of the page, click the set properties button .

The Set properties - Configuration page displays.
3. Click the Settings tab.
4. For the Environment category, next to Advanced settings, in the Value column, click Edit.
5. In the Set advanced settings page, in the Parameter column, type the following setting:

DISP.MetricDumpEnabled

Tip: The setting name is case-sensitive.
6. In the Value column, type the URI of the dispatcher.

You can find the dispatcher URI in IBM Cognos Configuration, under Environment > Dispatcher
Settings. Use only the first part of the URI that ends with /p2pd. For example, type http://
install_server:9300/p2pd.

Tip: To delete this setting, click the check box next to the setting, click Delete, and click OK twice.
7. Click OK twice.
8. If you have multiple dispatchers, repeat these steps for each dispatcher computer.
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Change the metricdumpconfiguration.xml file
The procedure to change the metricdumpconfiguration.xml file is as follows.

Procedure
1. Open the file install_location\configuration\metricdumpconfiguration.xml in an editor.
2. To configure the resources for which metrics are to be logged, specify the resource in the following

section:

<mbeans>
  <mbean>com.cognos:type=Metrics,*</mbean>
  <mbean>com.cognos:type=MetricHealth,*</mbean>
  <mbean>com.cognos:type=ServiceHealth,*</mbean>
  <mbean>com.cognos:type=ServiceOperationalStatus,*</mbean>
</mbeans>

For example, to specify a service, type

<mbean>com.cognos:type=Metrics,service=contentManagerService</mbean>

3. To rename the metric dump file and change the path, edit the following line:

<filename>../logs/metricdump.xml</filename>

4. To change the time interval for dumping, edit the following line:

<interval>15000</interval>

The time is specified in milliseconds.
5. To specify whether to reset the MBeans after the values were dumped, edit the following line:

<resetAfterDump>false</resetAfterDump>

Changing the value to true resets metric values back to 0 in the user interface. For more information,
see the IBM Cognos Analytics Administration and Security Guide.

6. To change the maximum number of dumps, edit the following line:

<count>-1</count>

-1 means unlimited number of dumps.
7. To change the maximum file size before rollover, edit the following line:

<filesize>10000000</filesize>

8. To change the number of metric dump files to keep, edit the following line:

<rollover>1</rollover>

9. Save the changes.

Fix Central
Fix Central provides fixes and updates for your system's software, hardware, and operating system.

Use the pull-down menu to navigate to your product fixes on Fix Central . You may also want to view Fix
Central help.
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Fix packs, interim fixes, and test fixes
An Authorized Program Analysis Report (APAR) is a formal report of a problem caused by a suspected
defect in a current unaltered release of an IBM program. APARs describe problems found during testing
by IBM, as well as problems reported by customers.

The modified Cognos Analytics code that resolves the problem described in the APAR can be delivered in
fix packs, interim fixes, and test fixes.

Fix pack
A fix pack is a cumulative collection of APAR fixes, internal fixes, new features, and conformance points.
In particular, fix packs address the APARs that arise between new releases of Cognos Analytics. They
are intended to allow you to move up to a specific maintenance level. Fix packs have the following
characteristics:

• They are cumulative. Fix packs for a particular release of Cognos Analytics supersede or contain all of
the APAR fixes shipped in previous fix packs and interim fixes for that release.

• They are available for all supported operating systems and Cognos Analytics products.
• They contain several APARS.
• They are published on the Cognos Analytics Technical Support website and are generally available to

customers who have purchased products under the Passport Advantage® program.
• They are fully tested by IBM.
• They are accompanied by documentation that describes changes to the products, and how to install and

remove the fix pack.

Note: The status of an APAR is changed from Open to Closed as program error when the APAR fix is
provided in a fix pack or before major releases. You can determine the status of individual APARs by
examining the APAR descriptions on the Cognos Analytics Technical Support website.

Interim fix
An interim fix is a cumulative collection of important APAR fixes that arise between fix packs. To qualify
for inclusion in an interim fix, an APAR must be considered pervasive or otherwise important. Candidate
APARs are evaluated and approved by experts on the Cognos Analytics technical support team. Interim
fixes have the following characteristics:

• They are cumulative. Interim fixes for a particular release of Cognos Analytics supersede or contain all
of the APAR fixes shipped in previous fix packs and interim fixes for that release.

• They usually contain one or more APARs.
• They are published on Fix Central, but customers must request access to interim fixes.
• A subset of operating systems is available on Fix Central, but all supported platforms are created.
• They are fully tested by IBM.
• They are accompanied by documentation that describes how to install and remove the interim fix.

Interim fixes are available as needed after the release of a new version or fix pack and are intended as the
preferred alternative to test fixes, which do not receive the same level of testing or enjoy the same level of
support as interim fixes.

Test fix
A test fix is a temporary solution that is supplied to specific customers for testing in response to a
reported problem. Test fixes are sometimes referred to as "special builds" and they have the following
characteristics:

• They usually contain a single APAR.
• They are obtained from Cognos Analytics Support and are not generally available to the public.
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• They undergo limited IBM testing.
• They are not supported in the customer's production environment unless approved by IBM. Test
fixes are typically provided for issues that only happen in the customer's environment and cannot be
reproduced in IBM support and development's environment.

• They include minimal documentation, including a description of how the test fix should be applied, the
APARs it fixes, and instructions for the removal of the test fix.

Test fixes are supplied in situations where a new problem has been uncovered, there is no workaround
or bypass for the problem and you cannot wait until the next fix pack or interim fix becomes available.
For example, if the problem is causing critical impact on your business, a test fix might be provided to
alleviate the situation until the APAR is addressed in a fix pack or interim fix.

To help ensure problem-free operation, keep your Cognos Analytics environment running at the latest fix
pack level. To be notified of the availability of new fix packs, go to the My notifications page on the IBM
Support website. You can edit your subscription settings to choose the types of information you want to
get notification about, for example, security bulletins, fixes, troubleshooting, and product enhancements
or documentation changes. For a list of fix packs, see https://www.ibm.com/support/fixcentral/.

Microsoft Windows Event Viewer
Microsoft Windows Event Viewer provides information about program, security, and system events. For
example, if an IBM Cognos Analytics service fails to start, this fact is recorded in the event log.

Microsoft Windows Event Viewer does not record information that is specific to operations or tasks
performed in IBM Cognos Analytics. Consult the IBM Cognos Analytics log files for these problems.

For information about how to use Windows Event Viewer, see the Windows help.

Samples
IBM Cognos Analytics uses samples to highlight product features and to help you learn how to use the
product. You can also use samples to troubleshoot problems.

You can use the samples that come with IBM Cognos Analytics to determine if various components are
working together as expected. For example, if you are having a problem running a report, you can try
running a sample report to see if problem persists. You may discover that the problem is related to
connecting to a database.
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Chapter 2. Installation and configuration problems
You may encounter problems during installation and configuration, or when setting up IBM Cognos
Analytics to run within an application server.

Problems starting IBM Cognos Analytics
You can encounter problems when starting IBM Cognos Analytics.

You may encounter problems when you try to perform the following tasks:

• Start the IBM Cognos Analytics service.
• Open the Welcome page for the IBM Cognos Analytics portal for the first time.
• Start an application server, such as WebSphere®.

The following table shows some common symptoms and their solutions.

Table 2. Symptoms and suggested solutions for starting IBM Cognos Analytics

Symptoms Solution

You do not see the splash screen for the IBM
Cognos Analytics portal when you start IBM
Cognos Analytics.

Check your Web server configuration.

The service starts, but no tables are created in the
content store database.

Check your content store configuration.

The service does not start. Ensure that you wait a few moments before
submitting a request.

The application server does not start. Check the file permissions and directory names of
the application server installation location.

To review an up-to-date list of environments that are supported by IBM Cognos Analytics products,
including information on operating systems, patches, browsers, web servers, directory servers,
database servers, and application servers, see the IBM Software Product Compatibility Reports page
(www.ibm.com/support/pages/node/735235).

java.lang.IllegalArgumentException: Malformed uxxxx encoding
When you attempt to configure or start a version of Cognos Analytics earlier than 11.1.7, the following
error message appears:
java.lang.IllegalArgumentException: Malformed \uxxxx encoding

This error is caused by a known java issue in which a backslash (\) followed by a lower-case u is
interpreted as an encoding error. In the case of Cognos Analytics 11.1.7 and earlier, the error message
appears if the character string \u appears in the path to the Cognos Analytics installer. For example, the
error is triggered by this path:

F:\Sources\11.1.5\update\ca_instl_win_2.0.191003.exe

Resolving the problem
To resolve this issue, choose one of these options:

• Upgrade to the latest version of Cognos Analytics

http://www.ibm.com/support/pages/node/735235


• If you must continue to use a Cognos Analytics version earlier than 11.1.7, do the following:

1. Go to cognos_analytics_installation_location.
2. Open the file cmplst.text in a text editor.
3. Delete instances of the string \u from the path to the installer.

For example, change F:\Sources\11.1.5\update\ca_instl_win_2.0.191003.exe to
F:\Sources\11.1.5xxxxpdate\ca_instl_win_2.0.191003.exe

4. Save cmplst.text.
5. Configure and then start Cognos Analytics.

AAA-AUT-0013 The user is already authenticated in all available
namespaces

The error message appears because of some incorrect settings in the configuration of IBM Cognos
Analytics.

When you try to log in to Cognos Analytics, your attempt fails and you receive the following error message
on the login web page:

AAA-AUT-0013 The user is already authenticated in all available namespaces.

The incorrect settings are most commonly in the following categories of IBM Cognos Configuration:

• Environment
• Security
• IBM Cognos Application Firewall

Resolving the problem
Perform the following steps to specify correct configuration settings:

1. Start IBM Cognos Configuration.
2. Stop the Cognos Analytics service.
3. Check that the following settings are correctly specified for each Cognos Analytics installation in your

environment:

URI settings
Under Environment, ensure that you specified fully qualified domain name (FQDN) for the
Gateway URI, Dispatcher URI, and Content Manager URIs. For more information, see Changing a
port or URI setting.

Namespace settings

• Under Security > Authentication verify the configuration of all namespaces. For more
information, see Configuring authentication providers.

• For Lightweight Directory Access Protocol (LDAP) namespaces ensure that valid certificates were
imported to the correct keystore. For more information, see Enable secure communication to the
LDAP server.

• Verify that the Selectable for authentication property of namespace is set to the value True
• Test all namespaces until all tests are completed with success. To run the test, in the Explorer

window, under Authentication, right-click a namespace and click Test.

IBM Cognos Application Firewall (CAF) settings
Under Security > Authentication > IBM Cognos Application Firewall for Enable CAF validation?
set the value to True. For more information, see Configuring IBM Cognos components to use IBM
Cognos Application Firewall.

4. Save changes in IBM Cognos Configuration.
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5. Restart Cognos Analytics.

CFG-ERR-0106 error when starting the IBM Cognos service in IBM Cognos
Configuration

When you start the IBM Cognos Analytics service, you may receive the following error message:

CFG-ERR-0106 IBM Cognos Configuration received no response from the IBM Cognos service in the allotted
time. Check that IBM Cognos service is available and properly configured.

There are two possible causes for this problem:

• The IBM Cognos service needs more time to start.
• A standby Content Manager computer may be configured incorrectly.

The IBM Cognos service needs more time
By default, IBM Cognos Configuration checks the progress of the start request every half second for three
minutes. If IBM Cognos Configuration does not receive a response within this time, the error message
displays.

The amount of time that IBM Cognos Configuration waits to receive a response from the IBM Cognos
service is controlled by the ServiceWaitInterval and ServiceMaxTries properties.

The ServiceWaitInterval property represents the time interval, in milliseconds, at which IBM Cognos
Configuration checks the progress of the start request. By default, its value is 500, which is equivalent to
half a second.

The ServiceMaxTries property represents the number of times that IBM Cognos Configuration checks the
progress of the start request. By default, its value is 360.

Content Manager Is configured incorrectly
If the error message displays on a standby Content Manager computer, the setting for storing the
symmetric keys may be incorrect.

Changing the wait time for the IBM Cognos service
If you received the CFG-ERR-0106 error because the IBM Cognos service needs more time to start,
change the amount of time that IBM Cognos Configuration waits to receive a response from the IBM
Cognos service.

By default, IBM Cognos Configuration checks the progress of the start request every half second for three
minutes. If IBM Cognos Configuration does not receive a response within this time, the error message is
displayed.

The amount of time that IBM Cognos Configuration waits to receive a response from the IBM Cognos
service is controlled by the ServiceWaitInterval and ServiceMaxTries properties.

The ServiceWaitInterval property represents the time interval, in milliseconds, at which IBM Cognos
Configuration checks the progress of the start request. By default, its value is 500, which is equivalent to
half a second.

The ServiceMaxTries property represents the number of times that IBM Cognos Configuration checks the
progress of the start request. By default, its value is 360.

Procedure
1. Using IBM Cognos Configuration, stop the IBM Cognos service.
2. Open the install_location/configuration/cogconfig.prefs file in an editor.

This file is created automatically the first time you open IBM Cognos Configuration.
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3. Add the following code to the file:

ServiceWaitInterval=number of milliseconds 

ServiceMaxTries=number of times 

Tip: Add the numeric values that correspond to your configuration needs.
4. Save the file.
5. Using IBM Cognos Configuration, start the IBM Cognos service.

Changing the location where symmetric keys are stored
If you received the CFG-ERR-0106 error on a standby Content Manager computer, configure the computer
to store the symmetric keys locally.

The setting for storing the symmetric keys may be incorrect.

Procedure
1. On the standby Content Manager computer, start IBM Cognos Configuration.
2. In the Explorer window, under Security, click Cryptography.
3. In the Properties window, under CSK settings, set Store symmetric key locally to True.
4. From the File menu, click Save.
5. From the Actions menu, click Start.

This action starts all installed services that are not running. If you want to start a particular service,
select the service node in the Explorer window and then click Start from the Actions menu.

Cryptographic error when starting IBM Cognos Analytics
If the following error occurs when you try to start the IBM Cognos Analytics service after installing
server or client components, then your Java™ Runtime Environment (JRE) is missing the encryption and
decryption routines.

If you receive this error, then you must copy the Java Archive (.jar) file that is provided to your JRE
director since it is required by IBM Cognos Analytics.
[Cryptography] 
1. [ ERROR ] java.lang.NoClassDefFoundError: 
javax/net/ServerSocketFactory:

Your Java Runtime Environment (JRE) is missing the encryption and decryption routines that are required
by IBM Cognos Analytics. You must copy the Java Archive (.jar) file that is provided to your JRE directory.

Procedure
Copy bcprov-jdkversion.jar from the install_location/bin/jre/version/lib/ext
directory to the JRE_location/lib/ext directory.

If you are using 64-bit components, copy the files from install_location/bin64.

Unable to start the IBM Cognos service because the port is used by another
process

You may not be able to start the IBM Cognos Analytics service or process if one of the default ports is
used by another process.

Tip: To view the current network TCP/IP network connections, use the netstat command.

Use IBM Cognos Configuration to change the default port that IBM Cognos Analytics uses.
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When you change the port used by the local dispatcher, you must change the value of the Dispatcher
URI properties. Because the change affects all the URIs that are based on the local dispatcher, you must
change the URIs of all local components. By default, local components contain localhost in the URI.

For example, if you install all components on one computer and you want to change the dispatcher port,
replace 9300 in all dispatcher and Content Manager URIs with the new port number.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, click the appropriate group or component:

• To access the port number in the dispatcher and Content Manager URIs, click Environment.

• To access the port number for the local log server, under Environment, click Logging.
• To access the shutdown port number, under Environment, click IBM Cognos services > IBM Cognos

Analytics.
• To access the port number for the location of the applications.xml file used by Portal Services, under

Environment, click Portal Services.
3. In the Properties window, click the Value box next to the property that you want to change.
4. Change the value from 9300 to the new value.

Ensure that you change the ports in all URIs that contain localhost:9300.
5. From the File menu, click Save.
6. From the Action menu, click Start.

IBM Cognos service does not start or fails after starting
You start the IBM Cognos Analytics service but services either do not start correctly or are very slow to
start. After services start, the system fails a short time afterwards. While services are starting, Java uses
100 percent of the CPU time.

You may also receive multiple occurrences of error messages such as the following:

• DPR-DPR-1035 Dispatcher detected an error.
• CAM-CRP-1157 Unable to synchronize the local common symmetric key store with Content Manager.

Procedure
If you use a DB2® database for the content store, ensure that the database version and Java version are
compatible.

For Db2 version 8.2, Java 1.5 is not supported. For Db2 version 9, Java 1.5 is supported on all operating
systems except Solaris.

IBM Cognos Analytics server fails to start and gives no error message
An IBM Cognos Analytics server may fail to start after an upgrade or new installation, but no error
message displays. This may occur when a previously running or new IBM Cognos Analytics server is
configured to use a large amount of memory.

If the server on which IBM Cognos Analytics is installed contains version 1.0 of Microsoft security update
921883, there may be an issue when a lot of contiguous memory is requested by an application.

This is a known issue with version 1.0 of Microsoft security patch 921883. Microsoft distributed a second
version of the patch to fix the problem. As a workaround, uninstall the first security patch, or install
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version 2.0 of the patch. Alternatively, you can configure the IBM Cognos Analytics server to use less
memory.

For more information, see the Microsoft knowledge base article about programs using a lot of contiguous
memory failing, at the Microsoft support Web site.

Server not available when starting Cognos Analytics
After you configure IBM Cognos components and start the IBM Cognos services, when you connect to the
IBM Cognos Analytics portal, the following error message may display:

The Cognos Gateway is unable to connect to the Cognos Analytics server.

The server may be unavailable, or the gateway may not be correctly configured.

Check the IBM Cognos server log file for more information. By default, the cogaudit.log file is located
in the install_location\logs directory. If you configured another destination for log messages,
check the appropriate file or database.

Content Manager may not be able to connect to the content store if the content store is not configured
properly. This may occur if

• the content store uses an unsupported character encoding
• the content store uses a database collation sequence that is case sensitive
• the configuration settings you specified in IBM Cognos Configuration are not valid

Unsupported character encoding
If the following messages display in the log file, the database you created for the content store does not
use a supported character encoding:

• For Oracle:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-SYS-5121 Content Manager cannot start because the database character set for the content store is
not supported.

CM-SYS-5126 The content store database server uses the character set US7ASCII.

CM-SYS-5125 The content store database client uses the character set US7ASCII.
• For Db2 UDB:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-SYS-5121 Content Manager cannot start because the database character set for the content store is
not supported.

CM-SYS-5124 The content store database server uses the code page 1252.
• For Sybase:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-SYS-5121 Content Manager cannot start because the database character set for the content store is
not supported.

For Content Manager to connect to the content store, the content store must use the appropriate
character encoding, as listed in the following table.
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Table 3. Character encoding used by the content store to connect to a specific database type

Database Character encoding

Oracle 9i AL32UTF8

AL32UTF16

Db2 UDB Codeset UTF-8

Sybase ASE UTF-8

Microsoft SQL Server UTF8

UTF16

To resolve this problem, you must recreate the content store database using the correct character
encoding, or convert the character encoding. For more information, see the database documentation.

Case-sensitive collation sequence
If the following messages are in the log file, the database you created for the content store uses a
database collation sequence that is case sensitive:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-SYS-5122 The content store database has a default collation that is case-sensitive. Content Manager
requires a content store that has a case-insensitive collation.

CM-SYS-5123 The content store database server uses the collation <parameter>.

CM-SYS-5007 Content Manager build @cm_build_version@ failed to start! Review the Content Manager log
files and then contact your system administrator or customer support.

To resolve this problem, you must recreate the content store database using a database collation
sequence that is not case sensitive. For more information, see the database documentation.

Invalid configuration settings
If the following or similar messages are in the log file, you did not configure the content store correctly in
IBM Cognos Configuration.

• For Microsoft SQL Server:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-CFG-5036 Content Manager failed to connect to the content store. The connection string is
"jdbc:JSQLConnect://localhost:1433/cm".

Failed Logon:com.jnetdirect.jsql.x: Cannot open database requested in login 'cm'. Login fails.
url:jdbc:JSQLConnect://localhost:1433/cm.

• For Db2:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-SYS-5003 Content Manager is unable to access the content store. Verify your database connection
parameters and then contact your database administrator.

[IBM][CLI Driver] SQL1013N The database alias name or database name "CM123" could not be found.
• For Oracle:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.
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CM-CFG-5036 Content Manager failed to connect to the content store. The connection string is
"jdbc:oracle:thin:@localhost:1521:pb1".

ORA-01017: invalid username/password; logon denied.
• For Sybase:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-CFG-5036 Content Manager failed to connect to the content store. The connection string is
"jdbc:sybase:Tds:localhost:5000/cm".

JZ006: Caught IOException: java.net.ConnectException: Connection refused: connect.

If you are using an Oracle database, do not use illegal characters, such as an underscore in IBM Cognos
Configuration for the Service Name property. If the Service Name includes illegal characters, tables are
not created in the content store database when the IBM Cognos service is started.

Configuring a Microsoft SQL Server, Oracle, Db2, Informix, or Sybase content
store in IBM Cognos Configuration
If you received a CM-CFG-5036 or CM-CFG-5063 error code, the content store might not be configured
correctly. To resolve the issue, reconfigure the content store.

Procedure
1. In the Explorer window, go to Data Access > Content Manager. Right-click Content Store, and click

Delete.

The default content store is deleted. Content Manager must be configured to access only one content
store.

2. Right-click Content Manager, and then click New resource > Database.
3. In the Name box, type a name for the database.
4. In the Type box, select the type of database, and click OK.

Tip: If you want to use Oracle Net8 keyword-value pair to manage the database connection, select
Oracle database (Advanced).

5. In the Properties window, provide values depending on your database type:

• If you use a Microsoft SQL Server database, type the appropriate values for the Database server
with port number or instance name and Database name properties.

For the Database server with port number or instance name property, include the port number if
you use nondefault ports. Include the instance name if there are multiple instances of Microsoft SQL
Server.

To connect to a named instance, you must specify the instance name as a Java Database
Connectivity (JDBC) URL property or a data source property. For example, you can type
localhost\instance1. If no instance name property is specified, a connection to the default
instance is created.

The properties specified for the named instance, along with the user ID and password, and database
name, are used to create a JDBC URL. Here is an example:

jdbc:JSQLConnect://localhost\\instance1/user=sa/more properties as required
• If you use a Db2 database, for the Database name property, type the database alias.
• If you use an Oracle database, type the appropriate values for the Database server and port

number and Service name properties.
• If you use an advanced Oracle database, for the Database specifier property, type the Oracle Net8

keyword-value pair for the connection.

Here is an example:
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(description=(address=(host=myhost)(protocol=tcp)(port=1521) (connect_data=(sid=(orcl)))))
• If you use a Sybase database, type the appropriate values for the Database server and port number

and Database name properties.
6. If you want to change the logon credentials, specify a user ID and password in the following way:

• Click the Value box next to the User ID and password property and then click the edit icon when it is
displayed.

• Type the appropriate values and click OK.
7. From the File menu, click Save.

The logon credentials are immediately encrypted.

Cannot log on to a namespace
Error displayed when you attempt to create a data source and log on to a namespace.

• PRS-CSE-1255 Exception error encountered in data decryption.
• CAM-CRP-1064 Unable to process the PKCS #7 data because of an internal error. Reason:

java.lang.IndexOutOfBoundsException.

This issue might occur if you do not have the necessary permissions for the following directories:

• install_location\configuration
• install_location\configuration\csk
• install_location\configuration\encryptkeypair
• install_location\configuration\signkeypair

Enable the read and execute permissions on the directories listed above for anyone who must start the
IBM Cognos service.

IBM Cognos services fail to restart after a network outage
The IBM Cognos Bootstrap Service restarts IBM Cognos services after a network outage.

For installations where you use the default WebSphere Application Server Liberty Profile and where
a network IP address is specified in the internal dispatcher URI, the IBM Cognos services might not
initialize successfully during the restart. In this case, manually restart the services after the network is
restored.

Procedure
To resolve the problem, configure the Internal dispatcher URI property in IBM Cognos Configuration to
use localhost or the network host name.

No warning that installing a later version will automatically update the
earlier version of the content store

You have a version IBM Cognos Business Intelligence installed. You install IBM Cognos Analytics into a
new location. You use the same database for the content store for both versions. After you configure the
later version and start the IBM Cognos service, the earlier version of IBM Cognos Business Intelligence no
longer works because all content is automatically upgraded.

If you want to use both the earlier version of IBM Cognos Business Intelligence and IBM Cognos Analytics
after you upgrade, ensure that before you install the later version, you

• back up the database you use for the content store
• restore the backup to a new location
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Alternatively, you can choose to use the deployment tool to import the entire content store from an earlier
version to the later version. All existing content in the content store database is replaced by the imported
content. You receive a warning message about this.

Download of resource fails
If the download resource fails, it may be caused by recent Microsoft XMLHTTP upgrades if you do not
have a language preference set in Internet Explorer.

You start Reporting in Internet Explorer and the following error message displays:

The download of the specified resource has failed.

Procedure
To resolve the problem, specify a language preference in Internet Explorer.

Db2 returns SQL1224N error when connecting from AIX
If your content store is a Db2 database and you receive an SQL1224N error on AIX®, check the
db2diag.log file for additional information about the error.

If the error includes reason code 18, you might need to change the Db2 configuration to accept more
connections. For more information, see the IBM Db2 support pages for the error SQL1224N.

Content Manager error when starting IBM Cognos Analytics
After starting IBM Cognos Analytics, no BIBUSTKSERVMA process is started. There are errors listed in
the pogo******.log and cogaudit.log files. Users receive errors in the browser when connecting to the IBM
Cognos Analytics portal.

In the pogo******.log file, an error related to Content Manager displays.

In the cogaudit.log file, the following error displays:

An attempt to register the dispatcher in Content Manager was unsuccessful. Will retry periodically.

When connecting to http://computer name/ibmcognos, the following error messages display in the
browser:

• DPR-ERR-2058 The dispatcher cannot service the request at this time. The dispatcher is still initializing

• SoapSocketException: Connection Refused

IBM Cognos Configuration uses a user ID to bind to the LDAP database. If this user ID is moved to another
group, IBM Cognos Configuration can no longer locate it.

Procedure
To correct the problem, move the user ID back to the original group.

Content Manager fails to start or takes a long time to start
On Microsoft Windows, you try to start the service on the computer where you installed Content Manager.
As the service is starting, the details include errors similar to the following:

DPR-CMI-4006 Unable to determine the active Content Manager. Will retry periodically.

CM-SYS-5007 Content Manager build x.x.x.x failed to start!

Details within the error log may also include references to OutOfMemoryError.
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To resolve this problem, start the service using the DuseCMLargeResultSet parameter. You can add the
parameter to the bootstrap configuration file and then start the service using IBM Cognos Configuration or
you can add the parameter to the startup configuration file and then run the file.

Resolving an out-of-memory error using the bootstrap configuration file
Start the IBM Cognos service by adding the DuseCMLargeResultSet parameter to the bootstrap
configuration file.

Procedure
1. Go to the install_location\bin64 directory and open bootstrap_wlp.xml in an XML editor.
2. Find the section that begins with <param>"${install_path}.
3. Uncomment the DuseCMLargeResultSet parameter to that section, in the location shown by the bold

text in the following example.

<param>"-Dcatalina.base=${install_path}/tomcat"</param>

<param>"-Dcatalina.home=${install_path}/tomcat"</param>

<param>"-Djava.io.tmpdir=${temp}"</param>

     <param>-DuseCMLargeResultSet=true</param>

4. Save and close the file.
5. Start IBM Cognos Configuration and start the service.

Resolving an out-of-memory error using the startup configuration file (11.1.4
and earlier)
Start the IBM Cognos service by adding the DuseCMLargeResultSet parameter to the startup configuration
file.

Note: As of release 11.1.5, the startup.bat file no longer exists.

Procedure
1. Go to the install_location\bin directory and open startup.bat in a text editor.
2. Find the following line:

set CATALINA_OPTS=-Xmx768m -XX:MaxNewSize=384m -XX:NewSize=192m 
-XX:MaxPermSize=128m
%DEBUG_OPTS%

3. Append the DuseCMLargeResultSet parameter to the line, as shown by the bold text in the following
example:

set CATALINA_OPTS=-Xmx768m -XX:MaxNewSize=384m -XX:NewSize=192m 
-XX:MaxPermSize=128m
%DEBUG_OPTS%-DuseCMLargeResultSet=true

4. Save and close the file.
5. Start the service by running the startup.bat file.

Managing the Configuration Server
The configuration server identifies the server that manages configuration values. This is critical in multi-
server installations so that configuration values remain available and consistent on all nodes, even after
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network partitions. The configuration server runs on the same instance as the active content manager.
Applies to 11.0.3 (replaced in 11.0.4 by Configuration Group).

About this task

Procedure
1. Start Cognos Configuration.
2. In the Explorer window, under Local Configuration, click Environment.
3. In the Environment - Group Properties window, scroll down to the category Other URI Settings, and

click Configuration Server.
4. To set the correct value:

• If this is the active Content Manager server installation, you can set the value to the local server by
right-clicking and then clicking Reset to Default.

• If this is the standby Content Manager server install, or an Application tier install, you need to set

the value by clicking on the edit icon  to launch the edit dialog.

a. In Value - Configuration Server dialog, click on the Retrieve button to launch Retrieve
Configuration Servers dialog. Enter the proper information to access the active Content
Manager server, and then click OK.

User ID - The ID with administration privileges on the server.
Password - The password for the User ID.
Namespace ID - The value can be found in the Security, Authentication resource. For
example, CognosEx
Cognos Analytics URL - The URL used to run Cognos Analytics. For example, http://
myserver:9300/bi

b. The Configuration Server value is retrieved. Click OK to set the value.
• If you cannot retrieve the value using the Retrieve button, you can set the value manually.

a. On the active Content Manager server, open install_location/zookeeper/conf/
zoo.cfg

b. Find two settings like this:

server.1=Myhost.ibm.com:2888:3888
clientPort=2181

c. Concatenate the two value with a semicolon like this:

Myhost.ibm.com:2888:3888;2181

d. Enter that value in the property.
5. Save the configuration.

DPR-ERR-2014 error in the log file on the Content Manager computer
This error is displayed if Content Manager is installed on a separate computer and the event management
service on the Content Manager computer is enabled, or if you have a single-server installation and the
event management service is disabled.

The following error message might be displayed in the cogaudit.log file:

DPR-ERR-2014 Unable to load balance the request because no nodes in the cluster are available, or no
nodes are configured for the service: eventManagementService

To correct the problem, turn off the event management service in a distributed installation with Content
Manager on a separate computer, or enable the service in a single-server installation.
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Procedure
1. Do one of the following steps:

• In a distributed installation with Content Manager on a separate computer, start IBM Cognos
Configuration on the Content Manager computer.

• In a single-server installation, start IBM Cognos Configuration.
2. In the Explorer pane, go to Environment > IBM Cognos services.
3. Do one of the following steps:

• For a distributed installation, set the Event management service enabled property to False.
• For a single-server installation, set the Event management service enabled property to True.

4. Save your changes.
5. Restart the services.

Non-ASCII characters in installation directory cause run-time errors
On all operating systems, if you use non-ASCII characters in the installation directory for IBM Cognos
Analytics, it causes run-time errors. It also causes some product functions, such as report execution, to
fail.

Install IBM Cognos Analytics in the default directory or use a directory name that contains only ASCII
Latin-1 characters.

Cannot Open a Microsoft Cube or PowerCube
You are unable to open a Microsoft Cube or PowerCube, or you can open an Microsoft Cube but only
metadata is shown. For an Microsoft Cube, you may receive the following error message:

MO-ERR-0030

Cannot connect to the datasource. Please set the service to run as a domain user with the correct
privileges.

To solve this problem, ensure that the user running the IBM Cognos Analytics service has access rights to
the cube.

PowerCubes are accessed through mapped drives or UNC path names.

Assigning access rights to Microsoft cubes
For a user account to open Microsoft cubes, it must be assigned the appropriate privileges in the system
administrative tools.

Procedure
1. Add the domain user account that starts the IBM Cognos service to the Act as part of the operating

system privilege:

• Under Administrative Tools, select Local Security Policy.
• Expand Security Settings, Local Policies and click User Rights Assignment.
• Right-click the Act as part of the operating system policy and select Properties.
• Click Add User or Group and add the user account that starts the IBM Cognos service.

2. If you use the domain userID and password method of authentication, add the user account that
starts the IBM Cognos service to the domain that includes Content Manager, the Application Tier
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Components, IIS Web server, and the data source server (Microsoft SQL Server or Microsoft Analysis
Server).

3. If you use an external namespace, such as Active Directory Server, for authentication, add the user
account that starts the IBM Cognos service to the domain that includes the authentication provider.

This domain must also include Content Manager, the Application Tier Components, IIS Web server, and
the data source server (Microsoft SQL Server or Microsoft Analysis Server).

For more information about configuring external namespaces for authentication, see the topics about
authentication providers in the IBM Cognos Analytics Installation and Configuration Guide.

Assigning access rights to PowerCubes
For a user account to open PowerCubes, it must be assigned the appropriate privileges in IBM Cognos
Administration.

Procedure
Ensure that the IBM Cognos user profile has sufficient operating system or domain access rights to open
the PowerCube file.

The page is not shown when opening a portal after installing IBM Cognos
Analytics

After you install and configure IBM Cognos Analytics, you are unable to connect to the Cognos Analytics
portal.

This may be because the Web server is not properly configured. For example, the virtual directories
required for IBM Cognos Analytics may not exist or they may point to the wrong physical folders.

For information about configuring the Web server, see the IBM Cognos Analytics Installation and
Configuration Guide.

DPR-ERR-2058 Error Displays in Web Browser When Starting IBM Cognos
Analytics

After you start the services in IBM Cognos Configuration and then try to open the portal, a message
similar to one of the following may display:

DPR-ERR-2058 The dispatcher encountered an error while servicing a request.
XTS handler must be initialized before being invoked.
DPR-ERR-2058 The dispatcher cannot service the request at this time.
The dispatcher is still initializing. Please try again or contact your
administrator.

These error messages usually occur when the dispatcher cannot communicate with the Content
Manager. To help you determine the specific cause, look in the cogaudit.log file in the
install_location\logs directory. The following are the most common causes with their solutions.

IBM Cognos Services are Not Done Initializing
After you start the services in IBM Cognos Configuration and the configuration tool shows that the
services are running, wait a few minutes for all services to start before you open the portal.

Content Manager is Not Available
In a distributed installation, ensure that Content Manager is installed, configured, and running. Ensure
also that the other IBM Cognos computers are configured with the correct Content Manager URI.
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The Content Store is Not Available or is Not Configured Properly
Ensure that the content store database was created and that you configured it correctly in IBM Cognos
Configuration.

Tables are Not Created in the Content Store
Ensure that you are using a version of Db2, Microsoft SQL Server, Oracle, or Sybase that is supported by
IBM Cognos components.

The Logon Credentials for the Content Store Are Incorrect
Check whether the information changed. For example, Db2 reads information from the NT user
management. If the password for the NT account changed, you must also change the logon credentials for
the content store in IBM Cognos Configuration.

Check for special characters in the logon password. Occasionally, the JDBC driver does not accept
characters that are reserved for xml, such as %, !, <, and >.

The User Does not Have Appropriate Permissions
Ensure that the user has the appropriate permissions.

Out of memory on HP-UX
If you are using the application server that is provided with IBM Cognos Analytics, you can determine the
issue is related to HP-UX server configuration. You might be exceeding the expected maximum number of
simultaneously active threads per process.

Increasing the maximum number of threads per process on HP-UX
If you are exceeding the expected maximum number of simultaneously active threads per process on
HP-UX, increase the number of active threads.

Procedure
Have your system administrator change the Kernel parameter as follows:

• max_thread_proc = 512
• nkthread = 1024

Checking for an HP-UX configuration problem
If increasing the maximum number of active threads per process does not resolve the out-of-memory
error on HP-UX, perform the following steps.

Procedure
1. In the /bin/startup.sh file, find

../tomcat/bin/catalina.sh start "$@"
2. Change it to the following:

../tomcat/bin/catalina.sh run "$@"

The run command causes the Tomcat output to display in the console window for IBM Cognos
Analytics.

3. Stop and restart IBM Cognos Analytics using the ./shutdown.sh and ./startup.sh commands.
4. If the following error message displays in the console window for any of the application servers, the

issue is an HP-UX configuration problem:

OutofMemoryException error: Unable to create new native thread on HP-UX.
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The problem is that the default values for HP-UX 11.0 and 11i are set too low for most Java
applications.

Tip: You can check the number of threads in your process by using the -eprof option available in JDK
1.1.8 and by analyzing the Java.eprof file using HPjmeter by selecting the threads metric.

Content Manager Cannot Connect to the Content Store on Oracle
If you are using an Oracle database as a content store, the DPR-ERR-2058 error may be generated when
logging onto the portal All tables are created on the database.

You may also receive the following error messages:

• CM-CFG-5036 Content Manager failed to connect to the content store.
• ORA-01017: invalid username/password; logon denied

Setting the Oracle database server name
The Content Manager might fail to connect to an Oracle database because of inconsistencies between the
Oracle server name in IBM Cognos Configuration and the server name in the tsnnames.ora file.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, click Data Access, Content Manager, Content Store.
3. Change the Oracle database server name to a fully qualified name such as

host_name.companyname:1534 to match the name in the tnsnames.ora file.

DPR-ERR-2022 error displays in Web browser when starting IBM Cognos
Analytics

After you start the services in IBM Cognos Configuration and then try to open the portal, a message
similar to the following may display:

DPR-ERR-2022 No response generated. This may be due to an incorrect configuration, a damaged
installation, or the dispatcher not having finished initializing.

This problem can occur if

• You try to open the portal before IBM Cognos services are initialized.
• A system.xml file has been edited.

In this case, replace the edited system.xml file in the appropriate subdirectory in
install_location\templates\ps with a copy from backup or use an XML editor to edit it.

There are many instances of system.xml in the directories in install_location\templates\ps. Ensure that
you replace the correct file.

Corrupt characters while installing in some languages on Linux
When running the installation wizard on Linux in Korean, Chinese (simplified or traditional), or Japanese,
you may see corrupted characters in the dialog boxes of the user interface or in messages that display
during the installation.

To avoid the problem of corrupt characters in the user interface during installation, you can use one of the
following solutions:

• Configure the Asian fonts on the Linux server:

– Set the locale to utf8.
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For example,

ko_KR.utf8, ja_JP.utf8, zh_CN.utf8, or zh_TW.utf8
– Ensure that Asian language Fontset *medium-r*--14* is available on X server.

• Run an unattended installation using the default response.ats file that is provided with your IBM Cognos
Analytics product. For information about setting up an unattended installation, see the Installation and
Configuration Guide.

Unable to download the cognos.xts file
After installing IBM Cognos Analytics, you are prompted to download the cognos.xts file when connecting
to the IBM Cognos Analytics portal. The following error message may display:

You have chosen to download a file from this location. cognos.xts from servername

This problem occurs when the permissions on the virtual directories are not set properly. You must
provide the cgi-bin virtual directory in the Microsoft Internet Information Service (IIS) with execute
permissions.

To resolve this problem, recreate the virtual directories in IIS with the permissions from the following
table, where install_location represents the installation location.

Table 4. Alias, path, and permissions for creating IIS virtual directories

Alias Path Permissions

ibmcognos install_location\webcontent Read

ibmcognos\ cgi-bin install_location\cgi-bin Read Execute

For example, the default installation location is C:\Program Files\IBM\Cognos\install.

Application server startup script fails
You may have problems running the startup scripts for an application server to deploy the IBM Cognos
application if IBM Cognos Analytics components are installed in a directory with a name that includes
spaces.

Procedure
1. Reinstall to a new directory and do not include spaces in the new name.
2. If this solution is not easily handled by the startup scripts, try adding quotation marks around the

directory name that includes spaces or use the 8.3 DOS naming convention.

Deploying to an Oracle Application Server when IBM WebSphere Application
Server fails

Deploying IBM Cognos Analytics to an Oracle application server or an IBM WebSphere application server
may fail.

These errors can occur because the application file that you are trying to deploy is too large. If a
deployment fails, any of the following errors may occur:
Browser timeout in administration console.
HTTP 500 Internal Error.
Deployment failed: Base Exception: java.rmi.RemoteException (Oracle). Return to 
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application file selection page in IBM WebSphere.

For more information about deploying IBM Cognos Analytics to an application server, see the IBM Cognos
Analytics Installation and Configuration Guide.

Procedure
1. If you are using the Build Application Wizard, clear the Include static files from the Webcontent

folder check box when you select the application to build.

This will reduce the size of the application file. If static content is required, you can manually copy it to
the deployed application location after you have successfully deployed IBM Cognos Analytics into the
application server.

2. If you are deploying the application file manually for an Oracle application server, type the following
command:
dcmctl deployapplication -f path_and_name_of_ear_file -a application_name
-co OC4J_instance_name

This command is not supported for Oracle Release 3.

Accented or double-byte characters may not display correctly when
installing IBM Cognos Analytics on Linux

If you are using issetup under a UTF-8 locale, accented or double-byte characters may not display
correctly.

Procedure
1. To resolve this problem when installing in German or French, use a non-UTF-8 locale and then launch

issetup to install IBM Cognos Analytics.

2. To resolve this problem when installing in Japanese, change the encoding setting of X Terminal
to Shift-JIS, and then install IBM Cognos Analytics using an unattended installation. For more
information, see the IBM Cognos Analytics Installation and Configuration Guide.

RSV-SRV-0066 a soap fault has been returned or RQP-DEF-0114 the user
cancelled the request errors display in high user load environments

These errors may be in the IBM Cognos cogaudit.log if you have a high user load (over 165 users) and
interactive reports are running continuously in a distributed installation.

Procedure
1. Increase the async_wait_timeout_ms parameter parameter in webapps/p2pd/WEB-INF/services/

reportservice.xml file.

For more information, see the IBM Cognos Analytics Installation and Configuration Guide.
2. Increase the Queue Time Limit setting to 360.

For information, see the IBM Cognos Analytics Administration and Security Guide.

Problems configuring IBM Cognos Analytics
After you install IBM Cognos Analytics components, you may encounter problems when you save changes
in IBM Cognos Configuration.

Ensure that you

• configure and start the services on the computer where Content Manager is located before you
configure other components
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• restart the IBM Cognos service after you make any configuration changes

Running Database and Index Cleanup Scripts
In some troubleshooting situations, you may be advised to start with new configuration data.

You can run SQL scripts to delete all the tables in any of the following databases that IBM Cognos
Analytics components use:

• content store for data that IBM Cognos Analytics needs to operate
• delivery database for report notifications
• database for human tasks and annotations

You can run SQL scripts to delete all the tables and indexes in the logging database for log messages.

When you delete a table, its structural definition and data are deleted permanently from the database.

When you delete the indexes from a logging database, they are deleted permanently from the database.

When you restart the IBM Cognos service, a new set of required database tables and indexes are created
automatically in the location specified by your configuration settings.

Procedure
1. On each computer where Content Manager is located, stop the IBM Cognos service.
2. Go to the appropriate directory:

• To delete tables and indexes from the logging database, go to
install_location\configuration\schemas\logging.

• To delete tables from the content store, go to install_location\configuration\schemas\content.
• To delete tables from the notification database, go to

install_location\configuration\schemas\delivery.
• To delete tables from the human task and annotation database, go to

install_location\configuration\schemas\hts.
3. Go to the appropriate database directory.
4. Depending on the database and database type, run one of the following scripts in the appropriate

database tool to delete the tables.

The following table lists the script names for the content store database.

Table 5. Database type and script name for the content store database

Database type Script name

Db2 dbClean_db2.sql

Db2 on z/OS® dbClean_db2zOS.sql

Informix® dbClean_informix.sql

Microsoft SQL Server dbClean_mssqlserver.sql

Oracle dbClean_oracle.sql

Sybase dbClean_sybase.sql

The following table lists the script names for the notification database.
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Table 6. Database types and script names for the notification database

Database type Script name

Db2 NC_DROP_DB2.sql

Db2 on z/OS NC_DROP_DB2.sql

Informix NC_DROP_IFX.sql

Microsoft SQL Server NC_DROP_MS.sql

Oracle NC_DROP_ORA.sql

Sybase NC_DROP_SYBASE.sql

The following table lists the script names to clean up tables and indexes for the logging database.

For Informix, the index cleanup script must be edited if you host more than one audit logging database
on the Informix instance and use them at the same time. See step 5.

Table 7. Script names to cleanup tables and indexes for the logging database.

Database type Script name

Db2 LS_dbClean_db2.sql

LS_dbCleanIndexes_db2.sql

Db2 on z/OS LS_dbClean_db2zOS.sql

LS_dbCleanIndexes_db2zOS.sql

Informix LS_dbClean_informix.sql

LS_dbCleanIndexes_informix.sql

Microsoft SQL Server LS_dbClean_mssql.sql

LS_dbCleanIndexes_mssql.sql

Oracle LS_dbClean_oracle.sql

LS_dbCleanIndexes_oracle.sql

Sybase LS_dbClean_sybase.sql

LS_dbCleanIndexes_sybase.sql

The following table lists the script names for the Human Task and Annotation database.

Table 8. Script names for the Human Task and Annotation database

Database type Script name

all types humanTaskService-dropScript.sql

5. If you have more than one audit logging database on your Informix instance, do the following:

• Go to install_location\configuration\schemas\logging\informix and open the file
LS_dbCleanIndexes_informix.sql in a text editor.
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• Replace every instance of IPFSCRIPTIDX with the value that you specified when you created the
IPFSCRIPTIDX property in IBM Cognos Configuration. For more information, see the topic about
specifying a log messages repository in the IBM Cognos Analytics Installation and Configuration
Guide.

• Save and close the file.
6. Start the IBM Cognos service.

Error trying to encrypt information when saving your configuration
When you save your configuration using the configuration tool, you may see an error message that the
cryptographic information cannot be encrypted. An error occurred when requesting a certificate from the
Certificate Authority.

The cryptographic information cannot be encrypted. Do you want to save the configuration in plain text?

Before you can encrypt your configuration settings, the computer where Content Manager is installed
must be configured and running. On UNIX operating systems, ensure that you copied the appropriate .jar
files to the installation location of your Java Runtime Environment. In addition, ensure that your Java
environment is configured correctly, the URIs are correct, and the same certificate authority password is
configured for all Content Manager computers.

On Linux operating systems, ensure that you copied the appropriate .jar files to the installation location of
your Java Runtime Environment.

Also, an error message similar to the following may display:

java.lang.NoClassDefFoundError: javax/net/ServerSocketFactory.

The cryptographic error usually means the Java environment is not configured correctly. Ensure that the
JAVA_HOME environment variable is set correctly and the appropriate security providers are installed,
such as JSSE for JRE 1.5.

Checking the URI properties and certificate authority password
To ensure that configuration settings can be encrypted, ensure that the URI properties and certificate
authority password in IBM Cognos Configuration are correct.

Procedure
1. On the Content Manager computer, start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, verify these properties:

• Under Gateway Settings > Gateway URI
• Under Dispatcher Settings > External dispatcher URI and Internal dispatcher URI
• Under Other URI Settings > Dispatcher URI for external applications and Content Manager URIs

4. In the Explorer window, click Security > Cryptography > Cognos.
5. In the Properties window, under Certificate Authority settings, click the value for Password.

Ensure that the same password is used on all Content Manager computers.
6. Save the configuration and restart IBM Cognos Analytics.

Problems generating cryptographic keys in IBM Cognos Configuration
When you uninstall IBM Cognos Analytics, some temporary folders are left behind. Reinstalling the
product to the same location without first removing the temporary folders may cause problems while
attempting to generate the cryptographic keys in IBM Cognos Configuration.
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Procedure
1. Uninstall IBM Cognos Analytics.
2. Remove the install_location/temp/cam folder.
3. Reinstall IBM Cognos Analytics.

CAM-CRP-1315 error when saving configuration
When you save your configuration, an error occurs when there has been a change to your environment's
trust domain.

There are several instances when the Cryptographic Keys may need to be regenerated. Beginning with
Cognos 10.2.2, the traditional method to regenerate the cryptographic keys is no longer valid and the
below steps would need to be followed instead. The trust domain is managed by the certificate authority
associated with the content store. The following error occurs if the content store you originally used
was removed or if you modified your configuration to use a Content Manager associated with a different
content store after you have saved your original configuration.

CAM-CRP-1315 Current configuration points to a different Trust Domain than originally configured.

To resolve the problem, change your configuration to use the original content store or regenerate the
cryptographic keys using the following steps.

Procedure
1. On the computer that reports the error, stop the Cognos services and launch Cognos Configuration

and click File > Export As.
2. Remove the install_location/temp/cam/freshness file.
3. Back up the existing cryptographic keys by saving the following directories to an alternate location that

is secure:

• install_location/configuration/csk
• install_location/configuration/certs

4. Delete the csk directory.
5. Except for the jCAPublisherKeystore file, which must be retained, clear the certs directory.
6. Repeat on all computers that report this error.
7. In IBM Cognos Configuration, save the configuration and restart the services.

CAM-CRP-0221 error when logging into the portal
After installing IBM Cognos Analytics on Microsoft Windows operating system (either a 32-bit or 64-bit
system) and configuring IBM HTTP Server as the gateway, attempts to log in to the IBM Cognos Analytics
portal result in an error message that contains the following:

CAM-CRP-0221 Unable to load the provider 'CAM_Crypto_TOpenSSL.dll' specified in the configuration file.

This error occurs when incompatible versions of OpenSSL libraries are loaded. To resolve the problem,
load the OpenSSL libraries that are provided with IBM Cognos Analytics.

Procedure
1. On the gateway computer, go to IBM_HTTP_location\conf directory and open httpd.conf in a text editor.
2. Add the following lines to the file:

LoadFile "install_location/cgi-bin/ssleay32.dll"

LoadFile "install_location/cgi-bin/libeay32.dll"
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where install_location is the path to the IBM Cognos Analytics installation directory.

Manually changing the installation directory name affects installations
running under an application server

After installing IBM Cognos Analytics using the installation wizard and later renaming the installation
directory or manually copying the contents to another directory, you attempted to run IBM Cognos
Analytics within an application server.

One of the following problems occurs:

• IBM Cognos Analytics does not start.
• Log directories are empty.
• Logs contain a linkage error or unsatisfied link error.

When you manually change the installation directory, the information in the IBM Cognos Analytics root
directory becomes invalid. To resolve the problem, you must either update the IBM Cognos Analytics root
directory before you create the IBM Cognos Analytics application file to deploy to the application server
or you must reinstall IBM Cognos Analytics in the original location. If you reinstall IBM Cognos Analytics,
follow the process for upgrading.

Procedure
1. In the new or renamed installation directory, open install_location/webapps/p2pd/WEB-INF/classes/

cogroot.link in a text editor.
2. Replace the path with the new location of the installation directory and save the file.
3. To build the application file to be deployed to the application server, in IBM Cognos Configuration, from

the Actions menu, select Build Application Files.
4. If you built and deployed an application file to the application server before updating the cogroot.link

file, undo the deployment.
5. Deploy the new application file to the application server.

For more information about configuring IBM Cognos Analytics for another application server, see the
IBM Cognos Analytics Installation and Configuration Guide.

Configuration data is locked by another instance of IBM Cognos
Configuration

You may get an error message that the configuration data is locked by another instance of IBM Cognos
Configuration.

When you start IBM Cognos Configuration, it checks to see if the cogstartup.lock file exists in
install_location/configuration. The file may exist if a previous instance did not shut down properly or if
another instance of IBM Cognos Configuration is running.

Procedure
1. If another instance of IBM Cognos Configuration is running, exit that instance.

Otherwise, any changes you make to the local configuration may result in errors.
2. If no other instance of IBM Cognos Configuration is running, delete the cogstartup.lock file in

install_location/configuration.
3. If the IBM Cognos service is stopped, click Start.
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Unable to exit a tab sequence when using keyboard-only navigation in IBM
Cognos Configuration

If you use the Tab key to navigate in IBM Cognos Configuration, you may experience problems exiting
a tab sequence. For example, in the Properties window, you can press the Tab key to move from one
property to another.

However, because IBM Cognos Configuration is a Java application, when you want to close the Properties
window, you must press Ctrl+Tab.

Unable to save your configuration
You may be unable to save your configuration because you are missing a resource. For example, you
delete a resource such as the Cognos namespace, a cryptographic provider, or the content store. You
can specify a different database type for the content store with Oracle, Microsoft SQL Server, Informix,
or Sybase. You can also configure a new cryptographic provider. You cannot specify a new Cognos
namespace, but you can recreate it. However, you must then recreate your Cognos groups and roles.

Recreating the Cognos namespace
If you deleted the Cognos namespace, you must recreate it and then recreate your Cognos groups and
roles.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, under Security, right-click Authentication and then click New resource >

Namespace.
3. In the Name box, type a name for the resource.
4. In the Type box, click Cognos, and then click OK.

The Cognos namespace displays in the Explorer window.
5. From the File menu, click Save.
6. Recreate the Cognos groups and roles using IBM Cognos Administration.

For more information, see the IBM Cognos Analytics Administration and Security Guide.

Java error when starting IBM Cognos Configuration
When you start IBM Cognos Configuration, you may receive an error message that the Java Runtime
Environment (JRE) has changed and that the current cryptographic information is not compatible with the
new JRE. You may then be prompted to regenerate the cryptographic information for the new JRE or exit
to switch back to the previous JRE.

This error may occur for one of these reasons:

• Your configuration data was encrypted using a different JRE than the one IBM Cognos Analytics
components are currently using.

• The cryptographic information may have been corrupted.

If you click Regenerate in the error dialog, the IBM Cognos service is stopped and the cryptographic
information is regenerated.

If you click Exit in the error dialog, you must set the JAVA_HOME environment variable to point to the JRE
that you used to save your configuration.
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On Microsoft Windows operating system, if you want IBM Cognos Analytics components to use the JRE
that is installed by default, unset JAVA_HOME or set JAVA_HOME to install_location/bin/jre.

Note: If you want to change from one JRE to another, see the topic on changing the version of JVM
that IBM Cognos Analytics components use. For more information, see the Installation and Configuration
Guide.

Cryptographic error when starting IBM Cognos Configuration
When you start IBM Cognos Configuration, the following error message may display:

The cryptographic information may have been corrupted or the cogstartup.xml file is invalid. You may have
to fix this file or remove it from disk. For more information, see the Installation and Configuration Guide.

This error occurs when IBM Cognos Analytics components detect an error in the cogstartup.xml file. This
can occur when the cogstartup.xml file is manually edited and there is an error in the changed text.

To resolve the problem, replace the cogstartup.xml file with a copy from your backup location.

Restarting the IBM Cognos service to apply configuration settings
After changing default property values or adding a resource to your installation in IBM Cognos
Configuration and then saving the configuration, you may not see the changes or be able to use the
resource in the run-time environment.

To apply the new settings to your computer, you must restart the IBM Cognos service.

Procedure
1. Start IBM Cognos Configuration.
2. From the Actions menu, click the appropriate command:

• If the IBM Cognos service is currently running, click Restart.

This action starts all installed services that are not running and restarts services that are running.
If you want to restart a particular service, select the service node in the Explorer window and then
click Restart from the Actions menu.

• If the IBM Cognos service is stopped, click Start.

This action starts all installed services that are not running. If you want to start a particular service,
select the service node in the Explorer window and then click Start from the Actions menu.

CM-CFG-029 error when trying to save a configuration that specifies a
Microsoft SQL Server content store

In IBM Cognos Configuration, you try to save a configuration and the following error message is in the
cogaudit.log file:

CM-CFG-029 Content Manager is unable to determine whether the content store is initialized.

EXECUTE permission is denied on object "sp_tables", database "master", owner "dbo'.

This indicates that you do not have the correct permissions to initialize a content store or create a table in
the database.

Ensure that the content store user has permissions to use the sp_tables stored procedure in the master
database.
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Db2 not found error for Linux on System z
You installed IBM Cognos Analytics and after you ran the C8DB2.sh script, an error stating that Db2
cannot be found is displayed or written to the log files.

Procedure
1. Create a profile that sources the sqllib/db2profile from the user's home directory for the user

you enter when you run the script.

An example .profile would contain something like the following:

if [ -f /home/db2user/sqllib/db2profile ]; then
  ./home/db2user/sqllib/db2profile
fi

2. Run the C8DB2.sh script again.

DPR-ERR-2079 when Content Manager configured for failover
You configured multiple computers as standby computers to ensure failover for Content Manager.
However, the following error message displays to the user:

DPR-ERR-2079 Firewall Security Rejection. Your request was rejected
by the security firewall

This error message can occur if you have not configured all the standby computers as valid hosts for the
IBM Cognos Application Firewall.

To solve this problem, on each distributed computer, start IBM Cognos Configuration and enter the names
of all the computers that you are configuring for failover.

Procedure
1. In the Explorer pane, click Security > IBM Cognos Application Firewall.
2. In the IBM Cognos Application Firewall - Component Properties window, click in the Value column

next to Valid domains or hosts.
3. Click the edit icon.
4. Enter the names of all the computers that you are configuring for failover.
5. Save and start the configuration.

Importing a large deployment in Windows crashes the Java virtual machine
The Java virtual machine under Microsoft Windows operating system may crash under the following
circumstances.

• The maximum Java memory setting is 1152 MB or higher.
• You are importing a large archive from a previous release of IBM Cognos Analytics.
• The archive contains large models that require upgrading.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer, under Environment, IBM Cognos services, click IBM Cognos.
3. Set the Maximum memory in MB property to 768.
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CCL-BIT-0006 error message when using WebSphere Application Server on
a heavily loaded system

On a heavily loaded system that uses WebSphere Application Server, some connections might terminate
before IBM Cognos Analytics finishes processing a request.

You might see the following message in the install_location\logs\cogaudit.log file:
Failure RSV-SRV-0063 An error occurred while executing the 'asynchRun_Request' 
command. CCL-BIT-0006 The HTTP message is unexpectedly short.

When the connection closes before the request is processed, the request is lost and the user must
resubmit the request.

Use the following steps to eliminate this error or reduce its frequency:

• From the install_location\wlp\usr\servers\cognosserver directory, open the
bootstrap.properties file in Notepad.

• In the bootstrap.properties file, locate the persist.timeout parameter, and increase its value
by 10-15 seconds. The default value is 60s.

• Restart the Cognos Analytics service.

If the issue is not resolved, repeat the steps increasing the time in 10-15 second intervals until the error
no longer or rarely occurs.

Font on UNIX not found when starting IBM Cognos Configuration
A common problem occurs on UNIX, when you start IBM Cognos Configuration.

The following error message may display:

Font specified in font.properties not found...

This error occurs if the Java Virtual Machine (JVM) is trying to use one or more fonts that are not installed
on your computer. However, the JVM should use the system default, and IBM Cognos Configuration
should start and run normally.

Procedure
Add the missing fonts to your Java Runtime Environment by editing the font.properties files.

Several font.properties files, which contain standard font environment information, are installed with your
Java Software Development Kit. You can find these files in the JRE_location/lib directory.

For more information, see the Java documentation.

ESSBASEPATH cannot be detected
For Microsoft Windows and UNIX platforms, Oracle Essbase software uses the ESSBASEPATH
environment variable to locate the Essbase 11 client software. The Oracle Hyperion Enterprise
Performance Management (EPM) System Installer creates ESSBASEPATH as a user environment variable.

If the IBM Cognos service is configured to run or log on as a system account, you must manually add
ESSBASEPATH as a system environment variable, if it does not exist. When IBM Cognos software cannot
locate the ESSBASEPATH environment variable, you receive the following error:

DB2-ERR-0044 Essbase environment variable "ESSBASEPATH" cannot be detected. Check if Essbase
client is installed.

To resolve this issue, do one of the following, and then restart the IBM Cognos service:
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• Double-click IBM Cognos service, and on the Log On tab, specify a user account that has access to
ESSBASEPATH.

• Add ESSBASEPATH as a system environment variable.

Note that if you are upgrading to Essbase 11 software from Essbase 9 software, you must install the
appropriate client and then edit the qfs_config.xml file to change the library name.

Changing the library name in the qfs_config.xml file
If you are upgrading to Essbase 11 software from Essbase 9 software, then after installing the appropriate
client, you must change the library name in the qfs_config.xml file.

Procedure
1. In the install_location/configuration directory, open the file named qfs_config.xml.
2. Find the line of code <provider name="DB2OlapODP" libraryName="essodp93"
connectionCode="DO"/> and change the library name from essodp93 to essodp111.

3. Save the changes.

Problems testing data source connections with IBM Cognos Analytics
deployed on SAP NetWeaver Application Server 7.1.1 on UNIX

If you have deployed IBM Cognos Analytics on SAP NetWeaver Application Server 7.1.1 running on a
UNIX operating system, you may receive an error when you test your data source connections in IBM
Cognos Administration.

To resolve this problem, you must update the library path and all paths used for database client access
in a SAP environment file named .sapenv_servername.sh, where servername is the name of your
server.

Procedure
1. Go to the SAP administrator user's home directory.
2. Locate the file named .sapenv_servername.sh, where servername is the name of your server.
3. Open the file in a text editor.
4. Add install_location/bin64 to the library path and any path locations required for database

client access.

For example, if you have installed IBM Cognos Analytics to /server1/home/ibm/cognos/install,
your library path would look like the following:

LIBPATH=/server1/home/ibm/cognos/install/bin64:/db/oracle/11.1.0.6/lib32:
/server1/home/db2user/sqllib/lib32:/usr/lib:/lib:$_DEF_EXE; export LIBPATH 

5. Save the file, and restart the SAP and IBM Cognos Analytics processes.
6. Test your database connections.

Group membership is missing from Active Directory namespace
If an Active Directory namespace is configured for the same forest and a user is authenticated using a
credential, the group membership will be missing.

The process identity of IBM Cognos Analytics, when running as a local system account or a domain user,
must have one of these privileges:

• impersonate a client after authentication
• act as part of the operating system

If the privilege is missing, there is no group membership for the authenticated user.
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Note:

To update a user's expired password, you must use a domain admin account (not a local system account).

Adding group membership for an Active Directory namespace
To add group membership for an Active Directory namespace, you must add the process identity for IBM
Cognos Analytics to the local security policy.

Procedure
1. From the Start menu, click Settings, Control Panel.
2. Click Administrative Tools, and then double-click Local Security Policy.
3. In the console tree, click Security Settings, Local Policies.
4. Click User Rights Assignment.
5. Add the process identity of IBM Cognos Analytics to one of the following policies:

• Impersonate a client after authentication

The default is Administrators, Service.

For more information, see the library article fe1fb475-4bc8-484b-9828-a096262b54ca1033.mspx
at the Microsoft Web site.

• Act as part of the operating system

The default is Local system.

For more information, see the library article ec4fd2bf-8f91-4122-8968-2213f96a95dc1033.mspx
at the Microsoft Web site.

Both of these privileges give an account the ability to act as another user.

The privilege Impersonate a client after authentication is similar to the Act as part of the operating
system privilege except that it will only allow a process to impersonate after authentication,
whereas the privilege Act as part of the operating system allows a process to impersonate before
authentication.

For more information, see the library article tkerbdel.mspx at the Microsoft Web site.

Query fails when using Oracle Essbase Server
You run a query to retrieve metadata or data from an Oracle Essbase server and you receive a message
similar to one of the following messages:

• The IBM Cognos gateway is unable to connect to the IBM Cognos Analytics server. The server may be
unavailable or the gateway may not be correctly configured.

• DB2-ERR-0005 An unknown error occurred during the login. Database error code: 1,042,006.
• XQE-DS-0006 Unable to logon to the data source.

These IBM Cognos errors can result from Windows not having enough sockets or ports available on the
Microsoft Windows operating system. A lack of sufficient ports can cause data retrieval from Essbase to
fail because of network communication errors.

To resolve this problem, increase the number of Windows sockets or ports that are available for program
use.
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Increasing the number of Windows sockets or ports
To resolve connection errors with an Oracle Essbase Server, increase the number of sockets or ports
on the Microsoft Windows operating system that are available for program use by adding two entries in
Microsoft Registry Editor.

Important: Use Microsoft Registry Editor at your own risk. Incorrect use may cause problems that require
you to reinstall your operating system. Microsoft cannot guarantee that you can solve problems that result
from using Registry Editor incorrectly.

Procedure
1. From the Windows Start menu, run the regedit application.
2. In the HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters directory,

create a new DWORD value named MaxUserPort.
3. Set the properties for MaxUserPort to use a value of 65534 and a base of Decimal.

The range for value is from 30000 to 65534.
4. In the same directory, add another DWORD value named TcpTimedWaitDelay.
5. Set the properties for TcpTimedWaitDelay to use a value of 50 and a base of Decimal.

The range for value is from 30 seconds to 300 seconds, with a default value of 240 seconds (4
minutes).

6. After closing the regedit application, restart the Microsoft CRM server or restart your computer.

Results
For more information, visit the technet2.microsoft.com Web site and search on the terms MaxUserPort
and TcpTimedWaitDelay.

Errors displayed when deploying to Oracle 10G Application Server
You are deploying IBM Cognos Analytics to an Oracle 10G Application Server.

The following error message may occur:
MDS-RUN-3213 Unable to locate database bulk load utility. Please install the 
appropriate database tool for this platform ('bcp' for SQL Server, 'sqlldr' 
for Oracle)

These errors occur because the bulk loading utilities (SQL Loader on Oracle) are not included in the
deployment file created by IBM Cognos Configuration.

Procedure
To install the missing components, use the Oracle client software on the computer where you installed
the Oracle 10G Application Server.

Ensure that you install SQL Loader.

CGI timeout error while connected to IBM Cognos Analytics through a Web
browser

When performing operations through your Web browser, you receive the following error message:

CGI Timeout, process will be deleted from server.

The error occurs when you use Microsoft Internet Information Services (IIS) as your Web server and the
gateway is configured to use CGI. IIS has a default timeout for CGI applications; you can increase the CGI
timeout in IIS
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Increasing the CGI timeout
To resolve a CGI timeout error in the Web browser, you can increase the duration of the CGI timeout in
IIS.

Procedure
1. In the administrative tools for Microsoft Windows operating system, open Internet Information

Services.
2. Under the local computer node, right-click Websites and select Properties.
3. In the Home Directory tab, click Configuration.
4. In the Process Options tab, increase the CGI script timeout.

Desktop icons or IBM Cognos Configuration window flicker on Windows
When you run IBM Cognos Configuration on Microsoft Windows operating system, you may notice that the
desktop icons or the IBM Cognos Configuration window flickers.

Procedure
Start IBM Cognos Configuration using the -noddraw command line option.

Missing translations for object names in some locales
After you upgrade IBM Cognos Analytics or import an archive, some object names might not be localized
for certain locales. For example, names display in English, and not in the specified language.

This problem might occur in the following situations:

• Cognos Analytics was upgraded to a newer version, but an older content store version was configured as
the active Content Manager.

• An archive that was created with IBM Cognos Business Intelligence or an older version of Cognos
Analytics was imported into a newer version of Cognos Analytics.

For example, you might encounter untranslated object names in the Catalan, Croatian, Danish, Greek,
Kazakh, Norwegian, Slovak, Slovenian, or Thai locale if your IBM Cognos Business Intellignce 10.2
installation is configured with the 10.1 version of Content Manager. Support for the above-mentioned
locales was added in IBM Cognos Business Intellignce versions 10.1.1 and 10.2 so your 10.1 version of
Content Manager does not have these translations.

To add the translations into the Cognos Analytics environment, perform the following procedure.

Procedure
1. Start IBM Cognos Configuration on the computer where the active Content Manager service is

installed.
2. From the Actions menu, click Edit Global Configuration.
3. Confirm that the required locales are listed on the Content Locales and Product Locales tabs. If the

locales are missing, add them and save your changes.
4. Go to install_location/webapps/p2pd/WEB-INF/classes directory, and confirm that a
cmmsgsRL_locale.properties message file exists for each required locale.
For example, for Slovenian this message file is the cmmsgsRL_sl.properties file.

5. In the install_location\configuration directory, copy the
updateInitialContentNames.xml.sample file and save it as
updateInitialContentNames.xml.

6. Edit the updateInitialContentNames.xml file:
a) Specify the locales that you want to add.
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For example, modify the file in the following way to display Croatian and Slovenian object names:

<updateInitialContentNames>
<locales>
<locale>hr</locale>
<locale>sl</locale>
</locales>
</updateInitialContentNames>

b) Remove or comment out any other locales that are not affected by the localization issue.
c) Save your changes.

7. Start the IBM Cognos service.
8. To add another locale later, repeat these steps.

Results
The localized object names are added during the IBM Cognos service startup process. You can view
the results of the operation in the cogaudit.log file. The updateInitialContentNames.xml file is
deleted in the process to prevent unnecessary updates on each restart.

IIS requests fail with the HTTP 502 Bad Gateway error in Cognos Analytics
In a Cognos Analytics environment with the Microsoft Internet Information Services (IIS) web server
installed with a gateway, users see HTTP 502 Bad Gateway errors when long-running requests are sent
through the IIS web server.

These errors can occur in the following situations:

• A client tool, such as PowerPlay, uses the IIS web server in the Gateway URI field, and users run reports
based on PowerPlay cubes.

• Users run large reports in Cognos Analytics or in an integrated tool, such as IBM Cognos for Microsoft
Office.

Other potential causes for HTTP 502 Bad Gateway errors with IIS are:

• Invalid reverse proxy URL.
• Incorrectly configured server farm (if using multiple application tiers when configuring IIS for Cognos

Analytics)
• Using HTTPS dispatcher URL in the reverse proxy, but not importing the dispatcher certificate on the IIS

server using Microsoft Management Console (MMC)

The issue does not occur when you log in to Cognos Analytics through the dispatcher URI and run the
same report.

Resolving the problem
To resolve the problem, complete the following steps in IIS:

• Set the Application Request Routing (ARR) timeout to a higher setting.

The default timeout is 120 seconds. You can try setting the timeout to 160 seconds.

– If a server farm is used (two or more dispatchers are configured for routing in IIS), the timeout setting
is located in: IIS > Server Farm > Proxy > Timeout.

– If a server farm is not used, the timeout setting is located in: IIS > Server Name (under Start Page) >
ARR Cache > Server Proxy Settings > Timeout.

• Restart the IIS server.
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Chapter 3. Security problems
You may encounter problems when you administer security for IBM Cognos components.

Problems Setting Up Security
The topics in this section document problems you may encounter when setting up security.

Access to Entries Is Denied During Deployment
If you deploy data using the Reports Administrator role, access to security entries may be denied. By
default, the Reports Administrator role does not have write access to the Cognos namespace.

Before you deploy, modify the permissions of this role to ensure that it has read and write permissions to
the Cognos namespace.

Prompt to Change Passwords When Logging on to an Active Directory
Namespace

When logging on to IBM Cognos components using a Microsoft Active Directory namespace, the
submitted password is recognized as expired and you are prompted to change it. This occurs even if
the password should still be valid. If the password is successfully changed, the behavior still occurs.

The following error message appears:
Your password has expired. Please change it.

Please type your credentials for authentication.

The solution is to set up the authority for delegated administration for IBM Cognos components. Ensure
that the server name or named account for starting the IBM Cognos service is set up in the Active
Directory properties as an authority for delegated administration. Without these permissions, IBM Cognos
components are unable to read all user properties from the Active Directory server.

For more information, see the Active Directory documentation.

Unable to Log on
If IBM Cognos components use an Active Directory Server as the security provider, you may not be able to
log on using only your user ID.

One of the following errors may appear:
Your password has expired. Please change it.
The provided credentials are invalid.

This problem occurs when the Content Manager service runs under the local system account and runs on
a computer that is not part of the Active Directory Server domain.

To log on, you must qualify your user ID using the domain name. For example, when you log on, type

domain\user ID

If you still cannot log on, contact your IBM Cognos security administrator.



CM-CAM-4005 unable to authenticate
The message CM-CAM-4005 unable to authenticate might appear when you attempt to log in to
IBM Cognos Analytics.

In addition, the following error messages are recorded in the CogAudit.log file:

• CM-SYS-5192 An error occurred with Content Manager
• CacheFreeList.allocateFromBlock::free list is empty
• CM-REQ-4377 Content Manager returned an error in the response header.
The following root cause is being returned in the response SOAP Header:
"cmCMError CacheFreeList.allocateFromBlock::free list is empty." This root
cause error has caused the following additional error messages to be returned
in the header: "[cmAuthenticateTCUnexpectedFault CM-HDR-4010 An unexpected
error occurred while authenticating using trusted credentials.]"

The message CacheFreeList.allocateFromBlock::free list is empty occurs when during
high-load periods Content Manager runs out of internal resources that are controlled by the
CacheFreeList structure. Maximum number of resources that CacheFreeList can hold can be
adjusted through the MAX_LOCK_HANDLES and CMCACHE_QUERYCACHE_FREELIST_SIZE advanced
settings.

Resolving the problem
To resolve this issue, in the bootstrap.properties file, for the MAX_LOCK_HANDLES and
CMCACHE_QUERYCACHE_FREELIST_SIZE advanced settings, specify a value of 20000. Follow these
steps:

1. Go to the Cognos Analytics installation_location\wlp\usr\servers\cognosserver
directory.

2. Copy the file bootstrap.properties and save it as bootstrap.properties.backup.
3. Open the bootstrap.properties file in a text editor.
4. Add the following line:

cm.advancedSettings=MAX_LOCK_HANDLES:20000;CMCACHE_QUERYCACHE_FREELIST_SIZE:
20000

5. Save the bootstrap.properties file.
6. Restart the Cognos Analytics service.

Certificate Authority Error When Logging on
You attempt to log on, entering a valid user ID and Password, in an environment that uses the default IBM
Cognos Cryptographic Provider settings. However, the following error message appears:

CAM-CRP-1071 Unable to process a remote request for the common symmetric key.
The certificate with the DN 'C=CA,O=Cognos,CN=CAMUSER' issued by the Certificate 
Authority with the DN 'C=CA,O=Cognos,CN=CA' is not trusted.
Reason: Exception thrown while doing CertPath validation
Cause: certificate expired on yyyymmddhhmmGMT+00:00

This problem occurs when the certificate issued by the Certificate Authority (CA) has expired. You can
renew the certificate by saving the configuration in IBM Cognos Configuration on the computer where
Content Manager is installed and then restarting the IBM Cognos service.
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HTTPS DRP-ERR-2068 Error in Log File When no Error Is Reported During a
Switch to HTTPS

You stopped the services on all computers in a distributed installation and configured the computers
to use SSL (HTTPS). You started the services successfully, with no reported errors. However, when you
checked the log file, you found an error similar to the following:

HTTPS DPR-ERR-2068 The administration request failed. Cannot connect to dispatcher.

The error occurred because when you restarted the services, the dispatchers were initializing and could
not communicate with each other. During the initialization, a normal administration request could not be
processed and a fault was generated. The fault was recognized as an initialization fault and so no error
was shown during the startup. However, IBM Cognos Application Firewall does not distinguish between a
regular fault and an initialization fault. As a security best practice, all messages are sent to the log file.

You can ignore the message in the log file.

Entries Do Not Appear for a Member of a Newly Created Group
A user who is a member of a newly created group, which is itself a member of the Query Users group, logs
on. The user sees that some entries, such as My Folders, are missing. The user name may also be missing
from the upper-left corner of the page.

The namespace that the user belongs to must have traverse rights to the Query Users group.

Procedure
1. On the Security tab in IBM Cognos Administration, click Users, Groups and Roles.
2. Next to the Cognos namespace, click the set properties button.
3. Click the Permissions tab.
4. If it is not already there, add the Query Users group to the namespace.
5. Click the check box for Query Users and ensure that Traverse permissions are granted.
6. Click Apply, and click OK.
7. Test with a user.

Existing Passwords May not Work in an SAP Namespace
When you log on using an SAP namespace, some previously functional passwords may no longer work.

The following error message may appear:

Unable to authenticate a user. Please contact your security administrator. Please type your credentials for
authentication.

This is because of a policy change in SAP software. In previous versions of SAP software, passwords were
not case sensitive. All password characters were automatically converted to uppercase. In SAP RFC 6.40,
password characters are not automatically converted to uppercase and so passwords are case sensitive.

To address the password policy change, the SAP BAPI interface introduced a new configuration parameter
named bapiPasswordConv. Using this parameter, you can enable or disable the functionality that
automatically converts all password characters to uppercase. To ensure that all previously created
passwords can still provide successful logon, set the value of the bapiPasswordConv parameter to true.

Procedure
1. Open the file bapiint_config.xml.

This file is located in the c8_location\configuration directory.
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2. Change the value of the bapiPasswordConv parameter to true, as shown in the following fragment of
code:

<bapiAbapDebug value="false"/> 
    <bapiTransCall value="false"/> 
    <bapiCharConv value="true"/> 
    <bapiCmdRecording value="false"/> 
    <bapiCacheReset value="false"/> 
    <bapiCallLocks value="false"/> 
    <bapiSupportCancel value="true"/> 
    <bapiMaxSuspendTime value="200"/> 
    <bapiPasswordConv value="true"/> 

3. Save the file.
4. Restart the IBM Cognos service.

Results
For more information, see the following SAP Notes:

• 792850 - Preparing ABAP systems to deal with incompatible passwords
• 862989 - New password rules as of Web AS ABAP 7.0/NetWeaver 2004

Users Are Repeatedly Prompted for Credentials When Trying to Log On to an
SAP Namespace

When users whose user IDs or passwords contain special characters try to log on to an SAP namespace,
they are repeatedly prompted for credentials and may not be granted access.

This is because SAP BW systems, version 3.5 and older, by default use a non-Unicode code page. Newer
SAP systems use a Unicode code page. As a result, the default SAP server code page was modified for the
SAP authentication provider to use a Unicode code page, which is SAP CP 4110.

To avoid this issue, in IBM Cognos Configuration, modify the default SAP BW Server Code Page
parameter for the SAP authentication provider to use a non-Unicode code page, such as SAP CP 1100.

Problems Using Authentication Providers
The topics in this section document problems you may encounter when using an authentication provider.

Unauthorized users can run reports
You use Signons for authentication to create a data source connection, which allows users to use the
same user name and password. Later, you modify to use an external namespace instead, such as LDAP,
and the original signon is still used for authentication. This happens when the original signon was used
because the information is subsequently stored in the content store.

About this task
For example, when a report is in development and testing, you create a data source connection
using Signons as the method of authentication. When the report goes to production, you change the
authentication to an external namespace. You think that the namespace is being used for authentication
but instead the original signon username and password are being used. This could create unexpected
results due to order of preference.

Procedure
1. Launch IBM Cognos Administration.
2. On the Configuration tab, select Data Source Connections.
3. Click the data source and then click the data source.
4. On the next page, click the data source again.
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5. Select the check box for the sign on, then click Delete.

Results
The signon is deleted.

Expired Password Error Appears When Using Active Directory Server
You use Active Directory Server as an authentication provider. When you log on to IBM Cognos
components, you see the following error message:
Your password has expired. Please change it.
Please type your credentials for authentication.

Ensure that you set up the authority for delegated administration for IBM Cognos components. The server
name or named account for starting the IBM Cognos service must be set up in the Active Directory Server
as an authority for delegated administration. IBM Cognos components can then read all user properties
from the Active Directory server. For more information, see the Active Directory Server documentation.

Single Signon Is Not Working When Using Active Directory Server
You use Active Directory Server as an authentication provider and single signon is not working.

To ensure that users are not prompted to log on to IBM Cognos components, the following must be true:

• Active Directory is running in native mode.
• The user does not have the Account is sensitive and cannot be delegated attribute selected.
• For each IIS Web server, the following must be true:

– This computer is part of the Active Directory domain.
– If the process is running as a Local System Account, the Trust computer for delegation attribute is

selected.
– If the process is running as a Domain User Account, the Account is trusted for delegation attribute is

selected.
• For each IBM Cognos Content Manager server, the following must be true:

– This computer is part of the Active Directory domain
– If the process is running as a Local System Account, the Trust computer for delegation attribute is

selected
– If the process is running as a domain User Account, the Account is trusted for delegation attribute is

selected.
• Kerberos authentication must be the active WWW-authentication header.

Note: Kerberos will not work in an Internet zone.

Unable to Identify Required SAP Permissions
You may encounter errors using SAP BW because your SAP user signon does not have sufficient
permissions. To identify the permissions needed, use the ST01 transaction.

Procedure
1. In SAP R/3, type /ST01 in the command window.
2. Under Trace components, select Authorization check.
3. Select Change trace.
4. In the Options for Trace Analysis Field, under General Restrictions, enter the user name of the IBM

Cognos account you are tracing.
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Unable to Access IBM Cognos Administration When an NTLM Namespace Is
Used and Single Signon Is Enabled

When you are logged into IBM Cognos software using an NTLM namespace and single signon is enabled
for your system, an IBM Cognos Application Firewall (CAF) error may occur when you try to access IBM
Cognos Administration.

To avoid this problem, resolve any possible issues related to the gateway host name. You can either
ensure that the gateway host name matches the gateway host or you can add the name of the gateway
server to the list of valid domains and hosts.

Match the Gateway Host Name
The procedure to match the gateway host name is as follows.

Procedure
1. Open IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. In the Properties window, under Gateway Settings, ensure that Gateway URI specifies the correct

server name or IP address and not localhost.

Tip: We recommend specifying a server name or IP address, not localhost, for all URI properties.
4. Save the configuration.

Add the Gateway Server as a Valid Host
The procedure to add the gateway server as a valid host.

Procedure
1. Open IBM Cognos Configuration.
2. In the Explorer window, under Security, click IBM Cognos Application Firewall.
3. In the Properties window, click the Value column for Valid domains or hosts and then click the edit

button.
4. Click Add.
5. Type the name of the gateway server in the blank row and then click OK.

For more information about valid domains, see the Installation and Configuration Guide.
6. Save the configuration.
7. Restart the IBM Cognos service.

Unable to Automatically Connect to an SAP BW Data Source by SSO
You are unable to connect to an SAP BW data source, by SSO, even though it is configured to use an
external SAP namespace for authentication.

This problem occurs if all of the following conditions are met:

• An SAP namespace is configured in IBM Cognos pointing to SAP BW System A.
• IBM Cognos users are logged on to the SAP namespace using credentials (a user name and password),

and not through the SAP Portal using single sign-on.
• A data source referring to SAP BW system B is defined and is configured to use an external namespace

for data source authentication. The namespace referred to as external is the SAP namespace configured
for authenticating users to IBM Cognos components.
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• SSO tickets are enabled for the SAP BW server associated with the SAP namespace.

The SAP provider generates and caches SAP logon tickets to be used for authentication with an SAP data
source. The provider uses the current user credentials, user name and password, to generate an SAP
logon ticket.

If the SAP BW system associated with the data source does not accept logon tickets because of the SAP
server configuration, or if the logon ticket presented is not valid because it originates from a system in a
different SAP SSO domain, data source authentication will fail.

To solve this problem, you can federate the SAP systems into one SAP SSO domain so that the ticket
generated for the user in one system is valid in the other system as well. If this solution is not possible,
disable the use of SAP BW SSO tickets for the provider to trigger it to fall back to passing the credentials
of the current user instead of a logon ticket. The credentials must be valid for all systems accessed as a
data source.

You can disable SAP SSO tickets either on the SAP BW system used as a data source, or by specifying the
bapiSSOSupport parameter in the bapiint_config.xml file installed with IBM Cognos components. As a
result, the provider will use the entered credentials of the current user for data source authentication.

To disable the use of SSO tickets for data source authentication in the bapiint_config.xml file, perform the
following steps for all IBM Cognos application tier components installed in your system.

Procedure
1. Stop the IBM Cognos service.
2. Open the bapiint_config.xml file.

This file is located in the install_location/configuration directory.
3. Search for the bapiSSOSupport parameter and change its value to 0, as shown in the following

example:

<bapiSSOSupport value="0"

If this parameter is not specified in the file, you must add it under the root element.
4. Save the bapiint_config.xml file.
5. Start the IBM Cognos service.
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Chapter 4. Administration problems
You may encounter problems when you administer IBM Cognos software.

Data source connection problems
Each data source can contain one or more physical connections to databases. The topics in this section
document problems you may encounter when setting up a data source connection.

Cannot Connect to an SQL Server Database Using an OLE DB Connection
You cannot create a native connection to a Microsoft SQL Server using OLE DB.

The following error messages appear:
QE-DEF-0285 Logon failure
QE-DEF-0325 The cause of the logon failure is:
QE-DEF-0068 Unable to connect to at least one database during a multi-database 
attach to 1 database(s) in: testDataSourceConnection
UDA-SQL-0031 Unable to access the "testDataSourceConnection" database
UDA-SQL-0107 A general exception has occurred during the operation "{0}"
UDA-SQL-0208 There was an error initializing "MSDA" for OLEDB

The solution is to ensure that MDAC version 2.71 or higher is installed. The registry of the local system
should hold the MDAC version information.

Intermittent Problems Connecting to an SQL Server Database
You use SQL Server database as a reporting data source.

You test the same database connection several times. Sometimes the test succeeds, but other times you
see one of the following or a similar error message:

SQL Server cannot be found.

Access denied.

In addition, when you run reports, sometimes they run but other times you see the following or a similar
error message:

Connection not found - Check DNS entry or select different connection.

You may also have problems creating the database that is used for the content store.

These errors can occur if you configure named pipes instead of TCP/IP protocol as the default network
library in the SQL Server Client Network Utility for a SQL Server reporting or content store database.

Oracle Kerberos JDBC connection failure: Unsupported key type found the
default TGT: 18

When you attempt to connect to an Oracle Kerberos data source via JDBC, the following message
appears:

Unsupported key type found the default TGT: 18

IO Error: The service in process is not supported. Unable to obtain Principal
Name for authentication

This issue occurs because Cognos Analytics is not configured with the ciphersuites used for encryption in
the file krb.conf.

For more information, see Configure JDBC data source connections for single sign-on using Kerberos.



Resolving the problem
To resolve this issue, perform these steps on all of your Cognos Analytics application servers:

1. Locate the file krb5.ini and open it in a text editor.

Tip: For more information, see Creating Kerberos initialization files.
2. Make a note of all the values of the following settings:

• default_tgs_enctypes
• default_tkt_enctypes
• permitted_enctypes

3. Start Cognos Configuration.
4. Navigate to Security > Cryptography > Supported ciphersuites.

5. Click the pencil icon .

The Value - Supported cipher suites window appears.
6. In the Available values list, select the check boxes corresponding to all the values you noted in step

“2” on page 50.
7. Click Add to move the selected values to the Current values list.
8. Click OK.
9. Save the configuration, and then restart the Cognos Analytics service.

Content Manager Connection Problem in Oracle (Error CM-CFG-5036)
Starting the IBM Cognos Service does not create the tables in an Oracle Content Manager.

One of the following error messages is generated:

CM-CFG-5063 A Content Manager configuration error was detected while connecting to the content store.

CM-CFG-5036 Content Manager failed to connect to the content store.

CM-SYS-5007 Content Manager failed to start. Review the Content Manager log files and then contact your
system administrator or customer support.

When you create a new database in Oracle, the SID name that is created has no underscore in it. You must
use this SID with no underscore as the Service Name in IBM Cognos Configuration.

Procedure
1. Ensure that you can contact the Oracle instance through tnsping <SID> where the <SID> does not

contain an underscore.
2. Configure the Oracle Content Manager connection in IBM Cognos Configuration so that the Service

Name is the same as the <SID> in step 1.

Error when importing Sybase metadata
When you import Sybase metadata in which DatabaseMetadata.getTables is called, an error
message appears if the database includes user-defined functions.

The error message appears similar to the following:

MSR_GEN_0097 Error while getting catalogs and schemas for: "SYBASEASE_CERT". Unable to connect 
to the data source. "JZ00L: Login
failed. Examine the SQLWarnings chained to this exception for the reason(s)

com.sybase.jdbc4.jdbc.SybSQLException: No such object or user exists in the database.
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To avoid this issue, ensure that the response from DatabaseMetadata.getTables only describes
objects that include Tables and Views.

Cannot Connect to an OLAP Data Source
You cannot connect to an OLAP source, such as SAP BW, Essbase, or Db2 OLAP.

Confirm the following:

• You can open the OLAP server from Microsoft Excel. Most OLAP vendors have a plug-in which allows
connectivity through Excel.

• You have the correct client software installed on the relevant IBM Cognos servers. Any IBM Cognos
computer which retrieves data from the OLAP source must have the appropriate client software.

• For MSAS, check that Pivot Table service is installed and the correct service pack is applied.
• You can open the OLAP source through IBM Cognos Series 7.
• You can open either the OLAP vendor samples or the IBM Cognos samples. The problem may be
specific to one model, outline, or cube.

• The user making the request from IBM Cognos software is a Domain user with the appropriate access
rights.

Unable to Select ODBC as the Type of Data Source Connection
Because IBM Cognos software on UNIX does not support all ODBC drivers, when you create data source
connections to IBM Red Brick®, Microsoft SQL Server, or NCR Teradata databases, you cannot select
ODBC as the type of data source connection.

To create an ODBC connection to these database vendors, select Other Type instead.

For the following database vendors, add the associated database codes when you type the connection
string.

Table 9. Database codes used for connections string according to the associated database vendor

Database vendor Database code

IBM Red Brick RB

Microsoft SQL Server SS

NCR Teradata TD

Type the data source connection, as follows:

[^UserID:[^?Password:]];LOCAL;{RBSSTD};DSN= Data_Source [; UID=%s[;PWD=%s]][@ASYNC={01}]
[@ Connection_Timeout/ Reply_Timeout ][@COLSEQ=[ Collation_Sequence ]]

The following are examples of connection strings:

• ^UserID:^?Password:;LOCAL;RB;DSN=DB62SALES;UID=%s;PWD=%s@ASYNC=0
• ;LOCAL;SS;DSN=TESTSERVER

To create data source connections to Microsoft SQL Server from UNIX, you must use the DataDirect ODBC
driver for SQL Server.

Error When Creating a Data Source Connection to a PowerCube
When you create a data source connection to a PowerCube where both the PowerCube and all report
servers are on UNIX or Linux computers, the following error may appear:

The field "Windows location:" is mandatory
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To solve the problem, type any characters in the Windows location field. The UNIX or Linux location
must be correct.

CAM-CRP-0016 Unable to process the configuration data in the
cryptographic engine

This error message can occur when Cognos Analytics is bundled with a product that connects to an
external database. When you create a data server connection to the database, the password for the
database is stored in an encrypted file. However, if the database password changes, the data server
connection no longer works.

Initially, the following message appears:

The IBM Cognos gateway is unable to connect to the IBM Cognos Analytics server.
The server may be unavailable or the gateway may not be correctly configured.

Another, more precise error message appears in the file cogaudit.log:

CAM-CRP-0016 Unable to process the configuration data in the cryptographic
engine.<errorCode>-13</errorCode>CAM-CRP-0277 Unable to open the key
store file '/data/ibm/cognos/analytics/cgi-bin/../configuration/encryptkeypair/
jEncKeystore'.

Resolving the problem
When the database password changes, you must update the database password file for the bundled
product, encrypt it, and then use it to replace the encrypted password file in the Cognos Analytics
environment.

For example, to resolve this issue when Cognos Analytics is bundled with IBM Maximo, follow these steps:

1. In the Maximo environment, update the database password file.

a. Go to Maximo_installation_location\reports\cognos\analytics\configuration
b. Edit the file mxcognosdatasources.properties.
c. Change the database password in this line:

maximoDataSource.password=cognos_password

2. Encrypt the password file.

a. Go to Maximo_installation_location\reports\cognos\tools
b. Run encryptproperties.cmd (in Windows)

OR

Run encryptproperties.sh (in UNIX/Linux)

A new, encrypted password file mxcognosdatasources_enc.properties appears in
Maximo_installation_location\reports\cognos\analytics\configuration

3. Replace the old encrypted password file in the Cognos Analytics environment with the one you just
created.

a. Copy the file mxcognosdatasources_enc.properties from
Maximo_installation_location\reports\cognos\analytics\configuration

b. Paste the copied file into this folder:
Cognos_Analytics_installation_location\configuration

c. Rename the copied file mxcognosdatasources_enc.properties to
mxcognosdatasources.properties

The old encrypted password file is overwritten by the new one.
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4. In Cognos_Analytics_installation_location\configuration, grant full read/write
privileges to the files csk and cogconfig.prefs.

5. Restart the Cognos and Maximo services.

Other administration problems
This section documents problems that you might encounter when administering IBM Cognos software.

Restarting Servers After Solving Content Store Problems
If the content store becomes unavailable, after resolving the problem, you must stop and restart IBM
Cognos services to resume processing.

An Update or Delete Request Fails
When any property of an object changes, the version property associated with the object changes. If you
try to update or delete an object, the request fails if the value of the version property changed after you
retrieved the object from the data store.

For example, if two administrators read the properties of the same object at the same time, they both
have the same version of the object. If they both try to update, the first update request succeeds.
However, the second update request fails because the version of the object no longer matches the version
retrieved from the data store.

If this happens when you submit an update request, you must read the data again to get the current
version of the object and then resubmit your update request.

Higher Logging Levels Negatively Affect Performance
All the IBM Cognos services send events to the log server, which directs messages to a log file. After an
error or problem occurs, you can review the log messages to obtain clues as to what happened.

Log messages also provide the status of components and a high-level view of important events, such as
successful completions and fatal errors

In the server administration tool, five levels of logging are available. They range from minimal, which logs
the least amount of detail and is intended for less frequent events, to full, which logs more detail and is
intended for more frequent events and detailed troubleshooting purposes.

Increasing the logging level may negatively affect the performance of IBM Cognos software. The higher
the level of detail logged, the more resources that are used. If performance is slow, you can try lowering
the logging levels.

To access the server administration tool, you must have execute permissions for the Administration
secured function.

Procedure
1. On the Configuration tab in IBM Cognos Administration, click Dispatchers and Services.
2. In the Actions column, click the set properties button for the dispatcher or configuration folder you

want.
3. Click the Settings tab to view all the configuration settings.
4. In the Value column, click a new value for the following settings, each of which represents a logging

category:

• Audit logging level

• Audit run-time usage logging level

• Audit administration logging level

• Audit other logging level
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Tip: If you want to reset a configuration setting to its default value, select its check box and click Reset
to parent value.

5. Click OK.

Unable to Identify SAP BW Version and Corrections
You must use supported versions and patch levels of SAP BW, so you must be able to see a list of patches
(correction notes) that have been applied.

For more information about supported versions, see the IBM Software Product Compatibility Reports
page (www.ibm.com/support/pages/node/735235).

To see a list of correction notes that have been applied, you can run one of two transactions in R/3: SE95,
or SNOTE.

In all cases, you must be authorized to run these transactions. In some cases, you may need to run the
transactions using the same account that was used to apply the correction notes.

Procedure
1. In SAP R/3, type /SE95 in the command window.
2. Enter an asterisk (*) in the Last Changed By field, to view all notes.
3. Select the type of modification in the Modifications tab.

SBW-ERR-0020 Error When Running Reports Based on SAP BW Data
Sources

Occasionally, when you run reports based on an SAP BWdata source, the following error message may
appear:

Querying the SAP BW cube's failed. SAP error code: BAP-ERR-0002 A BAPI error has occurred in the
function module BAPI_MDDATASET_GET_AXIS_DATA. &INCLUDE INCL_INSTALLATION_ERROR

This message means that SAP BWhas run out of resources.

In this situation, we recommend contacting your system administrator.

Links to Referenced Content Objects are Broken Following Deployment
After you import a deployment archive to a new location, some links for objects associated with reports
do not work.

When you import content objects which contain references to other objects that are not in the target
environment, these references are removed. For example, if you deploy an archive containing reports
based on a metadata package that is not in the deployment archive or the target environment, then the
links will remain broken even if the referenced object is subsequently created.

To solve this problem, do one of the following:

• Reimport your deployment package after the target objects have been created. The objects will be
automatically linked

• Manually reconnect the links to an object.

Table or View Does not Exist for Sample Database
The schema property in each of the Framework Manager models is synchronized to run against the
schemas defined in the sample databases.

If you change any of the database schemas, you receive an error connected to the Framework Manager
model that says the table or view does not exist.
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To solve the problem, open the model in Framework Manager and update the schema name and then
re-publish all packages.

CNC-ASV-0007 Error When Calling a Report Trigger From a Web Service Task
When calling a report trigger from a Web service task, the following error message may appear:

CNC-ASV-0007 An error occurred with the agent Web service task. The operation failed.
org.apache.wsif.WSIFException: CloneNotSupportedException cloning context.

This problem is related to the replacement of your existing Java Runtime Environment (JRE) by to the JRE
used by IBM Cognos Analytics.

To avoid this problem, modify the bootstrap_win32.xml file in the installation_location\bin directory by
adding the following line of code for the spawn element under <process name="catalina"> :

<param condName="${java_vendor}" condValue="IBM">-Xss128m</param>

Java Virtual Machine Fails Under Load When Multiple Users Run IBM Cognos
Workspace Dashboards

Using JRE 1.6 SR6 for Microsoft Windows, the following occurs:

• the Java PID disappears
• the Java core is not generated
• the Java.exe disappears
• there is no sign of a memory leak or high CPU utilization
• when the java.exe fails, the following error is reported in the Microsoft Windows Event Viewer:

Faulting application java.exe, version 6.0.0.0, faulting module j9jit24.dll, version 2.4.0.42924, fault
address 0x002ec4c2.

• both the cgsLauncher and BIBus processes become orphans and a new Java process is launched
• no errors are written to IBM Cognos Analytics, version 10.1, log files

The workaround is to set the TR_DisableEBPasGPR environment variable to TR_DisableEBPasGPR = 1,
before starting the Java Virtual Machine (JVM).

Oracle Essbase Version 11 Substitution Variables Must Be Set at the Cube
Level

In IBM Cognos Analytics, for Microsoft Windows operating systems, substitution variables that are
created using the application manager on the Oracle Essbase server can be used to alter the context
of a report. For example, by using substitution variables, such as current month or current quarter, you
can change the assigned value in one place and the appropriate reports are dynamically updated when
the report is run in all IBM Cognos studios. A given substitution variable can be set for an entire server, an
application, or a database.

Substitution variables that are created with Oracle Essbase version 11 and intended for use with IBM
Cognos Analytics can only be set at the cube level (application or database). but not at the server level.
The following Db2 error message is displayed all IBM Cognos studios when attempting to load a cube that
contains a substitution variable created at the server level:
DB2-ERR-0033 An error occurred while trying to access the substitution variables.
Database error code: 1,051,085.
Code 1051085 corresponds to the following Oracle Essbase error message:
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You do not have sufficient access to get this substitution variable.

CNC-SDS-0413 Error when executing a scheduled report
When executing a scheduled report, the user authentication fails with the following error message:

CNC-SDS-0413 There is a problem in executing the task. The user authentication failed. It may not be
possible to rerun the task.

About this task
The report fails because the credentials are invalid. Invalid credentials can occur when the user password
has expired or been altered, or the user account is invalid. When credentials are invalid, the current user
credentials do not match the credentials stored in the Content Store database. You can use a job and
schedule monitor service (JSM) trace, previously known as scheduling and delivery service (SDS), to help
trap the errors related to the scheduled reports.

If the schedule is using an invalid user account, login as a valid user, schedule the report using the valid
account, and click Save. The schedule will now use the valid user account. If the credentials are invalid
because they have expired or have been altered, you must renew the credentials.

Procedure
1. In My Preferences, renew your credentials.
2. Test for the error.

You can do this by scheduling the reports to run or creating a trigger to run the reports.
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Chapter 5. Problems when using Framework Manager
You may encounter problems when working in Framework Manager.

BMT-MD-003 error when creating a new project after upgrading
from a previous version of Cognos Framework Manager

If you upgrade IBM Cognos Framework Manager from version 11.0.3 or older, you must change the value
of the Dispatcher URI for external applications in IBM Cognos Configuration.

The format of the Dispatcher URI for external applications has changed from http://
<server>:<port>/p2pd/servlet/dispatch to http://<server>:<port>/bi/v1/disp.

Unable to Compare Two CLOBs in Oracle
If you are using Oracle and ask IBM Cognos Analytics to compare two CLOBs, such as where C2 is equal
to C3 (C2 = C3), you will see an Oracle runtime error.

To avoid this problem, use the DBMS_LOB.compare method:

where 0 = dmbs_lob.compare (c1, c2)

An Out of Memory Error with ERWin Imported Metadata
When you test query subjects based on a View table, an Out of Memory error may occur while performing
the sqlPrepareWithOptions operation.

The solution is to create a data source query subject using the same Content Manager connection as the
ERWin model.

Framework Manager Cannot Access the Gateway URI
When you create a new project in Framework Manager, Framework Manager cannot access the Gateway
URI.

The following message appears:

Unable to access service at URL:

http://hostname:80/ibmcognos/bi/v1/disp/

b_acton=xts.run&m=portal/close.xts

Please check that your gateway URI information is configured correctly and that the service is available.

For further information please contact your service administrator.

This message appears if the gateway is not properly configured. The gateway URI must be set to the
computer name where IBM Cognos Analytics is installed and reflect the type of gateway you are using.
You must log on as an administrator to configure the gateway URI.

Procedure
1. Close Framework Manager.
2. In IBM Cognos Configuration, in the Explorer window, click Environment.



3. In the Properties window, in the Gateway URI box, type the appropriate value:

• To use ISAPI, replace cognos.cgi with cognosisapi.dll.

• To use apache_mod, replace cognos.cgi with mod_cognos.dll.

• To use a servlet gateway, type the following:

http[s]://host:port/context_name/servlet/Gateway

Note: context_name is the name you assigned to the ServletGateway Web application when you
deployed the ServletGateway WAR file.

• If you are not using a Web server, to use the dispatcher as the gateway, type the following:

http[s]://host:port/p2pd/servlet/dispatch
4. If required, change the host name portion of the Gateway URI from localhost to either the IP address

of the computer or the computer name.
5. From the File menu, click Save.
6. From the Actions menu, click Restart.

Object Names Appear in the Wrong Language
When you import multiple languages from an SAP BW Query to a Framework Manager model, not all the
object names retrieved from SAP BW appear in the correct language.

To avoid this problem, save the SAP BW Query again in each of the logon languages in Business Explorer
Query Designer. The correct language texts will then show correctly in Framework Manager.

Error When Testing Query Subjects in a Model Imported from
Teradata

You are using a model imported from Teradata. When you test some query subjects that contain graphic
items, you see this error:

QE-DEF-0177 An error occurred while performing operation 'sqlOpenResult' status='-28'.

UDA-SQL-0114 The cursor supplied to the operation "sqlOpenResult" is inactive.

UDA-SQL-0107 A general exception has occurred during the operation "SgiCursor::doOpenResult()".

[NCR][ODBC Teradata Driver][Teradata RDBMS] An unknown character string translation was requested.

The reason is that the GRAPHIC and VARGRAPHIC data types are not supported.

Error for Type-In SQL Query Subject
You define the following in Db2:

create type address as (
    number character (6),
    street varchar(35),
    city varchar(35)
    )
MODE DB2SQL;
create table emp ( emp_no int, emp_address address);
Select e.emp_no, e.emp_address..street from emp e
SQL0206N "aBmtQuerySubject.2

When you define a type-in SQL query subject, an error appears because of the name assigned for the
attribute reference in the structured type.
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To resolve this problem, you have two options:

• assign a simple correlation name to the column in the original query subject, such as Select
e.emp_no, e.emp_address..street as "ABC" from emp e

• use pass-through notation for the query subject by surrounding the column with double braces ({{ }})

QE-DEF-0259 Error
This error occurs if you use braces { } in the wrong position in an expression. IBM Cognos Analytics
expects anything between the braces { } to be at the same level as a function. If you have used braces
elsewhere in an expression, you will see the following error message:

QE-DEF-0259 There was a parsing error

You can also use braces to send unique syntax to the data source. For example, your database uses a
keyword for a function, but this keyword is not used in IBM Cognos Analytics.

IBM Cognos Analytics does not validate the syntax you enter between braces. The syntax is simply sent to
the data source.

The solution is to make sure that braces are not used in the wrong positions.

For example, you type the following in an expression:

[ss_ole_both].[authors_lith].[au_id] = [ss_ole_both].[authors_latin].[au_id]
 { collate Lithuanian_CI_AI}

You see the following error message:

QE-DEF-0259 There was a parsing error before or near position: 75, text starting at position: 5 "le_both].
[authors_lith].[au_id]=[ss_ole_both].[authors_latin].[au_id]{"

Meanwhile the following expression is valid:

{ Q3.au_id }  =  { Q4.au_id collate lithuanian_CI_AI
}

Externalized Key Figures Dimension Retains Old Prompt Value
You have a key figures dimension (SAP BW) that contains an optional prompt. If you externalize this
dimension as a csv or tab file, the externalized file does not contain all the rows of data. This is because
the prompt value is retained.

For example, you set the prompt value for the dimension when testing the dimension in Framework
Manager. The prompt value is kept in the cache. Even if you clear the value of the prompt in the Prompt
dialog box, externalizing the key figures dimension results in a file containing data that is filtered by the
most recently used prompt.

To avoid this problem, do one of the following:

• Do not test the key figures dimension before you externalize it.
• Close the model, open it again, and externalize the key figures dimension.

Older Models Display Level Object Security
If you are using a previously-created IBM Cognos model, object security on a level may have been
defined. Object security on a level is not supported.

The solution is to verify and repair the older model before publishing it.
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Procedure
1. From the Project menu, click Verify Model.
2. Select the security view that references a level and click Repair.

Exporting a Framework Manager Model to a CWM File Fails With
Error MILOG.TXT was not found

Exporting a Framework model to a CWM file fails with error MILOG.TXT was not found when the path
contains Japanese characters.

Do one of the following to solve this problem:

• Specify an export path that does not use Japanese characters.
• Change the system default language on your computer to Japanese. You can set the system default

language in the Control Panel, under Regional and Language Options -> Advanced. For more
information on how to do this, refer to the Microsoft Windows operating system help.

Difference in SQL for Inner Joins After Upgrading
If you migrated from a version of the product earlier than IBM Cognos 8.3, there can be differences in the
generation of SQL used for the INNER JOIN syntax.

You can control the SQL syntax used for inner joins by configuring the setting for the SQL Join Syntax
governor. The SQL join syntax generated in all versions of IBM Cognos Analytics produces the same result.

If you are using RDBMS materialization technology which can be implemented using either implicit or
explicit syntax, you must ensure that you select the same syntax setting for the SQL Join Syntax governor
in your model.

Searching for values might return unexpected results
In the expression editor, when searching for values for a data item, the results you obtain might contain
unexpected results if the data item is not a string data type. Because you can edit the expression for a
data item, IBM Cognos Analytics cannot determine with certainty what the data type is.

Therefore, IBM Cognos Analytics guesses the data type of the data item by looking at its aggregate and
rollup aggregate set.
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Chapter 6. Problems When Using Transformer
You may encounter problems when working with IBM Cognos Transformer.

Problems when Modeling in IBM Cognos Transformer
You may encounter problems when modeling in IBM Cognos Transformer.

BAPI Error Occurs After the Prompt Specification File Edited Manually
In Transformer, you create a prompt specification for a SAP-based package.

You edit the prompt specification file, prompt.xml, manually and save your changes. After editing the file,
you attempt to generate a PowerCube using the command line options, for example,

cogtr -fpromptspecfilename -n cubename.mdl

but the PowerCube is not generated and you receive a BAPI error.

The error is caused by an invalid member unique name (MUN). Because editing the prompt.xml file
manually is error prone, we recommend that you do not edit the prompt.xml file manually but create an
alternate prompt specification instead.

Unable to Access an IQD Data Source Using a Sybase Database Connection
In Framework Manager, you use an IQD file to externalize a model using a Sybase database connection.

When you attempt to import the data source file into Transformer, you receive the following error
message:

[TR1907] Transformer cannot gain access to database database_name with signon information <user ID,
password>.

The database connection fails because quotes are added to the SQL query when the data source is
created in Framework Manager.

To successfully connect to the IQD data source and import the model, you must first edit certain
configuration files in the CS7Gateways\bin directory.

Procedure
1. Open the cs7g.ini file and ensure the database type in the connection string is CT, not CT15.

Cs7g.ini is located in the installation_location\CS7Gateways\bin directory.
2. In the [Services] section, include the following:

CTDBA=ctdba, ctdba15
3. Save your changes.
4. Open the cogdmct.ini file and in the [UDA USER OPTIONS] section, specify the following:

Attach=SET QUOTED_IDENTIFIER ON

Cogdmct.ini is located in the installation_location\CS7Gateways\bin directory.
5. Save your changes.
6. Open Transformer and import the data source.



Unable to use an IQD created in Framework Manager that contains an Oracle
stored procedure

In Transformer, when trying to open an IQD created in Framework Manager that contains an Oracle stored
procedure, you may receive a message similar to the following:
(TR0118) Transformer can't read the database [datasource] defined in 
Lan_location\datasource\iqd_name.iqd
DMS-E_General A general exception has occurred during operation 'execute'.
The native SQL generated in an IQD created in Framework Manager is wrong. 
The IQD cannot be used in Transformer.

To resolve this problem, execute the stored procedure in Framework Manager and set the Externalize
Method to IQD. Create a model query subject from the executed stored procedure, then publish the
package and open it in Transformer.

Preventing Errors When Model Calculations Use Double Quotation Marks
If you try to open an .mdl-format model containing calculations that include double quotation marks,
as might be used to create concatenated categories, you may get an error, even if you followed the
recommended practice of wrapping these calculations in single quotation marks.

This is because .mdl-format models do not support the use of single and double quotation marks
together, if the ObjectIDOutput flag is set to True, which is the default model creation setting.

To avoid this problem, you have two choices:

• You can open the cogtr.xml.sample file in a text editor, search for the string ObjectIDOutput, and change
the setting to 0. Save the cogtr.xml.sample file as cogtr.xml. Restart Transformer, and resave the model.

• You can use your RDBMS or a tool such as Framework Manager to perform the required calculations,
and then import the data into your model.

Whichever strategy you choose, you can then open the .mdl or py?-format model without error.

Framework Manager and Transformer May Display Different Locale Session
Parameters for Some Languages

Transformer may not return data in the expected locale during test or cube build when the following
conditions are encountered:

• The locale shown in the File/Session information in Transformer is not included in the Framework
Manager parameter map for session parameters.

• The modeler attempts to create a data source in Transformer using a query subject from the package
where the locale does not exist.

When this is encountered, the locale of the modeler’s session parameter does not exist in the Framework
Manager parameter map. As a result, the data returned will not be the locale of the Session information
shown in Transformer.

To avoid this problem, add the locale string that is displayed in the Transformer File/Session information
to the Framework Manager parameter list so that Transformer can retrieve the expected data when
accessing the data source. However, the model metadata will still be shown in English, or in the
Framework Manager design language.

62   IBM Cognos Analytics Version 11.1.0 : Troubleshooting Guide



Regular Columns Cannot Be Converted to Calculated Columns and Vice
Versa

When you attempt to convert a regular column to a calculated column by opening the Column property
sheet, the Calculated button is unavailable.

In Transformer version 10.1.0, you can no longer convert an existing regular column to a calculated
column by changing the column properties. Similarly, existing calculated columns cannot be converted
into regular columns by changing the column properties.

You can only create calculated columns using the Insert Column feature. For more information, see the
topic "Define a Calculated Column" in the IBM Cognos Transformer User Guide.

This does not affect how calculated columns are imported from an IBM Cognos Series 7 model into
Transformer. Existing calculated columns originally created in IBM Cognos Series 7 will be imported
correctly.

Transformer Takes a Long Time to Retrieve Data from an SAP-based Data
Source

You are attempting to retrieve data from an SAP-based data source in Transformer with null suppression
turned off. The retrieval takes a long time to complete.

Ensure that the machine where Transformer is installed has sufficient memory to perform the import. If
physical memory is limited, Transformer may perform the operation very slowly. In this situation, you can
end the task using Task Manager.

Categories Missing When Creating a Transformer Model Based on an SAP
Query Containing a Manually Created SAP Structure

The stream extract interface that reads the fact data doesn't handle certain features of the SAP queries.
A manually created structure in the query will look like a dimension when Cognos Transformer completes
the import from the Framework Manager package, but incomplete data is returned. A dimension added to
the SAP query as a characteristic will look like a dimension but no data is returned.

If you must use a BEx query with these limitations, consider turning off the stream extract and rely on an
MDX query. Note that if the MDX query is large, it may fail.

Error Occurs When Creating a PowerCube Containing an SAP Unbalanced
Hierarchy

You import an SAP package into Transformer that contains an unbalanced, ragged hierarchy and you
receive a TR2317 error when you create a PowerCube.

To avoid this error, before generating categories for the dimension, do the following steps.

Procedure
1. In the Dimension Map, right-click the lowest level in the ragged unbalanced hierarchy that is marked

unique.
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2. Click Properties and on the Source tab, click Move.
3. From the Run menu, click Generate Categories.
4. From the Run menu, click Create PowerCubes.

Rebuilding a PowerCube Soon After Publishing Produces a TR0787 Error
After publishing a PowerCube using the Publish wizard in Transformer, the PowerCube file is locked for a
few minutes by the IBM Cognos server.

If you attempt to rebuild the cube during this time, the cube build may fail, with Transformer error
TR0787 indicating that the cube is being used by another application.

To avoid this situation, do one of the following:

• Do not use the Publish wizard to publish the cube.
• Wait for the file lock to be released, and then rebuild the cube.
• Build the cube in a location that is different from the location where the cube is published.

Known Issues When Using PowerCubes in the IBM Cognos Studios
Using Transformer, you can publish PowerCubes and their data sources, without using Framework
Manager as an intermediary.

The following sections describe the known issues and limitations associated with using PowerCubes in
the IBM Cognos studios, such as Analysis Studio and Reporting.

Not Yet Optimized IBM Cognos PowerCubes May Open Slowly
If PowerCubes created with previous versions of Transformer take too long to open in the IBM Cognos
studios, we recommend that you run a command line utility named pcoptimizer, supplied with IBM
Cognos Analytics, to improve run-time performance.

This optimization utility is suitable for older PowerCubes when the model no longer exists or the data
used to build the PowerCube is no longer available. It is not necessary to run this command line utility for
cubes created in Transformer version 8.x. and later versions.

Procedure
1. Back up your target PowerCube, then navigate to the install_location/bin directory.
2. On Microsoft Windows, open a command line window and run PCOptimizer.exe.
3. On UNIX/Linux, enter the following line to run the optimization command line utility:

pcoptimizer [-t] [-v] [-h]
cubename

where cubename is the fully qualified PowerCube or time-based partitioned control cube name
with the .mdc extension, if the PowerCube resides in the same location as pcoptimizer. Otherwise,
cubename is the full path with the .mdc extension.

Note: This method only supports metadata extraction. To set up user-configurable drill-through, you
must use Transformer. Wildcard character support is not currently available. You must therefore invoke
the utility once per PowerCube. If cubename is not provided, the program enters an interactive mode,
prompting you for a PowerCube name and accepting keyboard input. The optional parameters are as
follows:
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• -t or test mode; it tests whether the metadata was extracted and loaded into the PowerCube. The
return code indicates the status.

– 0 if the metadata was extracted and loaded
– 10 if the metadata was not loaded
– 20 if an error occurred while accessing the PowerCube

• -v or verbose mode; text is output to standard output (stdout), indicating what was done, including
any error messages. If running in interactive mode, -v is assumed. All text is output in English only.

• -h for command-line help; if cubename is not provided, it prints the usage and options to the screen.

Analysis Studio Shows the Wrong Currency Symbol
When published to IBM Cognos Analysis Studio, PowerCubes show a default currency rather than the
currency associated with the locale of your servers and PCs. For example, GBP (£) is shown as $.

To resolve this problem, you can do one of the following:

• Create a currency table when you prepare your model in Transformer and embed a default currency
symbol into the resulting PowerCubes, based on the system locale used by your Transformer computer.

• For PowerCubes that do not contain an embedded currency table, set the fallbackCurrency
parameter as the default currency.

Creating a Currency Table in Transformer
The steps to create a currency table in Transformer is as follows.

Procedure
1. In Transformer, from the File menu, click Currency Table and click OK.
2. Right-click each currency measure and click Allow currency conversion.

This default currency table does not include currency information for any locales other than your
running locale. Also, you cannot convert to a different currency while working in Analysis Studio.

Setting fallbackCurrency as the Default Currency
The steps to set fallbackCurrency as the Default Currency is as follows.

Procedure
Define a default currency by setting the fallbackCurrency parameter in the
installation_location\configuration\qfs_config.xml file to GBP (Great Britain Pounds) or to an alternative
currency code as listed in the installation_location\bin\ccli18nrescr_xx.xml file.

Here is an example.

<!-- execution layer providers-->

<provider name="PowerCubeODP" libraryName="pcodp"
connectionCode="PC">

    ...

    <providerDetails>

        <parameters>
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           <!-- Max depth of nested calculated members
within a query. -->

           <parameter name="maxCalculatedMemberNestingDepth"
value="30"/>

           <!-- Normalize yen/won currency symbols
- set to "false" to disable -->

           <parameter name="normalizeYenWon" value="true"/>

           <!-- Fallback currency for cubes with no
default currency specified - set to USD, EUR etc. -->

           <parameter name="fallbackCurrency" value="USD"/>

        </parameters>

    </providerDetails>

</provider>

Changes to Decimals in Currency Formats
When you open a PowerCube in an IBM Cognos studio or in IBM Cognos Analytics Mobile Analysis
version 8.3, you may notice changes in the number of default decimal places shown in currency formats.

This behavior is due to the following changes:

• The default decimal formatting in currency formats is now determined by the measure format selected
in the cube, instead of from the data source currency table definition.

For example, if the Actual Revenue measure format specifies two decimal places and the USD currency
in the currency table specifies no decimal places, two decimal places will appear in the USD currency
value.

• Calculations that include a division operator and at least one currency operand will now show a
resulting value with three decimal places only when

– neither of the currency values includes decimals
– two currency operands have different numbers of decimal places

In all other calculations of this type, the number of decimals in the resulting value is determined by the
number of decimals in the currency value. The following examples illustrate this new behavior:

– $4.00 / $2.00 = $2.00
– $4 / $3.0000 = $1.3333
– $4 / $3 = $1.333
– $4.0 / $3.00 = $1.333

Ragged or Unbalanced Hierarchies Result in Unexpected Behavior
In ragged or unbalanced hierarchies, some members that are not at the lowest level of the hierarchy may
have no descendants at one or more lower levels. Support for these hierarchy gaps in relational sources is
limited.
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For OLAP sources, more complete support is provided, but some reports might result in unexpected
behavior:

• Groups corresponding to missing members may appear or disappear when grouped list reports are
pivoted to a crosstab. This happens with set expressions using the filter function, and detail filters on
members.

• Ragged and unbalanced sections of the hierarchy are suppressed when set expressions in that
hierarchy are used on an edge.

• When a crosstab is sectioned or is split into a master-detail report, sections corresponding to missing
members become empty.

Some of these behaviors might be corrected in a future release, while others might be codified as a
supported behavior. To prevent these behaviors, avoid the scenarios described in the previous paragraph.

The following scenarios are believed to be safe:

• one or more nested level references on an edge, with no modifying expression.
• a hierarchy reference on only one level of one edge.
• one or more explicit members or sets of explicit members as siblings on only one level of one edge.
• summaries of the previous three scenarios.

In all cases, reports based on ragged and unbalanced hierarchies should be tested to confirm that
hierarchy gaps are handled correctly.

Unable to Open the Great Outdoors Sales.mdl Sample Model and Generate
Cubes

If your setup information for the Great Outdoors Sales.mdl is incorrect, you will be unable to open the
sample model for Transformer, Great Outdoors Sales.mdl, or generate cubes.

To avoid this problem, set up Great Outdoors Sales.mdl using the following steps:

Procedure
1. Modify the Cs7g.ini to contain [Databases] connections.

The Cs7g.ini file is located in the install_location/cs7Gateways/bin directory.
2. Open ODBC Data Source Administrator and create a new ODBC data source named

great_outdoors_warehouse to connect to the SQL server database, GOSALESDW, which is provided
with the sample installation.

3. Connect using a valid user ID and password for SQL Server authentication.
4. Open the model.

Unable to Publish a PowerCube
If you try to publish a PowerCube and the publish action fails, check that the Microsoft Windows data
source location for the PowerCube is correct.

If the location is not specified correctly, as is the case with the English version of the sample Sales and
Marketing PowerCube, you cannot publish the PowerCube.

Procedure
1. Right-click the PowerCube and click Properties.
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2. On the Data Source tab, in the Windows location property, ensure that the data source location
specified for the PowerCube is entered correctly.

For example, the location for the English version of the sample sales_and_marketing.mdc file should
be installation_location\webcontent\samples\datasources\cubes\PowerCubes\EN

3. To publish the PowerCube, right-click the PowerCube and click Publish PowerCube as Data Source
and Package.

Note that because the sample PowerCubes have already been published, it is not recommended that
you republish them. Republishing a sample PowerCube may cause the reports that are based on the
PowerCube to fail. If you want to republish a sample PowerCube, republish it using a different name.
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Chapter 7. Problems when authoring reports
IBM Cognos Analytics - Reporting can be used to create different types of reports, including lists, crosstab
reports, charts, and user-designed reports.

You may encounter problems when authoring reports in Reporting or IBM Cognos Query Studio.

Problems Creating Reports
Planned, professional reports are created in IBM Cognos Analytics - Reporting, and ad hoc reports are
created in IBM Cognos Query Studio.

The topics in this section document problems you may encounter when creating reports.

Chart Labels Overwrite One Another
In IBM Cognos Analytics - Reporting and Query Studio, if you define a chart and render it in HTML or PDF
format using the default sizes, the axis labels of the chart may overwrite each other.

To avoid this problem, make the chart wider or taller by modifying the height and width properties of the
chart or enable the Allow skip property.

Chart Shows Only Every Second Label
You create a report that includes a chart. The Allow skip property is set to false, but when you run the
report, labels are skipped.

This can occur if there is not enough room for all labels and the properties Allow 45° rotation, Allow 90°
rotation, and Allow stagger are also set to false. IBM Cognos Analytics has no options for making the
labels fit, so it skips every second label.

The solution is to select either Allow 45° rotation, Allow 90° rotation, or Allow stagger.

Division by Zero Operation Appears Differently in Lists and Crosstabs
If you have a list that accesses a relational data source, a calculation containing a division by zero
operation appears as a null value, such as an empty cell. In a crosstab, the division by zero operation
appears as /0.

This happens when the query property Avoid division by zero is set to Yes, which is the default.

To have a consistent display of null values in lists and crosstabs, define an if-then-else statement in the
expression in the crosstab cell that changes the value /0 to the value null.

Application error appears when upgrading a report
When upgrading a report, the following error appears if the report contains data items in the page layout
that are not in a data container:
RSV-SRV-0040 An application error has occurred. Please contact your Administrator.

This error occurs when IBM Cognos Analytics cannot determine the query reference for a data item. Such
data items are identified by a red circle with a white x icon.

To correct the error, drag the data items into a container. If the container is a list, we recommend that
you drag the data items into the list page header or footer, or the overall header or footer. If you want to
see the first row of the item on each page or in the overall report, drag the item to the list page header or



overall header. If you want to see the item's last row on each page or in the overall report, drag the item to
the list page footer or overall footer.

Tip: If a header or footer does not exist, create it.

Nested List Report Containing a Data Item That is Grouped More Than Once
Does Not Run After Upgrade

When you upgrade a nested list report that contains a data item that is grouped in both lists, the report
does not run.

The following error occurs when the report is run against a dimensional data source and both lists are
using the same query. This error does not occur if the report is run against a relational data source.

OP-ERR-0199: The query is not supported. The dimensions on the edge are inconsistent. The dataItems
from dimension="[Product line]" must be adjacent.

For example, you have a list that contains the grouped items Product line and Product type and a nested
list that contains the data items Year, Quarter, Product line, and Unit sale price. Year, Quarter, and Product
line are grouped items in the nested list.

To resolve the issue, delete the data item that is grouped in both lists from the inner list.

Procedure
1. Click anywhere in the report.
2. Click the Show properties icon , and In the Properties pane, click the Select ancestor icon and click

the List link that represents the inner list.
3. Double-click the Grouping & sorting property.
4. In the Groups pane, select the data item that you want and press the Delete key.

Background Color in Template Does not Appear
When creating a Query Studio template in IBM Cognos Analytics - Reporting, if you add a list object and
change its background color, the color change does not appear when you apply the template to a Query
Studio report.

To work around this issue, do one of the following:

• Edit the style sheet (CSS) classes for lists in Cognos Analytics - Reporting.
• Do not add any objects to the page body when you are creating a Query Studio template.
• Leave the page body blank.

Subtotals in Grouped Lists
When using an IBM Cognos PowerCube that contains a ragged hierarchy, if you group on the first level in
the hierarchy, subtotals may appear in the wrong place or show wrong values.

To resolve the issue, group on the second level.

Metadata Change in Oracle Essbase Not Reflected in Reports and in the
Studios

When there is a metadata change on the Oracle Essbase server, the change is not immediately reflected
in the metadata tree in the studios. In addition, when a report is run, the report does not pick up the
republished changes.

To view the new structure, you must restart the IBM Cognos Content Manager server.
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Relationships Not Maintained in a Report With Overlapping Set Levels
In a report, the relationship between nested or parallel member sets at overlapping levels in the same
dimension may not always be maintained.

For example, a named set in the data source that contains members from both a Year and Month member
is nested under Year, but is not properly grouped by year.

In another example, an error message such as this appears:

OP-ERR-0201 Values cannot be computed correctly in the presence of multiple hierarchies ([Product].[B1],
[Product].[Product]) that each have a level based on the same attribute (Product).

This problem occurs in the following scenarios involving non-measure data items X and Y, which overlap
in the same dimension:

• X and Y together as ungrouped report details
• Y nested under X
• Y appended as an attribute of a group based on X

When using named sets, or sets that cover more than one level of a hierarchy, do not use sets from the
same dimension in more than one place in the same report. They should appear on only one level of one
edge.

Creating Sections on Reports That Access SAP BW Data Sources
SAP BW data sources may have problems with sections in reports under different circumstances:

If a section in a report uses the lowest-level query item in a ragged hierarchy, such as the children of the
not assigned node, the following BAPI error may appear:

BAPI error occurred in function module BAPI_MDDATASET_SELECT_DATA. Value <valueName> for
characteristic <cubeName> unknown

For more information about working with ragged or unbalanced hierarchies, see the IBM Cognos Analytics
- Reporting User Guide.

Lowest-level Query Item in a Ragged Hierarchy
The solution is to remove the section from the lowest-level query item.

Several Multicubes with SAP Variables
The solution is to use one SAP multicube when creating sections in reports.

Error Characters (--) Appear in Reports
When you run a report, you see two dash (--) characters in your report instead of values.

These characters may appear if you use an OLAP data sources other than PowerCube and Microsoft SQL
Server 2005 Analysis Services (SSAS), and you apply aggregation to calculations and measures that use
rollups other than Sum (Total), Maximum, Minimum, First, Last, and Count.

All other types of rollup either fail or return error cells, which typically display as two dash characters (--).
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This problem occurs in, but is not limited to, the following:

• footers
• aggregate function
• summary filters and detail filters that use a summary
• detail, summary, and context filters that select more than one member of a hierarchy that is used

elsewhere on the report

If you are working with a SSAS 2005 data source, these characters may also appear in summary cells if
you use an OR filter in the summary. To avoid this problem, do not use OR filters in summaries.

Function Unreliable with Sets
If you create an expression that uses the descendants function with sets, you may encounter
unpredictable results. Some expected members may be missing or may have blank captions or labels.

This problem occurs if the descendants function uses a set as its first parameter instead of a single
member and if the descendants function is nested under another data item from the same hierarchy.

To avoid this problem, replace the first parameter in the descendants function with the function
currentmember(H), where H is the hierarchy of the desired set and under which the expression is
nested. For example, use descendants(currentmember(H).

Columns, Rows, or Data Disappear With SSAS 2005 Cubes
Microsoft SQL Server 2005 Analysis Services (SSAS) has a feature called AutoExists that removes tuples
that have no facts at the intersection of two hierarchies of the same dimension.

Columns, rows, or data can disappear if you set the default member of a hierarchy to a member that does
not exist with every other member in the dimension. To avoid this problem, change the default member
that caused the disappearance to a member that exists with all other members in the dimension.

Columns, rows, or data can also disappear if members are specified that result in one or more non-
existent tuples. There is currently no workaround for this scenario. For more information, see Microsoft
Knowledge Base article #944527 at http://support.microsoft.com.

You may also encounter unexpected results if the default member of a hierarchy is a member that doesn't
also exist in all other hierarchies in the dimension, and if you query members from different hierarchies in
the same dimension.

For example a crosstab includes the following (using the Adventure Works cube):

• Rows: Generate([Adventure_Works].[Account].[Accounts],set([Balance Sheet],[Units])) nested with

children([Adventure_Works].[Department].[Departments]->:[YK].[[Department]].[Departments]].&[1]]])
• Column: [Adventure_Works].[Account].[Account Number].[Account Number]
• Measure: [Adventure_Works].[Measures].[Amount]

You run the report and notice that the query renders with some blanks cells. You then apply the simple
detail filter [Amount]>1 and run the report. Only row labels are displayed and all data and columns are
missing.

In the Adventure Works cube, the [Account].[Accounts] attribute has a default member set to [Net
Income]. When evaluating the GENERATE set expression, SSAS looks in the entire cube space and
looks at all coordinates for the [Account] dimension. These coordinates include both [Account][Account
Type].&[] and [Account].[Accounts].[Net Income]. Because these two coordinates don't exist within the
same hierarchy, SSAS returns an empty set.

To avoid this problem the SSAS administrator must set the default member in the cube to a member that
exists in all other hierarchies.
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Unexpected Cell Formatting in Reports
When using data sources other than OLAP and you run a report, cell formatting may not appear as
expected. For example, some cells may appear very small. This could be caused by null values returned
from the query.

To specify what appears for a data container when there are null values in a query, refer to the IBM
Cognos Analytics - Reporting User Guide.

You may also see an Invalid Dates message in some cells. This issue is specific to Transformer and
occurs when cubes are constructed with unknown date values. For more information, see the IBM Cognos
Transformer User Guide.

Report Differences Between TM1 Executive Viewer and IBM Cognos
Analytics with TM1 Data Sources

When using an IBM Cognos TM1® data source, comparable reports created in IBM Cognos Analytics
and in TM1 Executive Viewer may contain different cell values. This occurs because the TM1 Executive
Viewer product uses an algorithm for selecting default members for non-projected dimensions that differs
slightly from traditional OLAP clients.

To avoid this problem, when filtering your reports in IBM Cognos Analytics, use context filters that match
the default selections shown in the Executive Viewer user interface. This ensures that the cell values in
IBM Cognos Analytics match the values in Executive Viewer.

Order of Metadata Tree Differs for TM1 Data Sources
When using a an IBM Cognos TM1 data source, the order of members in the metadata tree of the Source
tab in IBM Cognos Analytics may differ from the order shown in TM1 Architect.

By default, TM1 Architect renders members of hierarchies using a slightly different algorithm than does
IBM Cognos Analytics. IBM Cognos Analytics automatically renders member metadata from TM1 data
sources in hierarchical order.

From within TM1 Architect, if you want to see how IBM Cognos Analytics will render a hierarchy, click the
Hierarchy Sort button.

MSR-PD-0012 error when importing external data
When you try to import an external data file, you receive an MSR-PD-0012 error.

MSR-PD-0012: Unable to upload the specified external data file. It exceeds the permitted file size of
"0(KB)", as specified by your system administrator.

This error occurs when the size of the file you are trying to import is greater than the value specified for
the Maximum external data file size (KB) governor in the Framework Manager model.

To resolve the issue, the modeler must update the governor, save the model, and republish the package.

MSR-PD-0013 error when importing external data
When you try to import an external data file, you receive an MSR-PD-0013 error.

MSR-PD-0013: Unable to upload the specified external data file. It exceeds the permitted maximum
number of rows "0", as specified by your system administrator.
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This error occurs when the number of lines in the file you are trying to import is greater than the value
specified for the Maximum external data row count governor in the Framework Manager model.

To resolve the issue, the modeler must update the governor, save the model, and republish the package.

Problems Calculating Data
The topics in this section document problems you may encounter when using expressions to calculate
data or when aggregating data in your reports.

Summaries in Query Calculations Include Nulls with SAP BW Data Sources
When using an SAP BW data source in IBM Cognos Analytics - Reporting, null values in the database
are returned in the result set and the count summary function includes the empty cells in the following
scenarios:

• A query calculation includes an arithmetic calculation where one or more NULL operands and an
aggregation is performed on the calculation.

• The result of a query calculation is a constant, such as current_time and current_date.

The count summary function should normally exclude null values.

To avoid this problem, for the first scenario, ensure that both operands do not return null values. For
example, the original expression is [num1]+[num2]. Instead, use the following expression:

if ([num1] is null) then ( 0 ) else ([num1])

if ([num2] is null) then ( 0 ) else ([num2])

There is no workaround for the second scenario.

Null Results for Calculations Using SAP BW Data Sources
When using a SAP BW data source, the expression you use in your calculation is evaluated as a null value
if your expression contains a null item. For example, in the calculation some_expression = result, the
result is null if a row or column that the expression references includes a null value.

To avoid obtaining null values as the result of your calculations, suppress null values before you create the
calculation.

Unexpected Summary Values in Nested Sets
If a report contains nested sets, summaries other than the inner set summaries may contain unexpected
values. For example, you insert a summary in a crosstab that contains a set with years in the rows.

Figure 1. Example of revenue numbers for the years 2012 and 2013
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You then nest a product line set within years.

Figure 2. Example of revenue numbers for the listed products for the years 2012 and 2013

Notice that the summary value does not change to represent the total of the new values. This occurs
because the within set aggregation used with dimensional packages does not take into account sets that
are nested below the set that is summarized.

To show the correct summary values, if the inner and outer sets do not belong to the same dimension, you
can nest a copy of the inner summary item under the outer summary item, as follows.

Figure 3. Example of the combined aggregate set for the years 2012 and 2013

Incorrect Results in Summaries When Using OLAP Data Sources
When using an OLAP data source, summaries that use for clauses give incorrect results.

This occurs because for clauses require access to the detail rows of the fact table. OLAP data sources do
not have detail rows.

For example, this report uses a dimensionally-modeled relational (DMR) data source and contains the
following summaries:

• mx: maximum ([Revenue] for [Year (ship date)])
• mx2: maximum (Aggregate([Revenue]) for [Year (ship date)])
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Figure 4. Example list report that uses a dimensionally-modeled relational data source and revenue for
four years

Notice that the mx and mx2 values are different, where mx2 is based on visible data, but mx is not. This
result is correct.

The following report uses an OLAP data source and contains the same summaries.
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Figure 5. Example list report that uses a dimensional data source and revenue for four years

In the example report, mx and mx2 values are now the same. Both summaries are based on visible data.
The mx value is incorrect.

Incorrect results also appear for footer summaries.

To avoid this problem, when using OLAP data sources, ensure that the parameter that precedes the for
clause is an aggregate function.

Incorrect Results with IBM Cognos PowerCubes and Time Measures
If a report uses an IBM Cognos PowerCube data source and a combination of data items, you will
encounter incorrect results.

The following combination of data items in a report that uses an IBM Cognos PowerCube data source will
give incorrect results.

• a measure with a Time State Rollup set to Average or Weighted Average
• an aggregate ( members from time dimension ) expression
• an intersection with a member in a relative time hierarchy

To avoid incorrect results, do not use this combination in your reports.
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CQM and DQM return different default results for aggregate rules
If you set the Aggregation Rule for a measure to Last for a time dimension, the default results in
Compatible Query Mode (CQM) are different than those in Dynamic Query Mode (DQM).

In DQM, if you focus the report on a member whose last measure is in a time period earlier than the last
time period actually found in the time dimension, rather than show the value for that earlier time period,
the record is dropped altogether.

For example, if a member from a Scenario dimension called Actual has a value last recorded in Oct of
2021 and you report on the Year level of 2021, the measure value for Oct should appear under 2021 for
Actual. Instead, however, the record is dropped since the last period in the data is Dec. 2021, which is
what is used in the filter in the SQL. CQM does not drop this record by default.

Solution
To ensure that DQM returns the same default results as CQM, follow these steps:

1. Go to installation_location\configuration\xqe.
2. Open the file dmr.properties in a text editor.
3. Change the line contextDependentIgnoreNullsAggregateRule=false to
contextDependentIgnoreNullsAggregateRule=true.

4. Change the line enableDMRcubeReuse=true to enableDMRcubeReuse=false.

Note: If you are setting your query properties in Reporting to not use the local cache, then the
enableDMRcubeReuse setting does not need to be changed because the report's query property will
override the dmr.properties setting.

5. Save your changes to dmr.properties.
6. Restart the Query Service.

Unexplained Discrepancies in Number Calculations
You might find unexplained discrepancies in number calculations due to round-off errors.

For example:

• You run regression tests and find differences in numbers. They are different only because of the
rounding off of decimal places.

• You choose not display zeros in reports, but the zeros are displayed anyway because there are decimal
places (0.00000000000000426, for example) that are rounded off to zero in reports.

Round-off problems are not specific to IBM Cognos software. They can occur in any environment where
rounding off occurs.

Binary Round-Off Errors
Discrepancies in calculations might occur due to binary round-off errors. For example, if the number 1.1 is
represented as a binary floating point number and your report format includes a large number of decimal
places, the number 1.1 might actually be something like 1.09999999999997.

If your report is formatted to use only one decimal point, decimal round-off takes place, compensating for
the binary round-off. So the number appears to be 1.1 when it is really 1.09999999999997. When the
number is used in calculations, you might get round-off errors. For example, Microsoft Excel calculations
use binary numbers (without rounding off decimal places) but formatting in reports shows rounded off
decimal places, which can create small discrepancies.
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Division Round-Off Errors
Calculations that involve division typically incur round-off errors, regardless of how the numbers are
represented. Examples of such calculations are Average and Percent of Base.

Design Guidelines to Minimize Round-Off Effect
The best solution is to change the underlying database schema or cube model but that may not always
be possible. Another solution is to minimize the round-off effect by following these guidelines when
authoring reports and creating models in IBM Cognos Framework Manager and external OLAP cubes:

• Avoid storing data in floating point format whenever possible. This is especially true for currency values,
which should be stored as either fixed-point decimals or as integers with a scale value such as 2.

For example, in a cube, the Revenue for Camping Equipment in 2012 is $20,471,328.88. If revenue
details are stored as floating point numbers, round-off errors might occur when revenue is calculated.

The round up errors might have slight differences, depending on the order of calculation. If revenue
for Products is calculated first and revenue for Time is calculated second, you might get a different
round-off error than if Time is calculated first and Products is calculated second.

Total revenue might be calculated as the number shown in the previous example. Or there might be
slight discrepancies, for example, $20,471,328.8800001 as opposed to $20,471,328.88. The internal
number might be slightly different than what is displayed. The number might even be for different runs
of the same report, depending on the order that the OLAP engine uses for calculation.

• In reports, avoid division whenever possible. When division is unavoidable, try to do it as
late as possible in the calculation process. For example, instead of Total([Revenue]/1000), use
Total([Revenue])/1000.

• When doing comparisons, add a margin to allow for round-off. For example, you may want [Profit %] to
be a fractional value formatted as a percentage with no decimals. However, the filter [Profit %]<>0 (or
[Profit %] NOT BETWEEN 0 and 0) rejects zero values and may still return values that appear to be 0%
after formatting.

To avoid this, filter in one of these two ways:

– [Profit %] NOT BETWEEN -0.005 and 0.005
– ([Profit %] <- 0.005) OR ([Profit %]> 0.005)

Note that 0.005 is equivalent to 0.5%, which displays as either 0% or 1%, depending on floating point
precision losses.

In some cases, you may prefer control round-off errors by rounding values explicitly. For example,
instead of [Profit %], use round([Profit %],2).

• Recalculate numbers every time instead of reusing calculations that might contain rounded off
decimals.

There might be additional considerations for Microsoft Analysis Services 2005/2008, especially when
comparing report results from different runs (as happens in Lifecycle Manager). Refer to Microsoft
documentation for more information.

Error when filtering on a _make_timestamp column
You cannot filter on a _make_timestamp column. If you do that, the following error messages appear:

UDA-SQL-0114 The cursor supplied to the operation "sqlOpenResult" is inactive 

UDA-SQL-0206 The OLEDB driver returned the following value:
HRESULT= DB_E_CANTCONVERTVALUE 

RSV-SRV-0025 Unable to execute this request

The solution is to apply the filter after aggregation, and not before.
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RSV-VAL-0010 Failed to load the report specification
This error message occurs in Cognos Analytics Reporting when validating a report during the compatible
(CQM) to dynamic query mode (DQM) migration, or when developing a new report. The report is based on
an OLAP data source.

Here is the full text of the message:

RSV-VAL-0010 Failed to load the report specification. XQE-PLN-0043 The query is
not supported. The value summary function 'total' in the data item 'DataItem1'
is based on detail values and the function does not match the pre-aggregated
values in the OLAP data source.

The error message informs you that the summary cannot produce the same result as it would against an
equivalent relational data source that has access to the transactional-level fact details. Consequently, the
summary result can be incorrect.

The following, similar error message might occur in CQM for the same report:

OP-ERR-0273 The value summary function is specified for a scope that extends
below the level of detail of the report.

While the report might run in CQM, DQM enforces a much stricter set of design rules.

Resolving the problem
For OLAP data sources, summaries are computed accurately only if the summary function is aggregate.
To resolve the problem, replace the total() function with the aggregate() function.

For example, the following expression:

member( total([Measure Set]), 'test','test', hierarchy([Data Set] ))

should be modified in the following way:

member( aggregate([Measure Set]), 'test','test', hierarchy([Data Set] ))

Problems Distributing Reports
The topics in this section document problems you may encounter when distributing reports.

A Report Link in an Email Notification Does Not Work
If a report link in an email notification does not work, the Gateway URI may not be configured correctly.

You must change the host name portion of the Gateway URI from localhost to either the IP address of the
computer or the computer name. If the URL in the email contains localhost, remote users cannot open the
report.

Report Contains No Data
In IBM Cognos Event Studio, if an agent running against a dimensionally-modeled data source passes
values to a report based upon a relational source, the report may contain no data.

When the source is dimensional, the agent passes member unique names (MUNs) to the target report. If
the target report is based upon the same dimensional source, the report runs correctly. However, if the
report is based upon a relational source, the agent must pass values (not MUNs) for the report to run
correctly.

Procedure
1. Drag the data item from the Insertable Objects tree to the Value field in the report task page.
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2. Click in the field.
3. From the Insert menu, click Caption.

Hyperlinks in Email Messages Are Stripped Out When the Agent is Saved
In Event Studio, hyperlinks are stripped out when the agent is saved. The administrator must allow email
links to ensure that the links remain in emails created by agents.

Procedure
1. To allow links in an email, do the following:

• Add the following line to templates/ps/system.xml: <param name="allow-email-links">true</
param>

• Restart the server.

Note: Adding this setting does not fix existing agents.
2. To insert a link in an email, do the following:

• Highlight some text in the email.
• Press Ctrl-K.
• Enter a URL into the box that appears.

Errors When Running Web Service Tasks
When running a Web service task, you might encounter errors.

You must modify one the following files to add the ThreadStackSize (Xss) parameter:

• bootstrap_win32.xml in the bin folder for a 32-bit installation
• bootstrap_win64.xml in the bin64 folder for a 64-bit installation

Adding this parameter prevents these errors:

CNC-ASV-0001 The Following Agent Service General Error Occurred: java.lang.StackOverflowError

CNC-ASV-0007 An error occurred with the agent Web service task.

Procedure
1. Open the appropriate version of the install_location\bin\bootstrap_win.xml file in an XML editor.
2. Add the following text for the parameter (shown in bold) exactly as shown here:

...
<condValue="Sun">-XX:NewSize=${dispatcherMaxMemoryBy4}m</param>
        <param condName="${java_vendor}" condValue="Sun">-XX
        <process name="catalina"> ...<param condName="${java_vendor}" 
            condValue="Sun">-XX:MaxPermSize=512m</param><
            param condName="${java_vendor}"
            condValue="IBM">-Xss512m</param>

The maximum stack size (Xss) parameter is set to 512 MB to avoid an overflow exception error.

Cannot Call the SDK from Event Studio
Even though IBM Cognos Event Studio has a feature to insert a web service as a task, it is not possible
to call the IBM Cognos SDK web service. Due to the complexity of the SDK and complex data types and
options, the web service feature in Event Studio does not handle the IBM Cognos SDK.

The exception to this rule is the trigger command that can be called from Event Studio.
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Chapter 8. Problems when running, viewing, and
printing reports

You may encounter problems when running, viewing, or printing reports.

Problems Running Reports and Analyses
The topics in this section document problems you may encounter when running reports.

Summaries in a report do not correspond to the visible members
If a crosstab or chart created in IBM Cognos Analytics - Reporting using a dimensional data source has a
context-dependent set function such as filter or topCount on an edge, summaries do not correspond
to the visible members.

This problem occurs because a summary that has the query property Use set aggregation set to Yes,
which produces an expression that contains the within set clause, uses a set that is dependent on the
members that it intersects with on the opposite edge. For example, the following crosstab has the top
three products returned as columns. The expression used to generate the columns is

topCount ([Product],3,[Return quantity])

where [Product] is the level.

Figure 6. A crosstab showing that the summary values for all rows do not correspond to the visible
members.

The summary values for Total and Minimum for all rows except Central Europe do not correspond to
the member values in the crosstab. This means that the top three products returned in all regions except
for Central Europe are not Bug Shield Lotion, Bug Shield Extreme, and Sun Shelter 30. Note that the
summary values for Total and Minimum for all columns do correspond to the visible member values. That
is because those summary values represent the total and minimum quantities returned for those three
products in each region.

You can see what the top three products returned in each region are by dragging the columns to the right
of the rows.



Figure 7. A single-edge crosstab showing the Total Returned Products and Minimum Returned Products for
each region

To obtain summary values that reflect the visible members, modify the expression of the data item
containing the context-dependent set function so that it includes a tuple that is locked to the default
member of every hierarchy that appears on the opposite edge. For this example, modify the expression to
the following:

topCount ([Product],3,tuple([Return quantity], defaultMember([Retailer site])))

where [Product] is the level and [Retailer site] is the hierarchy.

When you run the report, all summary values reflect the visible members in the crosstab.

Figure 8. A crosstab showing the return quantity of products in different regions of the world
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Unexpected Results for Analysis Studio Reports Using Suppression and
Nested Rows

In IBM Cognos Viewer, you run an IBM Cognos Analysis Studio report for which page breaks have been
set. Detail items appear only on the page that contains the item for which suppression is applied, and only
summary items appear on all other pages.

This may occur because of the following combined conditions:

• The report contains nested levels.
• Suppression is applied to an item nested inside the outermost group.
• In the report options, the page breaks setting is applied to the outermost groups on rows.

To avoid this result, in Analysis Studio you can do one of the following:

• In the report options, clear the page breaks setting.
• Move the outermost group to the context filter area before applying suppression.
• Remove all suppression.

You can also run the report as is. To prevent this message from appearing, from the Run menu, click
Report Options. On the Display tab, clear the checkbox under Warning page.

If you do not have access to Analysis Studio, contact your administrator.

Defining Languages for OLAP Data Sources
The first time you publish a cube definition, you must identify all the languages that represent the data
contained in the cube. If you add a language to the model after the cube is published, users with locales
that match the added language locale may find that Analysis Studio does not recognize references to the
member unique names. There is no impact on users whose locale matches the original language list.

Crosstab Shows Percentage But Chart Shows Values
When the crosstab calculates the percentage of the total for an item, the chart does not show the values
as a percentage.

Cannot Drill when Caption Represents a Blank or a Zero-length String
A dimensional model over relational data may return a zero length or blank caption in the row or column
in Analysis Studio. When it does, you cannot drill up or down from the set because no link appears.

If this occurs, you can right-click the caption and select Drill Up or Drill Down in the shortcut menu.

DPR-ERR-2082 The Complete Error Has Been Logged by CAF With
SecureErrorID

You cannot run a report.

The following error messages appear:

DPR-ERR-2082 An error has occurred. Please contact your administrator. The complete error has been
logged by CAF with SecureErrorID: timestamp-#number.

RSV-DR-0002 Unable to execute this request.

These error messages do not indicate an IBM Cognos Application Firewall problem.
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You can view a more detailed error message, in the c8server.log file that resides in the logs directory on
the IBM Cognos Analytics server.

Procedure
1. Open the cogaudit.log file in the install_location\uninstall\logs directory on the IBM

Cognos Analytics server.
2. Search for SecureError or the timestamp-error number combination shown in the error message, such

as 2004-06-29-15:15:03.796-#8.
3. The error message is under the SecureErrorID heading.

Query Studio Does Not Generate a SELECT DISTINCT statement if a Column
is Aliased Without Using the Actual Column Name

When filtering on a column name, the query does not generate a SELECT DISTINCT statement if the
referenced column is aliased by manually typing the alias in the SQL of the query subject.

To avoid this situation, do not manually type the alias. Instead, in IBM Cognos Framework Manager,
rename the column by right-clicking on it and selecting the Rename option.

QE-DEF-0288 Cannot Find the Database in the Content Store
You cannot retrieve data from the selected database when running a report.

The following error message appears:

QE-DEF-0288 Unable to find the database...

If this error does not occur when you are logged on as an administrator, then to solve the problem, ensure
that the user has permissions to the signon embedded. If this error always occurs, the data source has
not been created. Create the data source with the name mentioned in the error message.

Overflow Error Occurs When a Value in a Crosstab Is More Than 19
Characters

In a crosstab report, values support a maximum of 19 characters, including the decimal point. If a value
exceeds 19 digits, an overflow error occurs. By default, the decimal precision is set to 7 digits, which
restricts the number of integers to 11 digits.

To use more than 11 integers, you must edit the qfs_config.xml file in the install_location\configuration
directory.

IBM Cognos Analytics Runs Out of TEMP Space
By default, IBM Cognos Analytics stores temporary files in the install_location/temp directory. The
amount of space required by the temporary files directory depends upon several factors, including the
number and type of reports created.

The following error message indicates that the temporary files directory ran out of space:

QE-DEF-0177 An error occurred while performing operation 'sqlOpenResult'.

UDA-SQL-0114 The cursor supplied to the operation "sqlOpenResult" is inactive.

UDA-TBL-0004 There was a Write error while processing a temporary file.
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If this error occurs, ensure that the disk on which the temporary files directory is located has adequate
space. You should also periodically delete unwanted files from this directory.

A Report Does Not Run as Expected
A report may not run as expected if the model contains errors or the wrong governor settings.

Procedure
1. Open the model in Framework Manager.
2. Ensure governors are set to disallow.
3. In the diagram view, ensure that there are no cross-join errors or ambiguous joins.
4. Check the package for a missing query subject.
5. Run the Verify Model function, and correct any errors detected.

Performance Issues when Showing Multiple Attributes Using Dimensionally-
modeled Relational Data Sources

If you display multiple attributes for the items in a set on the crosstab, you can only select one attribute at
a time, so Analysis Studio executes a query for each attribute selection.

The performance of this approach is an expensive one to execute against a relational data source because
of the query necessary to retrieve the attribute and its value.

You can select multiple attributes for a selected crosstab set in Analysis Studio by using the Properties
pane. By selecting multiple attributes before clicking OK or Apply in the dialog box, only a single
query for all selected attributes is executed, instead of one per attribute. Multiple selection in the UI
is the preferred approach for enabling the display of more than one attribute for dimensionally modeled
relational data source packages, because of the reduced performance impact on the relational data
source.

Scheduled Reports Fail
You schedule reports that previously ran successfully, but now fail.

The following error message appears when the reports fail:
CAM.AAA Error authenticating user

This may happen because a user changed a password. IBM Cognos Analytics uses a copy of the user ID
and password to run the scheduled report.

The solution is for the user to renew their credentials.

Procedure
From My Preferences, renew your credentials.

This option is not available to users from an IBM Cognos Series 7 namespace.

The Table or View Was Not Found in the Dictionary
When you run a report, the following error message appears:

The table or view "xxx" was not found in the dictionary.

This may occur if permissions were not properly set.

Ensure that the user defined in the data source has SELECT privileges for the affected table.
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Mixed Languages Are Displayed When Using Samples
When you select a PowerCube, a mixture of languages is displayed.

When you restore the Cognos_samples.zip file in the webcontent/samples/content folder it contains
multilingual content. When you change the locale setting on your computer, reports appear in the
language specified for your computer. This is not true for sample IBM Cognos PowerCubes. When you
restore Cognos_PowerCube.zip, a different folder is set up for each language. If you select a PowerCube
from a language folder that is different than the language specified by the locale setting on your computer,
a mixture of languages is displayed.

There are two options for solving this problem:

• Re-install Cognos_PowerCube.zip. First ensure that your computer is set to the locale that is consistent
with the language of the PowerCube package you are installing. Then, install only the package from the
language folder that matches the locale setting.

• Open each PowerCube package, click the Set Properties button, and in the Language box, select the
language of the IBM Cognos PowerCube.

Unable to Select Multiple Report Formats When Running a Report
When running a report with options, you cannot select multiple formats when the delivery option is to
view the report.

Before selecting multiple formats on the Run with advanced options page, you must first change the
Delivery option to Save the report, print it, or send an e-mail.

A Report or Analysis Does Not Run Because of Missing Items
You attempt to run a report or analysis and a message indicates that one or more items are missing or
changed. Each missing item is listed by its MUN (member unique name). The MUN includes the complete
path within the hierarchy for the item. When you place your cursor on an item in the Source tab, the MUN
for that item is displayed in a tooltip. This situation may occur if members have been removed from or
changed in the data source. It may also occur when you attempt to run a report that uses items to which
you do not have access. For example, an administrator may create an analysis that includes items that
you do not have the correct permission to access.

The solution is to find a suitable replacement in the Source tab, and drag it to the work area. The report or
analysis will then run.

Cannot View Burst Report
When you burst a report, each burst output is sent to the associated list of recipients.

If a list of recipients contains invalid entries, the following occurs:

• The burst output is not saved to IBM Cognos Content Manager.

Consequently, you cannot view the burst output.
• If you choose to send the output by email, only valid recipients will receive an email. Although the

output is sent as an attachment if you select the Attach the report check box, no link is generated if you
select the Include a link to the report check box.

• The following error message appears in the run history for the report, where parameter 1 is the burst
key, parameter 2 is the list of recipients, and parameter 3 contains the error messages returned by
Content Manager:

An error occurred while saving the output for the burst instance <param type="string" index="1"/>
with the recipients (<param type="string" index="2"/>). Here are the details: <param type="string"
index="3"/>

Note: The list of recipients includes both the valid and invalid recipients.
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For example, a report is set up to burst on Country or Region, and the recipients are managers. Running
the report produces the following countries and regions and recipients:

• Canada: John, Mary
• US: Peter, Frank
• France: Danielle, Maryse

Frank is an invalid recipient. The burst outputs for Canada and France are saved to Content Manager, but
not the U.S. output. If you choose to send an e-mail to each recipient and you selected the Include a link
to the report check box, the e-mail to Peter will not contain a link to the output for US. The error message
that is generated will contain Peter and Frank as values for parameter 2 with no indication as to which is
invalid.

Procedure
1. View the error message in the run history for the report.
2. From the list of recipients, determine which recipients are invalid.

You may need to consult with your administrator to find out which recipients are invalid.
3. Correct or remove the invalid recipients.

Correcting or removing invalid recipients will depend on how the list of recipients was defined, such as
through a calculated field or a burst table.

4. Run the report again.

Recursive evaluation error
You run a report and encounter the following error.

PCA-ERR-0057 Recursive evaluation has exceeded limit. Calculated member trace:
COG_OQP_USR_Aggregate(Retailer Type): COG_OQP_INT_m2: COG_OQP_INT_m1:
COG_OQP_USR_Aggregate(Retailer Type): COG_OQP_INT_m2: COG_OQP_INT_m1:
COG_OQP_USR_Aggregate(Retailer Type): COG_OQP_INT_m2: COG_OQP_INT_m1:
COG_OQP_USR_Aggregate(Retailer Type): COG_OQP_INT_m2: COG_OQP_INT_m1

You may encounter this error when two or more data items form a recursive evaluation. For example,
in this error, the calculation of Aggregate(Retailer Type) is dependent on a column expression while at
the same time the column expression is dependent on Aggregate(Retailer Type). Therefore, the cyclic
relationship cannot be resolved.

To avoid this problem, ensure that calculations do not have cyclic relationships.

Arithmetic Overflow Error When Running a Report in PDF Format
If you use a Microsoft SQL Server 2005 data source and your report includes aggregations, you may
encounter the following error when you run your report in PDF format:

RQP-DEF-0177 An error occurred while performing operation 'sqlOpenResult' status='-28'. UDA-SQL-0114
The cursor supplied to the operation "sqlOpenResult" is inactive. UDA-SQL-0564 [Microsoft OLE DB Provider
for SQL Server] Arithmetic overflow error converting expression to data type int. (SQLSTATE=22003,
SQLERRORCODE=8115)

This error occurs because the action is performed in the database, and the database data type is too
small.

To avoid this problem, increase the size of the the database data type.
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RQP-DEF-0177 An error occurred while performing operation
'sqlPrepareWithOptions' status='-69' UDA-SQL-0043 Error

You cannot run a report in IBM Cognos Analytics - Reporting or IBM Cognos Query Studio, and the
following error messages appear.

RQP-DEF-0177 An error occurred while performing operation 'sqlPrepareWithOptions' status='-69' UDA-
SQL-0043 The underlying database detected an error during processing the SQL request.[NCR][ODBC
Teradata Driver][Teradata Database] Partial string matching requires character operands

These error messages do not indicate an IBM Cognos Application Firewall problem.

There is a problem with your data source not converting numeric data items. Ask your administrator
to consult the topic Enable Conversion of Numeric Search Keys to Strings in Queries in the IBM Cognos
Analytics Administration and Security Guide.

PCA-ERR-0087 error when you run a large report
You run a large report and you receive a PCA-ERR-0087 error that indicates that the report exceeds the
maximum number of tuples allowed.

PCA-ERR-0087 The "crossJoinSet" operator is not applicable. The limit on the number of tuples per edge
has been exceeded (<value>).

This error appears when there is an item in a query that has no relationship to the rest of the data or does
not make sense in the query.

To resolve the problem, review the query for unrelated items. If an item is found, redesign the query or
apply a filter on the item to reduce the number of results returned.

If you still receive the error, ask your administrator to modify the maximum number of tuples setting in
IBM Cognos Analytics. The setting is an XML attribute named maxTuplesPerEdge. For more information,
see the IBM Cognos Analytics Administration and Security Guide.

Differences in the appearance of charts that are run in different formats or
on different operating systems

IBM Cognos Analytics - Reporting charts can appear differently when reports are run in different formats
or on different operating systems. For example, donut and pie charts can appear smaller in reports that
are run on the Linux on System z® operating system compared to the Windows operating system.

The differences in appearance occur only with Cognos Analytics - Reporting default charts. Cognos
Analytics - Reporting legacy charts are not affected. When default charts are rendered in HTML or PDF,
the following font-related problems might occur.

• The font that is used in HTML output is different than the font used in PDF output.
• Some chart items appear misaligned. For example, a pie chart might show smaller pies in PDF output

than in HTML output.
• The font that is used in the chart is different from the expected font.
• The font that is used in the chart is different when you run the chart in different operating systems.

There are two possible causes to the font-related problems.

• The Java Runtime Environment (JRE) used by IBM Cognos Analytics did not find the font that is
specified in the chart, and substituted the font with a different font.

• An unknown default font is specified.

To resolve the problem, ask your administrator to configure JRE to find the installed fonts on the Cognos
Analytics server. There are two ways that you can configure JRE to find the installed fonts:

• Copy the installed fonts to the jre/lib/fonts folder.
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For example, to use the Cognos Analytics default font Andale WT, copy Andalewt.ttf from the
install_location/bin/fonts folder to jre/lib/fonts.

• Configure the JRE font search path to point to the location where the fonts are installed.

On AIX, set the shell environment variable JAVA_FONTS=<list of directories>

Tip: Setting this variable is equivalent to setting the properties java.awt.fonts and
sun.java2d.fontpath.

The default fonts configuration in your Cognos Analytics server default style sheet can also cause font-
related problems, particularly when the operating system is UNIX. On UNIX systems, fonts must be
purchased and installed. To ensure that a specific font is used, perform one of the following tasks:

• Ask your administrator to update the Cognos Analytics server default style sheet to reflect the fonts that
are installed on the server.

• Update the chart fonts that are used in your report to use that font, and do not rely on any default fonts.

Out-of-memory errors with reports that are run in interactive HTML format
Out-of-memory errors occur when you run a report in interactive HTML format. The errors do not occur
when you run the report in other formats, such as PDF or saved HTML.

Out-of-memory errors occur in reports that contain many objects that require memory intensive
processing, such as crosstabs and charts that are linked together with master-detail relationships.
Running reports in interactive HTML can consume more memory than running reports in other formats.
When a report is run in interactive HTML, data sets are kept in memory for all pages in the report. For
report formats like PDF, data sets are released from memory after the report is rendered.

Under certain conditions, you can exceed the memory limitations of a 32-bit configuration of the
Cognos Analytics server report server component when you interact with an interactive HTML report.
For example, scrolling through a report page by page or drilling up or drilling down can consume more
memory and processing capacity in interactive HTML than in other output formats.

Problems with viewing saved Active Report output in Mozilla Firefox 8 or
later versions

When you try to view saved Active Report output in Mozilla Firefox 8 or later, you receive errors.
The problem also occurs when you try to insert a saved active report in a workspace in IBM Cognos
Workspace.

No problems occur when you use an earlier version of Firefox. In Firefox 8 and above, you see the
following errors:

Error: ReferenceError: HTMLIsIndexElement is not defined

Error: TypeError: _IS1 is undefined

The problem occurs because HTMLISIndexElement was deprecated as of Firefox 8. To resolve the
problem, rerun the active report and create a new saved output version.

Tip: If you must rerun many active reports, you can create a job to run multiple reports.

Problems with large SAP BW queries
When you are working with an SAP BW data source, if your report includes a data set greater than
1,000,000 cells, you might encounter an XQE error.

XQE-CON-0007 XQE error encountered: XSB-ERR-0022 Execution of MDX
failed: XSB-ERR-0038 SAP Error executing BAPI BAPI_MDDATASET_SELECT_DATA:
com.cognos.xqe.data.providers.olap.sbwodp.bapi.JBapiSAPException: RFC Error: MDX result contains too
many cells (more than 1 million).
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To avoid this error, set the Processing property for the query to Limited Local. This option allows the
report to process locally.

Master Detail or Burst Reports with Charts or Crosstabs May Result in Denial
of Service

When running a master detail or burst report that includes a chart or crosstab, disk space exhaustion may
cause the report or other requests to fail. A large set of burst keys or master rows may produce one or
more charts per detail, resulting in many master detail executions. This may cause the temp folder to
accumulate many gigabytes of temporary files containing data required for successful chart rendering.

To avoid this issue, we recommend that you test large master detail or burst reports that include charts or
crosstabs to determine the potential peak disk requirements for the report.

Error when filtering on a _make_timestamp column
You cannot filter on a _make_timestamp column. If you do that, the following error messages appear:

UDA-SQL-0114 The cursor supplied to the operation "sqlOpenResult" is inactive 

UDA-SQL-0206 The OLEDB driver returned the following value:
HRESULT= DB_E_CANTCONVERTVALUE 

RSV-SRV-0025 Unable to execute this request

The solution is to apply the filter after aggregation, and not before.

Result set of a multi-fact query contains blanks
The result set of a multi-fact query contains blanks in some columns, even though there is a conformed
dimension that should join the records from both fact tables.

When IBM Cognos Analytics processes a multi-fact query, it breaks it up into two single fact queries
(each with items from a single star in the star schema), then stitches the results of both of those queries
together to create a single result set. You can see the two queries and stitching in the native SQL
generated for the multi-fact query in Reporting.

Stitching these queries together is not the same as joining tables in the model. Stitching the two sides
together requires a stitch key that exists in each single fact query as a unique value for the row. The rows
from the two single fact queries are then matched 1:0, based on the stitch key values. The stitching must
be 1:0. Otherwise, you can get double counting of measure data, or exclude rows that should be included.
The stitching also means that it is possible for a row from one of the single fact queries to not have a
corresponding row from the other single fact query, leading to blanks in the result set.

When the fact tables contain non-conformed dimensions between them, there is not a suitable stitch key
among the query items selected. As a result, IBM Cognos Analytics creates one using RSUM, and joins
the results of the two queries. For more information, see the topic Multiple-fact, Multiple-grain Query on
Non-Conformed Dimensions in the Framework Manager User Guide.

When there is a conformed dimension, it is still possible to not have a suitable stitch key, depending on
what items are used in the query and other model design factors. In such cases, IBM Cognos Analytics
uses the conformed dimensions and the row numbers from the results of each query to create a stitch
key. If one single fact query returns more rows than the other, there are blanks in the result.

To resolve the problem, it might be possible to avoid splitting the query by changing the model. For more
information, see Resolving Queries That Should Not Have Been Split in the Framework Manager User
Guide. If you cannot avoid splitting the query and the report needs these two result sets to be joined
differently, create two separate, single-fact queries in Reporting, create a join between them, and define
the join links and cardinality as needed.
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Single-select prompt is generated where multi-select prompt might be
expected

A single-select prompt control is generated for an IN-filter when you run a report, view tabular data in a
report, or set prompt values in report properties. Typically, a multi-select prompt control is expected in
these report contexts when the IN-filter is used.

This issue applies to the dynamic query mode (DQM) only. In the compatible query mode (CQM), a
multi-select prompt control is generated in this situation.

The generation of prompts depends on the queryPlanning parameter. The prompt controls within the
same report, but in different contexts (running a report, viewing tabular data in a report, or setting prompt
values in report properties), are generated in the following way:

1. A dataItem with expression <expression>?productName?</expression> generates a single-
select prompt control.

2. A filter with expression <filterExpression>[Products] in (?productName?)</
filterExpression> generates a multi-select prompt control.

3. A dataItem must be referenced (projected) in the report page to be processed by queryPlanning.
4. Viewing tabular data on a specific query generates a temporary query that projects all dataItems, and

therefore all dataItems are processed by queryPlanning. (Viewing tabular data is not like running a
report.)

5. When query "a" is referenced from another query, all dataItems in query 'a' are processed by
queryPlanning.

6. When queryPlanning processes a parameter that is used in two different contexts (see items 1 and 2 in
this list), a single-select prompt control is displayed in the user interface.

7. When you run a report, queryPlanning receives an execute request that points to a specific query in
the report, which means that queryPlanning collects no knowledge from other queries in the report.
Therefore, the same parameter that is used in a different context (see item 1 and 2 in this list) and in
different queries might produce either a single-select prompt control or a multi-select prompt control.
It all depends on the order in which the queries are processed by queryPlanning, which is driven by the
report layout.

8. When you set the prompt values from the report properties in the Content page, queryPlanning
receives a getParameter request, which means that it processes all queries in the report to collect all
parameter information. Therefore, the same parameter that is used in different contexts (see items 1
and 2 in this list) and in different queries generates a single-select prompt control.

Scenario 1
The report includes one query with the following expressions:

• dataItem = <expression>?productName?</expression>
• filter = expression <filterExpression>[Products] in (?productName?)</
filterExpression>

The dataItem is referenced in the report page, and the filter is required.

The following prompt controls are generated in this scenario:

• A single-select prompt control is displayed when you run the report (see item 6 in the list above).
• A single-select prompt control is displayed when you set prompt values in report properties (see item 6

in the list).

Scenario 2
This scenario is similar to scenario 1, except that the dataItem is not projected in the report page, but
included in the query.
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The following prompt controls are generated in this scenario:

• A multi-select prompt control is displayed when you run the report (see item 2 in the list).
• A multi-select prompt control is displayed when you set prompt values in report properties (see item 2

in the list).
• A single-select prompt control is displayed when you view tabular data in the report (see item 4 in the

list).

Scenario 3
The report includes two queries (two list frames - first list refers to Query 1, second list refers to Query 2).

Query 1
dataItem = <expression>[Products]</expression>
filter = expression <filterExpression>[Products] in (?productName?)</
filterExpression>

Query 2
dataItem = <expression>?productName?</expression>

The following prompt controls are generated in this scenario:

• A multi-select prompt control is displayed when you run the report because Query 1 is processed first
(see item 6 in the list).

• A single-select prompt control is displayed when you set prompt values in report properties because all
queries are processed (see item 6 in the list).

Scenario 4
This scenario is similar to scenario 3, but the first list frame points to Query 2, and the second list frame
points to Query 1.

The following prompt controls are generated in this scenario:

• A single-select prompt control is displayed when you run the report because Query 2 is processed first.
• A single-select prompt control is displayed when you set prompt values in report properties because all

queries are processed (see item 6 in the list).

XQE-V5-0005 Identifier not found '_row_id' error
You run a report and get error message "XQE-V5-0005 Identifier not found '_row_id'. CAF-WRN-2082 An
error has occurred. Please contact your administrator.".

If the report is using data module that contains data from an uploaded file, make sure that both the data
module and the file are stored in Team content. Data that is stored in My content can be accessed by only
the user who uploaded it.

Scheduled reports fail after password update: CM-REQ-4159 CM-CAM-4005
Unable to authenticate

When you log in to IBM Cognos Analytics and then change your password, previously scheduled reports
may fail, while other non-scheduled reports run successfully during the current session.

The following message appears:

CM-REQ-4159 Content Manager returned an error in the response header. The error
"cmAuthenticateFailed CM-CAM-4005 Unable to authenticate. Check your security
directory server connection and confirm the credentials entered at login" can
be found in the response SOAP header. CM-REQ-4342 An error has occurred with
the client.
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This issue occurs because, for performance reasons, trusted credentials are automatically renewed only
once every 24 hours. If you changed your password during the 24-hour period after your credentials were
automatically renewed during a Cognos Analytics session, the trusted credentials associated with your
scheduled reports are no longer valid and the reports fail.

For more information, see Trusted credentials.

Resolving the problem
To ensure that your scheduled reports run without errors, renew your trusted credentials manually. Follow
these steps:

1. Click the Personal menu icon , then click Profile and settings.
2. On the Profile tab, under Advanced options, for Credentials, click Renew.

Problems viewing iFrame content
The topics in this section document problems you may encounter when viewing content in iFrames.

Error when opening an asset
When you try to open a Cognos Analytics asset, such as a report, an error message appears. Here are
examples of the messages that appear in different browsers:

• Firefox error message:

The custom sign-in view could not be found

or

The custom sign-in view is not available. The default sign-in view is
displayed instead.

• Chrome and Edge error message:

Invalid login response

Cause
Some browsers block cross site cookies by default. This prevents Cognos Analytics assets from being
launched in an iFrame if they are hosted in a different domain than the report server.

Note: This issue is not specific to a Cognos Analytics release. It occurs in certain browser versions whose
security settings may change over time.

Solution
To resolve this issue, follow these steps:

1. Edit your browser settings to allow cross site cookies. For more information, see your browser
documentation.

2. If the issue persists, the administrator should configure the SameSite attribute on cookies.

Note: Alternatively, you can avoid the error messages above by ensuring that HTML files containing
iFrames are hosted in the same domain as the report server.

Performance Problems When Running Reports
The topics in this section document performance problems you may encounter when running reports.
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CGI Timeout Error While Transferring Data to IBM Cognos Analytics
Components

When performing operations through your Web browser, you receive an error message.

The following error message appears when you use Microsoft Windows Internet Information Services
(IIS) as your Web server and the gateway is configured to use CGI. IIS has a default timeout for CGI
applications.

CGI Timeout, process will be deleted from server.

To resolve this problem, you can configure the gateway to use ISAPI. IIS does not have a default timeout
for ISAPI applications. Or, if you want to keep using a CGI gateway, you can increase the CGI timeout in
IIS.

Procedure
1. To change the gateway to ISAP, do the following:

• On the gateway computer, start IBM Cognos Configuration.
• Under Environment, for the Gateway URI property, change the cognos.cgi portion of the URI to

cognosisapi.dll.
• In your Web browser, specify the ISAPI URI:

http://computer_name/ibmcognos/isapi
2. To inclrease the CGI timeout, do the following:

• In the Microsoft Windows administrative tools, open Internet Information Services.
• Under the local computer node, right-click Websites and select Properties.
• In the Home Directory tab, click Configuration.
• In the Process Options tab, increase the CGI script timeout.

The BAP-ERR-0002 BAPI Error
When using IBM Cognos Analytics with an SAP BW data source, the following error message may appear:

BAP-ERR-0002 BAPI error occurred in function module BAPI_MDDATASET_CHECK_SYNTAX. Error occurred
when starting the parser.

This error usually occurs because the SAP BW server is overloaded.

To resolve this problem, restart the IBM Cognos Analytics server or close all open connections from the
SAP BW Administrator Workbench.

The Out of Memory Error Appears in HP-UX
In HP-UX, the default setting for the threads per process is too low for most Java applications.

To avoid out of memory errors, increase the value for the following kernel parameters:

• max_thread_proc
• nkthread.

Note: The nkthread parameter should be double the value of the max_thread_proc parameter.

For more information, see the HP Web site.

A Query Is Slow When Filtering Non-ASCII Text
When using an SAP BW data source, and range filters are defined on non-ASCII text values, such as
city names that contain accented characters, the query may take longer to run. This occurs because the
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filter must be performed on the application server and not on the SAP BW server because SAP BW 3.0B
supports queries only if they use ASCII values.

To avoid this problem, do not filter non-ASCII values.

Report Output Takes a Long Time to Run
You click Run with Options and select the Save the report delivery option. This action returns all data,
renders the report, and stores it in the content store, which can take a long time.

It is quicker to run the report manually, using the Run command, which generates the report a page at a
time.

Report runs slowly
The following is a list of questions that will help you to troubleshoot a slow report.

• Does your IBM Cognos environment conform with the supported environments?
• Has the report always been slow or did it recently become slow?

If it recently became slow, can you identify an event that occurred just before the report began to run
slowly? Events could include changes to configuration settings, changes to tuning settings, a recent
upgrade where your previous settings have not been applied, an introduction of firewalls or proxies,
changes to existing firewalls or proxies, changes to virus scans on temp directories, or temporary table
space restrictions on the database. This event could have caused the change in report performance.

• Is the performance slow for all reports or just one report?

If all reports are slow, the issue may be due to your environment or database. If all reports from a
specific package are slow, the issue may due to the model design. If just one report is slow, the issue
may be due to a specific report element.

• How many queries does your report contain?

The number of queries on the report will proportionally affect the report execution time.
• Does the report run slowly for everyone, or just for one user?

If the report runs slowly for just one user, the issue may be due to something in that user's environment,
such as virus scanning, page file size or location settings, or their location on the network.

• Is the report burst or run often by many people?

If many people are running the same report at the same time, you may need to scale your environment
or consider using dispatcher routing rules to direct all requests for a specific package or group of users
to a specific server or server group. For more information, see the IBM Cognos Analytics Administration
and Security Guide.

• Do your queries require local processing?

The following report elements require local processing: crosstabs and charts, master relationships,
unions or joins, multiple fact queries, bursting, and non-vendor specific functions. Local processing
requires the IBM Cognos server to compute operations on the result set returned by the database,
which can impact the SQL execution time.

• Does your environment use a Custom Authentication Provider?

Using a Custom Authentication Provider could cause a memory leak if the code is not destroying objects
correctly.

• Have you reviewed the logs in the install_location\uninstall\logs directory and the audit
logs?

They may help you identify the source of the problem. Monitoring your processes, such as the Java and
the bus processes could also identify excessive memory use.

• Is your environment tuned correctly?
• Have you recently upgraded?
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Ensure that any tuning settings that were applied to your previous installation are applied to the new
environment. Ensure that your models have been verified, upgraded, and republished. Verify that the
IBM Cognos Framework Manager governor that allows enhanced model portability at runtime is not
enabled. Depending on your upgrade method, you may also need to open and save the reports again
after upgrading.

Problems Viewing Reports
The topics in this section document problems you may encounter when viewing reports.

An upgraded report does not retain its original look
When you upgrade a report to IBM Cognos Analytics, a new style sheet is applied that changes the look of
the report.

To preserve the formatting that was used in the original report, you can select a different style sheet. This
retains the original look of the report and specifies that any new items added to the report, such as list
columns or crosstab levels, have the original formatting applied to them.

Procedure
1. Open the report in IBM Cognos Analytics - Reporting.

2. Click the Pages icon  or the Queries icon , and then click the Report icon .
3. Click the Show properties icon , and in the Properties pane, click the Report styles property and

select one of the available values.

For example, to use the IBM Cognos ReportNet style sheet, select 1.x styles.

Preventing font changes that cause text wrapping in PDF report outputs
In an upgraded IBM Cognos Analytics environment, if you work with reports created in older versions, you
might find that some query data in PDF reports now wraps onto a second line. You can set the advanced
property RSVP.RENDER.PDF_FONT_SWITCHING to restore the font-choosing behaviour of earlier versions
of IBM Cognos Analytics.

About this task
IBM Cognos Analytics software uses preferred fonts. The preferred font is any font listed in a report
specification, followed by the fonts listed in the global styles cascading stylesheet (css) file. If the first
font cannot be used, the software uses the next font in the list. In previous versions of IBM Cognos
Analytics, a font was used only if all characters in a string could be displayed using that font. Starting
with IBM Cognos Analytics 10.1, the preferred font is applied at the character level. When a character
is not available in the preferred font, it is displayed in the next font specified. As a result, one word can
be displayed using different fonts, or some fonts might be bigger, which can cause word wrapping. If you
have this problem, configure IBM Cognos software to choose fonts using the rules from previous versions
of the product. You can do this by setting the RSVP.RENDER.PDF_FONT_SWITCHING advanced setting to
false for the report and batch report services.

Procedure
1. In IBM Cognos Administration, on the Configuration tab, click Dispatchers and Services.
2. Click the dispatcher.
3. For the BatchReportService, in the Action column, click the Set properties icon.
4. Click the Settings tab.
5. For Advanced settings, click Edit.
6. Click Override the settings acquired from the parent.
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7. Type the parameter RSVP.RENDER.PDF_FONT_SWITCHING
8. In the Value column type False
9. Click OK.

10. Repeat steps 3 to 9 for the ReportService.

Measure Format Disappears in SSAS 2005
Microsoft SQL Server 2005 Analysis Services (SSAS) does not propagate formatting through calculations.
IBM Cognos compensates for this whenever possible, but cannot guarantee to do so in all cases. As a
result, if you are working with a Microsoft SSAS cube, any calculation (other than a non-count summary)
that is based on or intersects with a formatted measure, such as a currency, may lose the measure
format. This may also happen if you use a detail filter or context filter (slicer).

For example, a crosstab includes members on one edge and a measure with formatting, such as a
currency symbol and decimal places, applied on the other edge. When you run the report, you see the
formatting for each cell. However, if you add a detail filter, such as measure > 1 and run the report, all the
formatting disappears.

Additionally, the fine details of the MDX generated by IBM Cognos Analytics can change from release to
release. As the SSAS behavior depends on the MDX generated, the loss of formatting in reports might not
occur in a future release.

To avoid this problem, specify explicit formatting for the affected row, column, or cell.

A Running Total in Grouped Reports Gives Unexpected Results
You have a running total calculation in a grouped report that returns unexpected values.

Because tabulation of the running total calculation depends on the order in which the grouping is
executed, you must ensure that the grouped totals are tabulated before applying the running total.

To ensure that the grouping is executed in correct order, define a running total calculation as a
freestanding calculation outside the query subject in IBM Cognos Framework Manager, and ensure that
the Regular Aggregate property is set to Automatic.

This may also be an issue with other running, moving, and ranking aggregations.

The Page Cannot Be Found Error Appears for Reports
When a report is distributed by email, no error message appears if the report output from the email link
is not available. This can occur when the output is deleted or when the user does not have permissions to
the report. Instead, the error The Page Cannot Be Found appears.

You are unable to view the report output from the email link when Allow Anonymous Access is set to
True and when the Anonymous user does not have access to the report output.

When you run a secured report from an email link and when Allow Anonymous Access is set to True, a
passport is automatically issued to the Anonymous user. The Anonymous user is not prompted to log on
and is unable to view the report output.

Non-English Characters Appear as Placeholders
IBM Cognos Analytics and Framework Manager are Unicode applications. A Unicode application permits
handling of content in any language, or any combination of languages. However, if your database contains
non-English characters, and if the database client is not configured to receive these characters, some
characters may appear as placeholder characters, such as boxes or inverted question marks.
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To avoid this problem, ensure that your database clients are properly configured. For more information,
see your database vendor documentation.

For Oracle 9, you can force the use of Unicode on the client by ensuring that the system environment
variable NLS_LANG is set to "xxx.UTF8", where xxx is whatever is needed for other applications on that
computer. If there are none, the value can be simply .UTF8.

While enforcing the use of Unicode on the database client guarantees that it can handle multilingual data,
some characters in some character sets may still appear incorrectly, such as Japanese Shift-JIS.

Cannot Connect to a SQL Server Database Using an ODBC Driver
The connection works in IBM Cognos Framework Manager, and metadata can be imported. When testing
the database connection in the portal, errors occur.

When the following errors occur, the solution is to change the Network Library Configuration for SQL
Server to use TCP/IP instead of Named Pipes.
QE-DEF-0285 Logon failure
QE-DEF-0325 The cause of the logon failure is:
QE-DEF-0068 Unable to connect to at least one database during a multi-database 
attach to 1 database(s) in: testDataSourceConnection
UDA-SQL-0031 Unable to access the "testDataSourceConnection" database
UDA-SQL-0129 Invalid login information was detected by the underlying database
[Microsoft][ODBC SQL Server Driver] [SQL Server] Login failed for user '(null)'.
Reason Not associated with a trusted SQL

Procedure
1. Open ODBC Data Source Administrator.

Tip: In Microsoft Windows 2000 you can do this by clicking Start, Settings, Control Panel,
Administrative Tools, Data Sources (ODBC).

2. Select the data source name defined for SQL Server on the System or User DSN tab.
3. Click Configure.
4. On the Microsoft SQL Server DSN Configuration page, click Next.
5. Click Client Configuration.
6. Ensure that TCP/IP is selected for the Network library entry.

Unable to Click Links
Links will not work if your browser is not properly configured. Consequently, you cannot perform
operations such as running a report or starting Reporting.

For all Web browsers, cookies and JavaScript must be enabled. For more information, see your browser
help.

For Microsoft Internet Explorer Web browser only, the following must be enabled:

• Run ActiveX controls and plug-ins

• Script ActiveX controls marked safe for scripting

• Active scripting

IBM Cognos software does not provide or download ActiveX controls as part of IBM Cognos Analytics.
IBM Cognos Analytics - Reporting uses the native Internet Explorer XML support, which is an integral
component of the browser. Because Microsoft implements XML using ActiveX, you must enable ActiveX
support for Reporting.
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Procedure
1. In Internet Explorer, from the Tools menu, click Internet Options.
2. On the Security tab, click Custom Level.
3. In the Security Settings dialog box, scroll to the Activex controls and plug-ins settings and enable

Run Activex controls and plug-ins and Script Activex controls marked safe for scripting.
4. Scroll to the Scripting settings and enable Active scripting.
5. Click OK.

Missing Images in a PDF Report
Images that appear in reports rendered as HTML are missing in reports rendered as PDF.

The embedded GIF, JPG, and BMP images do not appear. Only the borders of the missing images appear.

If you use Microsoft Internet Information Services (IIS), go to the properties sheet of the Web site and
ensure that the Enable the HTTP Keep Alives option is selected.

Ensure that the virtual directory where the images are stored has anonymous access enabled. Open IIS
and open the properties sheet for the virtual directory for your images. Select the Anonymous Access
check box.

If you do not want to open up anonymous access to all users, ensure that the account that is running the
dispatcher has access to the virtual directory where the images are stored.

Problems Printing Reports
The topics in this section document problems you may encounter when printing reports.

A Printed HTML Report is Unsatisfactory
Printing HTML may produce unsatisfactory results.

For best results, run the report in PDF format, and then print it from the PDF viewer menu bar. This
alternative gives you more control over such things as pagination than the browser does.

Understanding Drill-Through Results
The topics in this section document unexpected results that you may encounter when using drill-through.

Filters Are Not Correct When Users Drill Through to Upgraded Targets in
Analysis Studio

If the target of a drill-through definition is an IBM Cognos Analysis Studio report with a drill-through filter
(defined by setting a context filter as a Go To parameter), and the application has been upgraded from
IBM Cognos Analytics, version 8.3, to IBM Cognos Analytics, version 10.1, filters may not be correctly
passed from the source to the target. Instead, the Analysis Studio report appears as it did in its last saved
state without any filtering occurring from the source report, or users may be prompted to select a context.

This is true for authored drill-through definitions (created in an IBM Cognos Analytics - Reporting report)
and package drill-through definitions that use parameterized drill through.

This problem occurs because of changes in how parameters are automatically named in Analysis Studio.
To correct the problem, recreate the mapping in the drill-through definition, and save the definition.
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Drill-through Links are Not Active in the Safari Browser
When viewing a PDF report in the Macintosh Safari browser, you cannot open hyperlinks. This is because
the Macintosh Safari browser does not have the necessary Adobe Acrobat plug-in.

To avoid this problem, use the HTML format when creating drill-through reports that may be viewed in
Safari.

Unexpected or Empty Results When Drilling Through
When you drill from a source report to a target report, there might be no data returned. This might be
the correct result if there is no data that corresponds to the drill-through selections or if you do not have
permission to view the data.

In other cases, if no data or the wrong data appears, the source item might not be mapped to the target
correctly or the values in the data sources might not be conformed (the values do not match in both data
sources).

If you have the necessary permissions, you can debug drill-through definitions by using the drill-through
assistant from the Go To page (right-click the selection in the source report and select Go To). You can
view the passed source values and the mapping to the target report parameters. You can use this tool for
both authored and package drill-through definitions.

You might be able to correct the problem by modifying the parameter mapping in the drill-through
definition. For example, when you drill from a cube to a relational data source, sometimes no data is
returned or the wrong data is returned because the business key values in the two data sources do not
match. You can change the drill-through definition to pass the caption of the IBM Cognos PowerCube
member instead of the business key, but you must also change the target report to filter on the
corresponding string value and not the business key value.

However, it is best to ensure the data sources are conformed. In this example, the business keys in the
cube should match the business keys in the relational source. Filtering on a key is more efficient than
filtering on a larger string that may or may not be indexed in the database.

For more information on data source conformance, search for "conformed dimensions" and "business
keys" in the IBM Cognos Transformer User Guide and the IBM Cognos Analytics - Reporting User Guide.

Procedure
1. Ensure that the target report filters on a string value that matches the caption being passed from the

PowerCube.
2. Edit the drill-through definition as follows:

• If the drill-through definition was created in IBM Cognos Analytics - Reporting, open the report, and
go to the drill-through definition associated with the drill-through source object. On the parameter
mapping page, select Member caption in the Property to pass column.

• If the drill-through definition was created in the source package, in the IBM Cognos Analytics

portal, click the New icon , Other, Drill-Through Definitions. Open the package drill-through
definition. On the Target tab of the drill-through definition, select Member caption in the Property to
pass column for the appropriate parameter.

Results
When you drill through, instead of the business key, the caption is passed to the target.
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Cannot Drill Through From a Relational Source to a Cube
By default, you cannot drill through from a relational data source to a cube. This is because a cube
expects a Member Unique Name (MUN) as a parameter value and relational sources do not use MUNs.

Members have properties which include a business key and a caption. If either of these match data
items within the relational source, drilling through can be performed as long as the cube target report is
authored in Reporting.

If the source data source has a query item, for example display name, that corresponds to a member
property in the target cube, for example caption, you must create the parameter on the caption in the
target report.

To pass the data item to the cube target, do the following:

• In the cube target report, create a parameter that accepts the caption of the member. This parameter

should be created in a Query calculation object from the Toolbox icon  with the following syntax.
Type the following

filter([ Hierarchy or Level],caption([Hierarchy of Level]) = ?Parameter?)

For example:

filter([sales_and_marketing].[Products].[Products].[Product line],
caption([sales_and_marketing].[Products].[Products].[Product line]) 
= ?Product Line?)

Cannot Drill Through Between PowerCubes Because MUNs Do Not Match
We recommend that business keys be unique throughout the dimension for PowerCubes. These keys are
used as the source value for levels in a hierarchy of a dimension. If the values are not unique throughout
the dimension, the corresponding Category Code values may be generated with tildes.

For example, if a category for the Product Line level has a source value of 101 and a category in the
Product Type level has a source value of 101, the Category Code value for the Product Type level is
automatically generated with a unique value such as 101~245. The Category Code values are used
in the Member Unique Name (MUN) for each member, for example, [Sales and Marketing].[Products].
[Products].[Product type]->:[PC].[@MEMBER].[101~245].

Because these values are generated automatically, they cannot be guaranteed from one cube build to
the next or in a build for another cube with the same dimension structure using the same source values.
Therefore, drilling from one PowerCube to another on what appears to be the same member might not
work since the MUNs might not match.

If the MUNs do not match, consult the cube modellers to see if the business keys can be made unique
throughout the dimension. If this is not likely, or might take some time to resolve, you can use calculations
to pass the source value from one PowerCube to another for drill-through.

Procedure
1. In the target report, create a filter with the following syntax:
filter([Hierarchy or Level], roleValue('_businessKey', [Hierarchy or Level])
= ?Parameter?)

For example:

Chapter 8. Problems when running, viewing, and printing reports  103



filter([Sales Cube].[Products].[Products].[Product type],
roleValue('_businessKey',[Sales Cube].[Products].[Products].[Product type])
= ?Prod Type?)

2. In the source report, create a Query Calculation which is used to pass the business key (source value)
to the target report by mapping it to the target parameter in the drill-through definition. Use the
following syntax:

roleValue('_businessKey', [Hierarchy or Level])

For example:

roleValue('_businessKey', [sales_and_marketing].[Products].[Products].
[Product type])

Drilling Through to IBM Cognos Analytics from an IBM Cognos Series 7
Product Results in a Firewall Error

You use an IBM Cognos Series 7 product that is configured to use a proxy server.

When you drill through to IBM Cognos Analytics, the following error message appears:

DPR-ERR-2079 Firewall Security Rejection. Your request was rejected by the security firewall. Please try
again or contact your administrator.

This is because the IBM Cognos Analytics Web server does not recognize the proxy server name and
rejects the entry.

To correct this problem, add the proxy server name in IBM Cognos Configuration.

Procedure
1. Start IBM Cognos Configuration.
2. In the Explorer window, click Security, and then click IBM Cognos Application Firewall.
3. In the Valid domains or hosts box, add the proxy server name.
4. From the File menu, click Save.
5. From the Action menu, click Start.

Detail Cells are Not Displayed for Excluded Items When Drilling Through to
PowerPlay Studio

In IBM Cognos PowerPlay® Studio, you can use the Hide/Show feature to hide items in a report. If you drill
through to a PowerPlay Studio target report to an item that is hidden in the source report, the target has
no detail cells for the hidden item.

For example, the year 2005 is hidden on the row edge in a PowerPlay Studio target report. You drill-
through to the target report on 2005 in a PowerPlay Studio, Analysis Studio, or Reporting source report.
The target report shows no detail cells for 2005 they are hidden.

However, if the Show Summaries option is selected for the hidden categories in the target report, then the
summary row will display the total values for 2005.

To correct this problem, do not exclude items in the source report if you want to see the details cells in the
target report.

Drill-Through Parameter is Ignored in PowerPlay Studio Due to a Custom Set
When a target PowerPlay Studio report contains a custom subset, you may not see the results you
expect when you drill through from a source report in Analysis Studio, PowerPlay Studio, or Reporting.
For example, the target PowerPlay Studio report contains a custom subset for the year 2006. If you
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drill through from the source report in Analysis Studio, PowerPlay Studio, or Reporting, the year 2006 is
displayed. But, since the custom subset does not include the year 2004, the drill-through parameter for
2004 is ignored and items for 2004 are not displayed.

To avoid this problem, ensure that the target report has custom subsets that include the items you want
to display during drill-through from source reports.

Drill-Through Definition is Not Available
When a drill-through definition is created there is an option to specify the scope for the drill-through
definition. The specified item can be a query subject, query item, measure, dimension, or level. The
item must be present and selected in the source report when drilling through to a target report for the
drill-through definition to work. It must also be available in the list of drill-through target links on the
Go To page.If the scope item is not included in the source report when it is created in Analysis Studio,
Reporting, or PowerPlay Studio, the drill-through target link does not appear on the Go To page.

Calculations Do Not Appear in the Target Report
If you drill through to PowerPlay Studio from a report in Reporting, Analysis Studio, or PowerPlay Studio,
calculations on the edges in the target report might not appear.

For example, you have a target report with the calculation Personal Accessories+100 as a column in a
crosstab report. When you drill through from a source report to the target report, if Personal Accessories
is filtered out of the target report (Personal Accessories is not one of the items that is returned on the
column edge), then the Personal Accessories+100 calculation does not appear. Personal Accessories has
been filtered out of the target report and is not available to fulfill the calculation.

To see the calculations in the target report, ensure the items used in the calculations are returned in the
result set (not filtered out).

Target Report Does Not Filter Properly Without "Go-To" Parameters
In Analysis Studio, you can multi-select two or more items from a dimension and add them to the Context
Filter area to create a list of items (a set of members from one dimension) that the analysis is filtered
on. For example, Telephone, Web, Sales Visit and Special are multi-selected from Order method type and
dropped onto the Context Filter area of an Analysis Studio target report.

If a drill-through definition is created for this target report, when you drill through from a source
Reporting, PowerPlay Studio, or Analysis Studio report, all context filter items are returned even though
they are not part of the intersection selected for drill-through. This is because Analysis Studio does not
dynamically filter from source reports.

Enable Go To parameters on the context filter in order to drill through and filter the reports as expected.
In the drop down menu for the Context Filter, select Use as "Go To" Parameter. For any items that you
wish to filter on in an Analysis Studio target report drill-through, a context filter must be created and set
as a Go To parameter.

Empty Cells Returned in a Target Report with Excluded Items
In IBM Cognos Analytics, to filter an Analysis Studio target report on a drill through, context filters must
be created and set as Go To parameters. Each context filter must contain all the items from the dimension
that you wish to filter on, for example, a context filter might contain the years 2004, 2005, 2006, 2007.
For example, an Analysis Studio target report has context filter for years, but excludes the year 2005 on
the row edge. If you drill through to this target report on 2005 from a PowerPlay Studio, Reporting, or
Analysis Studio report, the report displays empty cells.

This is an accurate result since the target report has filtered out the years displayed in the report layout
(for example, 2004, 2006, 2007). The report has been filtered on the excluded item, 2005. However, the
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summary total row shows values for 2005 since it provides the overall total for included and excluded
items of the report.

Nested Crosstab Only Filters on Some Items
If you perform a parameter-based drill-through from a source report to an IBM Cognos Analytics -
Reporting target report with two or more dimensions nested on a row or column, you may encounter
unexpected results depending on the filters applied to the target report.

For example, a target Cognos Analytics - Reporting report has the following two filters:

• [sales_and_marketing_mdc].[Order method].[Order method].[Order method type]=?Order Method
Type?

• [sales_and_marketing_mdc].[Retailers].[Retailers].[Region]=?Region?

Order method type and Region both have filters, but Product line does not. A drill-through definition
mapped to the appropriate parameters, in this case Order method type and Region, is created.

When the source report is run and the intersection of Outdoor protection, Northern Europe, and
Telephone is selected to drill through to the target report, the order method type and region display
as expected, but all product lines are returned. This is because there are filters on Order method type and
Region but not Product line.

Data Does Not Appear in a Target Report or the Wrong Data Appears
If no data appears when you drill through to a target report or if the wrong data appears, the problem
might be data source conformance. The business keys might be different or might be mismatched.

For example, the business key for Camping Equipment might be 100 in the data source for the source
report and 1 in the data source for the target report, in which case no data appears in the target report.
Another example might be that the business key for Camping Equipment is 100 in the data source for the
source report but, in the data source for the target report, 100 is the business key for Golf Equipment, in
which case the wrong data appears in the target report.

To solve the problem, ensure that business keys have the same value in both data sources. If there are
cases where data does not appear to match, contact your database administrator or data modeler.

For more information about data source conformance, search for "conformed dimensions" and "business
keys" in the IBM Cognos Transformer User Guide and the Reporting User Guide.

You might also want to see “Unexpected or Empty Results When Drilling Through” on page 102.

Data is Not Filtered in the Target Report After Drill-Through
You drill through to a target report, but no filtering occurs in the target report. For example, you drill
through on a crosstab intersection of Camping Equipment and 2010 and expect to see only data for
Camping Equipment for 2010 in the target report. Instead you see all products for all years. This occurs
because the target report has no filters for the parameters that were passed.

To solve the problem, ensure that the target report has the correct filters. In the previous example,
the correct filters in the target report are Product line and Year. Alternatively, you can enable Dynamic
Drill-Through in a package-based drill-through definition.

Error when drilling through from source report in PDF
The "request not valid" error occurs when you drill through from a source report in the PDF format.

The error reads:
DPR-ERR-2101 Your request was invalid. Please contact your administrator.
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When you drill through from a source report in PDF, then drill-though only works if the session is active. If
the browser is closed or if the passport timeout expired, then the following message DPR-ERR-2101 Your
request was invalid. Please contact your administrator is displayed.

The PDF drill-through metadata has a lifetime that matches the passport. This lifetime allows for a
downloaded PDF to still allow drill-through. Because the PDF itself has a lifetime of 15 minutes, you are
unable to restore the PDF after a drill is to be expected.
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Chapter 9. IBM Cognos Workspace Administration
Problems

Use this troubleshooting information to help solve problems you may encounter during or after the
installation of IBM Cognos Workspace.

Secure Connection Failed error when accessing IBM Connections
You have enabled collaboration using IBM Connections, and you receive an error in your Mozilla Firefox
Web browser when you access IBM Connections.

The following error can occur if you are using secure socket layer (SSL) protocol when the SSL algorithms
do not match between the browser and your application.
Secure Connection Failed An error occurred during a connection to server_name.
Cannot communicate securely with peer: no common encryption algorithm(s).

To resolve the error, update your ssl3 settings in your Web browser.

Procedure
1. Open your Mozilla Firefox Web browser.
2. In the URL box, type about:config, and press Enter.
3. In the Filter box, type ssl3.
4. Change any attributes marked False in the Value field to True.
5. Restart your Web browser, and try to access IBM Connections again.

Problems saving a workspace in IBM Cognos Workspace
You tried to save a large workspace and you received an error.

The following error might occur if Microsoft Internet Information Services (IIS) is blocking the request.
Unable to save the workspace.

Or, you might see a continuously spinning hourglass.

To resolve the error, increase the maxAllowedContentLength on IIS to prevent IIS from blocking your
request to save a large workspace.

Procedure
1. Open your IIS Manager that is hosting the IBM Cognos Gateway.
2. Select your Site.
3. Open the Request Filtering feature.
4. Select Edit Feature Settings.
5. Increase the Maximum allowed content length to a larger value. You can perform a network trace to

learn the minimum content length required.
6. Save your changes.
7. Restart IIS and try to save your workspace again.
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Chapter 10. Problems when using IBM Cognos
Analytics on mobile devices

Use this troubleshooting information to solve problems that you might encounter when configuring,
running, and viewing IBM Cognos Analytics content on mobile devices. Problems might occur on the
Cognos Analytics Mobile Reports server or on the Cognos Analytics Mobile Reports client.

Cognos Analytics Mobile Reports service problems
You may encounter problems when configuring and running IBM Cognos content on Cognos Analytics
Mobile Reports.

Charts and images not appearing
Charts and other images do not appear in reports in Cognos Analytics Mobile Reports if IBM Cognos
Analytics and Cognos Analytics Mobile Reports have been installed on a UNIX operating system that does
not have X server software installed.

To resolve this problem, configure IBM Cognos Analytics to run with X server software.

Procedure
1. Find the bootstrap_*.xml file located in the install_location\bin directory or in the
install_location\bin64 directory.

The exact bootstrap_*.xml filename depends on the version of UNIX that you are using.
2. Add the line <param>-Djava.awt.headless=true</param> to the following startup parameter in

the bootstrap_*.xml file:

<process name="catalina"> 
       <start>
           <spawn sync="1" wait_time="5">
               <path>${java_home}/bin/java</path>
               <param>-d64</param>
               <param>-Djava.awt.headless=true</param>
               <param condName="${ip_protocol}"
condValue="IPv6">-Djava.net.preferIPv6Addresses=true</param>
               <param>-Xmx${dispatcherMaxMemory}m</param>
<param>-XX:MaxNewSize=${dispatcherMaxMemoryBy2}m</param>

3. Save the modified file, and then restart the IBM Cognos Analytics server from the IBM Cognos
Configuration tool.

For more information, see the IBM Cognos Analytics Installation and Configuration Guide.

List prompt items consisting of only a single space are not supported
While running a report, a user chooses an item from a list prompt that consists of only a single space and
the report generates an error and fails to run.

To resolve this problem, either do not include single space items in list prompts or, if you do include the
single space then ensure that the user does not select it when running the report.

Cognos Analytics Mobile Reports service configuration settings are reset to
the defaults after upgrading

The Cognos Analytics Mobile Reports configuration settings and advanced settings may be reset to their
defaults after IBM Cognos Analytics is upgraded.

To resolve this problem, reapply the settings.



Advanced HTML functionality is not supported
Some advanced HTML functionality, such as Javascript and HTML tables, cannot be viewed in Cognos
Analytics Mobile Reports.

To obtain table functionality, you can use IBM Cognos Analytics - Reporting to create a table.

java.lang.NoClassDefFoundError
This error can occur while a report is running on a UNIX operating system if the server is running in
headless mode.

To resolve this problem, in the install_location/bin directory, in the IBM Cognos Analytics
startup.sh file, add the following parameter:

JAVA_OPTS=-Djava.awt.headless=true

java.lang.InternalError: Can't connect to X11 Windows server using ':0.0' as
the value of the DISPLAY variable

The server cannot run a report because the DISPLAY environment variable was not set or was set
incorrectly.

To render a report to a .png file, the Cognos Analytics Mobile Reports server invokes graphics routines. As
part of this process, the server must also invoke the Java Abstract Windows Toolkit (AWT) libraries. This
error occurs when the DISPLAY environment variable was not set or was set incorrectly and the server
cannot find the AWT libraries.

To resolve this problem, ensure that the DISPLAY environment variable is set to X11.

Cognos Analytics Mobile Reports service starts but then stops
Cognos Analytics Mobile Reports service fails during system startup. This means that the service has
encountered a fatal error, such as being unable to create database tables.

Check the logs for additional information, take the appropriate action to correct the problem, and restart
the service.

Cognos Analytics Mobile Reports database tables are not created
After IBM Cognos Analytics Mobile Reports was installed with IBM Cognos Analytics, the scripts to create
the MOB_* tables were not run.

Under normal circumstances, the Cognos Analytics Mobile Reports tables are created automatically after
the Mobile service starts for the first time.

This problem might occur when Cognos Analytics Mobile Reports application tier components and Cognos
Analytics Content Manager are installed in different locations, and the Cognos Analytics Mobile Reports
database is not configured properly.

Ensure that the Cognos Analytics Mobile Reports database is configured as documented in the IBM
Cognos Analytics Installation and Configuration Guide.

Cognos Analytics Mobile Reports client problems
Users might encounter problems when accessing IBM Cognos content on Cognos Analytics Mobile
Reports.

Images do not appear on Cognos Analytics Mobile Reports
Report images do not appear on Cognos Analytics Mobile Reports. This happens when users use their own
SSL certificates, which are not trusted by the Java virtual machine (JVM).
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To resolve this problem, users need to use the Oracle Sun keytool utility to import their SSL certificate into
their JVM. For more information, see the Sun software documentation.

Cognos Analytics Mobile Reports does not filter downstream prompts for
cascading prompts using reprompt

Users do not see the expected results in reports that have been set up with cascading prompts that
require reprompting, that is where the user must click Reprompt in Cognos Viewer.

IBM Cognos Analytics Mobile Reports does not apply the filters correctly downstream for the cascading
prompts.

To resolve this problem, change the report's prompt options to Auto-Submit. With this option, IBM Cognos
Analytics will apply the filters to the downstream prompts as expected.

Repeater tables render incorrectly
A report that includes a repeater table that is within a block or table element does not render correctly in
Cognos Analytics Mobile Reports.

To resolve this problem, rewrite the report so that repeater tables are not within blocks or table elements.

Calendar prompts show only the Gregorian calendar
When a report with a non-Gregorian calendar date prompt is displayed in the IBM Cognos Analytics
Mobile Reports app, the prompt appears in the Gregorian calendar format. The report runs after the user
enters values in the prompt, but the results may be empty or inaccurate.

Cognos Analytics Mobile Reports fails to connect to Microsoft SQL Server
IBM Cognos Analytics Mobile Reports accesses Microsoft SQL Server through the Java Database
Connectivity (JDBC) driver, which uses a TCP socket to connect to the database.

If Microsoft SQL Server is not configured to allow TCP connections, then Cognos Analytics Mobile Reports
will not connect to the database and will report errors in the logs.

To resolve this problem, enable TCP connectivity in Microsoft SQL Server.

Long text messages may be truncated
Long text messages may appear truncated on some parts of the device user interface for some languages.

For example, the user may observe that report long names and some translated text messages are
truncated.

No reports available when logged on from Cognos Analytics Mobile Reports
The mobile user is logged on to the IBM Cognos Analytics Mobile Reports client, but cannot access any
reports.

Reports need to be run before they appear in the mobile device inbox.

Procedure
1. In Cognos Analytics Mobile Reports, click Browse.
2. Click a report.
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3. Click Run Report.

The report runs on the server.
4. Click Refresh inbox to refresh the inbox.

The report appears in the list.

Some Cognos Analytics Mobile Reports users do not receive burst reports
All Cognos Analytics Mobile Reports users specified as recipients of a burst report should receive the
report on their mobile devices as scheduled. If some users do not receive the report, the report might not
be properly scheduled.

In the schedule settings for the report, ensure that the following check boxes are selected:

• Burst the report under Bursting.
• Send the report to mobile recipients under Delivery.

Do not select recipients for this option because burst reports are delivered to users defined in the burst
specification. Any recipients selected here are ignored.

Next time when the report is run, all mobile users should receive it.

Only those reports for which the report author defined burst options can be distributed by bursting. For
more information about burst reports, see the IBM Cognos Analytics - Reporting User Guide and the IBM
Cognos Analytics Administration and Security Guide.
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